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Scoupa

Announcements and General Info

This chapter contains the following topics:

CSP Features by Release
See which CSP features were introduced in which release.

Changes in the CSP Documentation
See what has changed in the CSP documentation since the previous release.
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CSP Features by Release

The following table gives an overview of the Coupa Supplier Portal (CSP) features introduced in various Coupa
releases.

Release Feature Description
Release | Supplier Onboarding with Additional Profile The supplier onboarding flow includes additional details.
29 Information
New Remit-To Experience for Suppliers You are guided through the process of providing remit-to
information.
Other CSP Enhancements You can view tables with invoice lines and SFTP errors,

you can see a reCAPTCHA before merging requests, and
are notified when you are deactivated or reactivated and
if you have too many active login sessions.

The following new notification preference settings are
available: Digital Check Canceled, Virtual Card Canceled,
and Receipt created.

When you decline to respond to supplier

information requests, you need to provide a comment.
Depending on your customers' settings, you can see
payment agreements on POs.

New Payments Page for Suppliers The new Payments page shows a summary of overdue
payments, early payment discount requests, tasks, and
payment preferences to help you collect and reconcile
your receivables from your customers that use Coupa
Pay.

Release | Smart Onboarding of Suppliers in the CSP When you register or log in to the CSP to do business
28 with a customer that uses an onboarding flow, you can
see a welcome message and are guided through the
process of providing the customer with the necessary
information.

Supplier Business Performance You can view a summary of orders and invoices that may
need attention, your year-to-date order and invoice
trends, and your lead time to shipping goods.

Updated CSP Customer Profile Sync You can use an external supplier update (system) form to
update your profiles for your non-SIM customers.

View Public Sourcing Events in the CSP You can access and participate in public sourcing events.

Other CSP Enhancements You can see dispute reasons in the table of invoices and
are notified of PO cancelations and PO acknowledgement
requests.

Release | CSP Profile Data Reuse You can reuse your CSP public profile information in

27 Supplier Information Management (SIM) and email your
non-SIM customers for help to update your customer
profiles.

Valid until January 31, 2021 6
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Release Feature Description
One-Click Savings You can benefit from savings opportunities provided by
other suppliers through the Coupa Advantage program.
Other CSP Enhancements Public and customer-specific profiles are more clearly
differentiated, and customer-specific profile pages include
information about which customers do not allow profile
changes by default. Also, users are arranged in
alphabetical order and the user permissions are
enhanced to provide targeted access to orders and
service/time sheets.
Release | Enhancements to the CSP Home and Profile | The CSP has additional fields for the public profile and
26 Pages displays a profile summary.
Restricted Access to Orders and Service/ As a supplier administrator, you can decide which
Time Sheets in the CSP supplier users can access POs, PO changes, and
service/time sheets.
Improved Emails to Suppliers Some frequent emails from your customers have a new
look and feel and enhanced content.
Enhancements to Collecting Remit-To You can provide more remit-to types and add this
Information in the CSP information to your legal entities in the CSP so that your
Supplier Remit-To Redesign customers can use different payment methods when
working with you.
Release | Announcements to Suppliers in the CSP Your customers can create custom announcements to be
25 shown to you in the CSP.

cXML Error Notifications to Suppliers

If you use cXML, you can receive notifications of and view
cXML submission errors.

Enhancements to the CSP Home and Profile
Pages

The CSP displays profile completeness allowing you to
see at a glance if you need to provide more details in your
profiles. Also, if your customers use Supplier Information
Management (SIM), the information you submit through
SIM forms can be reused in your public profiles in

the CSP without having to enter the same information
twice.

Improved PO Emails to Suppliers

PO emails you receive have a new look and feel,
enhanced content, and the improved ability to create a
CSP account from emails.

Supplier Support Chat

Whether logged in to the CSP or not, you can get help
from Coupa Support also through chat.

Early Payment Discount Term Segments

Your customers can assign specific Coupa
Accelerate payment terms to you. You can accept
customer-specific payment terms and choose to apply
them globally.

Valid until January 31, 2021
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Release Feature Description
Release | SFTP Account for Suppliers You can create and manage SFTP accounts for your
24 CSP instances.

Digital Check Payment in the CSP If your customers use Coupa Pay, you can accept
payment through digital checks that you can download
and print from the CSP.

Release | Supplier Add-ons An add-on is a value-creating product or service that you

23 can begin to use or express interest in using, for
example, Coupa Advantage, Coupa Accelerate, or
invoice financing. As an admin, you can access all these
add-ons from one page in the CSP.

Invoice Creation and Other Improvements You can create invoices and enter payment information
more easily due to a more intuitive user interface, and
can enjoy a better user experience.

Release | Supplier Notifications for Increased You are notified when your customers enable Coupa

22 Accelerate Adoption Static Discounting and they are ready to accept early
payment discount offers, and you can act quickly on
orders that can be accelerated.

Bulk Export Legal Invoices You can bulk export all the legal invoice
attachments in a .zip file.

Create CSP Accounts from PO Emails and You can create CSP accounts by clicking on a button in a

Forward Invites purchase order (PO) email.

Release | CSP Two-Factor Authentication with SMS You can use SMS messaging to validate your credentials
20 when prompted by two-factor authentication.

Early Payment Discount Terms at You can choose the type of early payment discount you

Transaction Level want for each purchase order you receive and each
invoice you send. If your choice matches one of the
discount terms on your Coupa customer side, that
discount is automatically assigned to the transaction.

Release | CSP Service (Time) Sheets You can manage service/time sheets in the CSP.
18

CSP User Experience Improvements The Coupa Supplier Portal (CSP), formerly the Coupa
Supplier Network (CSN), upgraded its graphical user
interface (GUI) to optimize better for mobile devices.

Customer-Enforced Two-Factor Two-factor authentication can be mandatory.

Authentication in CSP

Global Early Payment Discount Terms in You can set preferred accelerated payment terms (early

CSP payment discounts terms) in the CSP.

Purchase Order Lines in CSP You can view purchase order (PO) lines with Advance
Ship Notice (ASN) "shipping status" information from the
CSP.

Valid until January 31, 2021
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Release Feature Description
Release | Automatic Navigation to Supplier Profile You are taken from a Supplier Information
17 Update Management (SIM) email to update your profile directly in
the CSP.
Public Profile Notifications Turned Off Public Profile Update notifications are turned off by
default.
Recently Used Remit-To Address A recently used remit-to address is the first on the list of
remit-to addresses.
SMS Notifications from Coupa Supplier Portal | You can receive notifications in a text message (SMS).

For more information, see Changes in the CSP_Documentation.

Valid until January 31, 2021 9
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Changes in the CSP Documentation

Changes for the January 2021 Release

Topic Change Details

View Business Performance Data Updated The layout of the customers list and the
order/invoice summary dashboards has
changed.

View and Manage Remit-to Information Updated Changed title from View Remit-to Information.

Updated to reflect the changes to the Remit-
To page and to adding remit-to accounts.

Set up Legal Entities Updated Added information about pre-populating the
remit-to fields on SIM form responses.
Updated to reflect the changes to providing
remit-to information.

Create or Update Your Profiles Updated Updated to show the new option of applying
selected payment terms to all the customers
and the new pages in the onboarding flow.
Also, updated to reflect the removal of the
Diversity Certificates field from the Profile
edit page.

Manage Merge Requests Updated Replaced the screenshot of the Admin /
Merge Requests page to show the
disclaimer and the reCAPTCHA.

View and Manage Notifications Updated Added notification preference setting options
for canceled digital checks, virtual cards, and
created receipts.

Manage Users Updated Added information about reactivating users.
Admin Page Updated Added information about viewing SFTP file

upload errors.

Log in to the CSP Updated Added information about multiple sessions
and user deactivation.

View and Manage Payments New Provided instructions on how to view and
manage payment-related information.

View SFTP File Upload Errors New Provided instructions on how to view SFTP
file upload errors.

View Invoice Lines New Provided instructions on how to view invoice
lines.

Valid until January 31, 2021 10
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Changes for the September 2020 Release

Topic Change Details

Create SFTP Accounts Updated Added a note about required SFTP clients.

Create Custom Views Updated Added information about how to delete a
custom view.

Create or Update Your Profiles Updated Updated with information about how to reuse
public profile information in customer-specific
profiles.

Added information about how to update your
customer profile through an onboarding flow.

Set up Legal Entities Updated Added a tip about the tooltips showing the
number and type of characters allowed in the
banking information fields depending on the
selected bank account country.

Access Add-ons Updated Updated to reflect the changes on the One-
Click Savings and Express Interest pages.

Create or Edit an Invoice Updated Replaced the screenshot of the Invoices
page to show the addition of the Dispute
Reason column to the Invoices table.

View and Manage Invoices Updated Updated to show the addition of the Dispute
Reason column to the Invoices table.

Log in to the CSP Updated Removed the warning and note about the
banner listing permissions.

Updated with information about the new login
page with the welcome message.

Create Your Account Updated Added a note about the case when you join
the CSP from one of two simultaneous
invitations.

Added Proposal Manager to the list of
available roles within the Sales department.
Updated with information about the new
registration page with the welcome message.

Manage Users Updated Updated to show that the Admin main menu
item has moved under the new Setup main
menu item.

Replaced the screenshots to show the new
Business Performance and Sourcing tabs
and the Business Performance and
Sourcing permissions necessary to see
them. Also, updated the table with the new
permissions.

Added more details about how to use

the Restricted Access to Orders and
Restricted Access to Service/Time Sheets

Valid until January 31, 2021 1
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Topic Change Details
permissions.
View and Manage Notifications Updated Added notification preference setting options

for canceled orders, granted permission for
viewing business performance, and bank
transfer, virtual card, and zero payment
remittance advice.

Navigate and Get Help Updated Updated with information about the Business
Performance menu item.

View Business Performance Data New Provided instructions on how to view a
summary of orders and invoices that may
need attention, year-to-date order and invoice
trends, and lead time to shipping goods.

View Public Sourcing Events New Provided instructions on how to view public
sourcing events.

CSP Videos Updated Added a new video about the customer-
branded welcome message and updated
existing videos.

CSP Features by Release Updated Added information about the features
introduced in this release.

Changes for the May 2020 Release
Topic Change Details

Access Add-ons Updated Updated to reflect the changes in content and
layout and to provide details about the One-
Click Savings add-on.

CSP Videos Updated Added a new video about One-click Savings.

CSP Features by Release Updated Added information about the features
introduced in this release.

Valid until January 31, 2021 12



CSP Admin and User Guide Announcements and General Info

Changes for the January 2020 Release
Topic Change Details

View and Manage Notifications Updated Updated to reflect that the notification
preference setting A new comment is
received for Form Responses is enabled by
default for new suppliers.

Added new notification preference settings.
Also, added information about stopping SMS
notifications by replying STOP.

View and Manage Invoices Updated Added information about the Totals with
Early Payment Discount section on legal
invoices.

View and Manage POs Updated Added information about the tooltip text of the

icon for flipping a PO into an invoice.
Added information about the new Assigned

To column.

View and Manage Service/Time Sheets Updated Added information about the new Assigned
To column.

Regqister for the CSP Updated Updated the information about the content
and format of email invitations.

Create Your Account Updated Updated to reflect the new Department and
Role fields.

Create or Update Your Profiles Updated Added information about the profile summary,

the Learn More link, and the new fields on
the Public Profile page.

Manage Your Account Updated Updated to reflect the change of the page title
from My Account Password to My Account
Settings, the new Department and Role
fields, and the User Details and Change
Password sections.

Manage Users Updated Added information about the Restricted
Access to Orders, Restricted Access to
Service/Time Sheets, and Pay Me

Now permissions.

Invoices Updated Added information about how long legal
invoices are available for download.

Navigate and Get Help Updated Replaced the screenshot of the Home page
to show the new Profile Summary section
and reflect the other changes to the profile.
Replaced the screenshot of the contact
information pop-up for chatting with Coupa
Support to show the new text stating that the
Coupa Support chat is only for technical
issues with the CSP.

Valid until January 31, 2021 13



CSP Admin and User Guide

Topic

Admin Page

Change

Updated

Announcements and General Info

Details

Updated to reflect that E-Invoicing
Setup has changed to Legal Entity Setup.

Create or Edit an Invoice

Updated

Updated to reflect the changes to adding new
or choosing existing invoicing details.

Added information about the tooltip text of the
icon for flipping a PO into an invoice and
about the fields that cannot be edited if
customers mandate PO acceptance.

Set up Legal Entities

Updated

Changed title from Set up E-Invoicing.
Updated to reflect the changes in setting up
legal entities.

Changed the requirement of 4-28 digits to
4-28 characters for the Account Number
field.

Added details about how to fill in the What is
your Tax ID? section in the absence of a tax
ID number.

CSP Videos

Updated

Added a new video about the profile
summary and additional fields.

CSP Features by Release

New

Provided information about which
CSP features were introduced in which
release.

Changes for the September 2019 Release

Topic Change Details

Create an Invoice from a PO, Create a Credit | Removed Moved the content of these topics to Create

Note or Edit an Invoice.

Create or Edit an Invoice Updated Updated with content from topics Create an
Invoice from a PO and Create a Credit Note,
and added instructions on how to create a
blank invoice and an invoice from a contract.

CSP Videos Updated Updated the videos for Intro, Help, Profile,
Orders, Invoices, Catalogs, and Admin. Also,
added new videos about profile
progress, announcements, and creating
invoices.

Register for the CSP Updated Updated the information about registering to

the CSP from a PO email.

Valid until January 31, 2021
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Topic Change Details

Set up E-Invoicing Updated Added information about the Account
Number field digit count limit being
increased.

Navigate and Get Help Updated Provided instructions on how to chat with

Coupa Support to get help. Also, replaced the
screenshot of the Home page to show the
sections for profile progress and
announcements.

Create or Edit an Invoice Updated Added information about the possibility to
update PO references on invoice lines
and add PO lines from other orders.

Manage Users Updated Added information about the Order Changes
permission.
View and Manage Notifications Updated Added notification preference setting options

for customer announcements, integration
errors, rejected PO change requests, and
Coupa Pay new virtual cards, reissued virtual
cards, and virtual card reminders.

Also, updated to reflect the new
Announcements filter option on the My
Notifications page.

Create or Update Your Profiles Updated Added information about the profile progress
indicator and the new fields on the Public
Profile page.

View and Manage Invoices Updated Replaced the screenshot of the Invoices

page to show the position of the buttons for
creating invoices or credit notes.

View and Manage POs, View PO Lines Updated Replaced the screenshot of the Orders page
to show the Order Changes and Order Line
Changes tabs.

Admin Page Updated Added information about viewing cXML
submission errors.

Manage Merge Requests Updated Replaced the screenshot of the Admin
Merge Requests page to show all the tabs
on the page.

Set Coupa Accelerate Preferences Updated Updated to reflect the possibility to

select customer-specific payment terms and
apply them globally.

Create Custom Views Updated Added information about the new pages that
have tables.
Edita PO New Provided instructions on how to request

Valid until January 31, 2021 15
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Topic Change Details
changes to POs and add shipment tracking
information.

View Customer Announcements New Provided instructions on how to view

announcements from customers.

View cXML Submission Errors New Provided instructions on how to manage
notifications of and view cXML errors.

Changes for the May 2019 Release
Topic Change Details

Set Coupa Accelerate Preferences Updated Removed notes informing users that after
logging in they need to navigate to pages that
they tried to access from URLs without being
logged in initially. Users that click on links to
CSP pages without being logged in are now
directed to the relevant pages (not to the
Home page) after logging in.

Set up E-Invoicing Updated Added information about the Account
Number field digit count limit being increased
from 17 to 19.

Manage Users Updated Replaced the screenshots to show the new
Payments tab and the Payments permission
necessary to see it. Also, updated the table
with the new permission.

Admin Page Updated Added information about creating SFTP
accounts.
View Service/Time Sheet Lines Updated Updated to reflect the changes in layout and

information provided on service/time sheet
lines to support partial acceptance of

services.

View and Manage POs Updated Added a tip about adding comments to POs
that suppliers do not accept and want to
reject.

View and Manage Notifications Updated Added notification preference setting options

for abandoned invoices and Coupa Pay new
digital checks.

Valid until January 31, 2021 16
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Topic Change Details

View and Manage Invoices Updated Added information about the new Abandoned
invoice status.

Create or Edit an Invoice Updated Added information about invoices associated
with digital checks and bank transfers being
populated with payment information.

Navigate and Get Help Updated Replaced the screenshot and updated the
table to show the new Payments tab.

Log in to the CSP Updated Updated the Additional Features page of
the Welcome tour with information about the
new Payments page.

View and Download Digital Checks New Provided instructions on how to view and
download digital checks.

Create SFTP Accounts New Provided instructions on how to create and

manage SFTP accounts.

Changes for the January 2019 Release

Topic Change Details

View Remit-to Information Updated Updated to show that new remit-to addresses
can be created/added directly when creating
invoices.

Set up E-Invoicing Updated Updated to reflect the changes in setting up
legal entities.

Create a Credit Note Updated Updated to reflect the changes on the Create
Invoices page.

Create or Edit an Invoice Updated Updated to reflect the changes on the Create
Invoices page and in how an invoice is
created from a contract.

Create an Invoice from a PO Updated Updated to show that new remit-to addresses
can be created/added directly when creating
invoices.

Create or Edit a Service/Time Sheet Updated Updated with information on service/time
sheet lines.

View PO Lines Updated Added information on new PO line fields for

services.

Valid until January 31, 2021
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Topic Change Details

View and Manage Service/Time Sheets Updated Replaced the screenshot to show the new
Service/Time Sheet Lines subtab.

Navigate and Get Help Updated Replaced the screenshot of the Help
Tour with a reference to the section on the
updated welcome tour.

Replaced the screenshot and updated the
table to show the new Add-ons tab.

Create or Update Your Profiles Updated Added a note stating that changing the
customer-specific profile might update the
supplier information that the specific
customer has on record.

Log in to the CSP Updated Added information on the new welcome tour.

Regqister for the CSP Updated Updated with information on the changed
subject line, content, format, and style of the
email invitations.

View Service/Time Sheet Lines New Provided information on viewing service/time
sheets at line level.

Access Add-ons New Provided information on the add-ons that
admins can access.

Changes for the September 2018 Release
Topic Change Details

Regqister for the CSP Updated Updated with information on additional
options to register for the CSP.

Create Your Account Updated Updated with information on forwarding your
invitation to the CSP.

Log in to the CSP Updated Added information on the banners that warn
about permissions.

View and Manage Notifications Updated Added notification preference setting options
for form response reminders, early payment
opportunities, and legal invoice export results.

View and Manage Invoices Updated Added information about downloading all the
legal invoice attachments in one compressed
file.

Set Coupa Accelerate Preferences Updated Updated with instructions on how to

Valid until January 31, 2021 18
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Topic Change Details

accelerate orders from PO emails and
information on notifications of customers who
are ready to accept early payment discount
offers.

CSP FAQ / Invoices Updated Added a note to the Why can't | edit, void, or
delete an invoice? frequently asked question.
Updated the What does the Export to button
do? frequently asked question with
information on bulk exporting legal invoices
and increased export size limitation.

Changes for the May 2018 Release

Topic Change Details

CSP FAQ / Other Updated Added a frequently asked question about
archiving information in the CSP.

Regqister for the CSP, Create Your Account, Updated Replaced the screenshot of the Register/Log

and Log in to the CSP In page to show the newly added links where
you can get help with registering and logging
in.

Create or Edit an Invoice Updated Added information on the warning message

that you might get if you try to submit an
invoice that does not meet your customer's
requirements.

View and Manage Notifications Updated Added two new notification preference setting
options.
Manage Users Updated Replaced the screenshot of the Edit user

access for [User Name] window to show
that the Deactivate User button is inactive for
the user who is logged in. Also, added a note
to explain the reason.

Changes for the January 2018 Release

Details

Create or Edit an Invoice Updated Added a note stating that it is not possible to
pick lines from POs when creating an invoice.

Valid until January 31, 2021 19
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Topic Change Details
Enable or Disable Two-Factor Updated Updated with instructions on how to use SMS
Authentication and Log in to the CSP messaging to validate your credentials when

prompted by two-factor authentication.

View and Manage Notifications Updated Updated with information on new notification
preferences that you can set to get notified if
your customer sends you a comment or
replies to your question/comment about
unclear sections of the SIM update request
form or provides a reason for rejection.

Set Coupa Accelerate Preferences Updated Updated with instructions on how to set early
payment discount terms at transaction level,
that is, for specific orders and invoices for
some or all customers.

View and Manage Invoices Updated Updated with information on resolving
disputed invoices.

Create a Credit Note New Provided instructions on when and how to
create a credit note.

Valid until January 31, 2021 20



Get Started with the CSP

This chapter contains the following topics:

Register for the CSP

Self-register at supplier.coupahost.com, get an invitation email from your Coupa customer, forward an invitation to a peer,
or create an account from a PO email.

Create Your Account
After receiving an invitation, create your CSP account.

Log in to the CSP
See how to log into the CSP using single or two-factor authentication.

Create Custom Views

Change the view settings depending on how you want to see information on orders, invoices, catalogs,
service/time sheets, ASNs, or payments for each customer.

Create or Update Your Profiles
Update your public and customer-specific company profiles.

Enable or Disable Two-Factor Authentication
Enable two-factor authentication for additional security.

Manage Your Account
Change your personal information, set your notification preferences, or enable/disable two-factor authentication.

Navigate and Get Help
Learn where to find what in the CSP, including help.

View and Manage Notifications
View your notifications and set your notification preferences.
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Register for the CSP

You have the following options to register for the CSP:

Method

Customer-created
invitation

Benefits

You get a custom-invitation with specific
instructions and a proactive message from
your customer.

When you accept the invitation and create
your account, you are automatically
connected/linked to the customer who invited
you.

Get Started with the CSP

Considerations

You have to wait for your customer to send
the invitation email. This means that you
might not get invited due to your customer
forgetting or not having the time to send the
invitations to all their suppliers.

Self-created invitation

You can set up your accounts ahead of time,
add multiple users, set up your login
preferences, and update your profile more
quickly.

You need to connect manually to your
customers in Coupa. Let your customer know
that you registered and you want to connect
with them.

Customers can connect with you through
their Supplier Portal Directory, or by sending
an invitation email to any of the CSP supplier
users on the account. However, if you are
invited using a different email, that email can
log in but will have to merge with the account
that was set up ahead of time in order for all
the supplier users to be on the same account
and linked to the customer.

Purchase order (PO)
email

Your customer does not have to proactively
manage invitations and reminders for you to
get connected through the CSP.

You can create a CSP account without
requiring an invitation if you use Supplier
Actionable Notifications (SAN),
InvoiceSmash, or other PO methods.

As PO emails are a frequent communication
channel between you and your customers,
you have more opportunities to create a CSP
account and enjoy its benefits.

None

Forwarded invitation
from a coworker

You can easily invite others within your
organization to the CSP by forwarding them
your PO email notification or by sending them
an invitation from the create account page.
You end up with the right supplier user(s)
linked to and transacting electronically
through the CSP with less work.

You can forward the invitation only to email
addresses with the same domain. However,
this ensures more built-in security.

With all methods, you need access to the email address you are going to use for the account.

Your CSP account is based on a specific email address. If you use an email address different from the one your Coupa
customers have on file for you, you cannot connect with them until you give them the email address or create a
CSP account with that email address.

Valid until January 31, 2021
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Customer-created invitation
Ask your customer to send you an invitation to the CSP.

Self-created invitation
Go to supplier.coupahost.com and in the Register pane on the left, fill in the mandatory (email) field (marked with an
asterisk), and then click Register to request an invitation.

Farcoupa supplier portal

Register LogIn
New to Coupa? Create your account or click here for help. Welcome back! Login or click here for help.
First Name * Email Address
Last Name * Password
Company
" Email Forgot Your Password?

In both cases, you receive an email invitation with a different subject line, depending on whether the invitation was sent
by your customer or was initiated by you.

If the email was initiated by your customer, it contains the customer logo instead of the Coupa logo.

Tip: If you do not receive your invitation email, check your spam folder.

The email contains instructions and links to useful information, and buttons for joining the CSP or forwarding the
invitation. Depending on your customers' settings, your invitation emails might look different and have different sections.
For example, if your customer enabled new email formats, your email has the following sections:

Section Description

Top section Section specific to the type of the email. Depending on the type of email, it also
contains relevant buttons, for example, to register for the CSP.

More about the CSP / Provides basic information about the CSP, its benefits, and a link to Learn more
Do More with the CSP / about Coupa for Suppliers or Get Started with the CSP.

Get Connected with the CSP Depending on the type of email, it also includes instructions.

What is Coupa? Provides a short introduction to Coupa and a link to Find out

more about Coupa for Suppliers.

Note: For the new email format, only Microsoft Outlook version 16 is supported.

Valid until January 31, 2021 23
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Forwarded invitation
You can invite others to the CSP by forwarding them your PO email notification with the Create Account button, by
clicking on the Forward This button in your CSP invitation email, or by sending them an invitation from the create

account page.

Warning: You can forward the invitation only to email addresses with the same domain.

An invitation to the CSP is sent to the email address that you specified.

When the invited user clicks on the Join Coupa button in the email, the user is directed to create an account to
the CSP.

If the user is already linked to the CSP or tries to create an account from an expired invitation, the user is directed to the
Register / Login page where a red message bar displays the following: "Your invitation has expired or already been

activated."

Warning: Invitations to the CSP expire after 30 days.
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Create Your Account

Join the CSP

After following the link from an invitation email (other than customer-created invitation), fill in the mandatory fields to
provide basic information for your account and your company's public profile.

frcoupa

Join the Coupa Supplier Portal

Complete the information below and create the password for your account. Click here for help.

*First Name | Jane
* Last Name | Doe
* Company | Awesome Supplier

* Department | Sales

(@(

*Role | Sales Manager
*Email jane.doe@awesupplier.com

* Password

Use at least & characters and include a number and a lefter.

* Password Confirmation

] | accept the Privacy Policy and the Terms of Use.

Forward Your Invitation

Not the right person to register now? Want to ask a coworker to join quickly? Send a copy of your
invitation to a colleague's email below (must have same email domain).

Forward email | Email @coupa.com

Setting Description

*First Name Your personal first name to be applied to your personal account.

Valid until January 31, 2021 25



CSP Admin and User Guide Get Started with the CSP

Setting Description

*Last Name Your personal last name to be applied to your personal account.
*Company The name of your company as seen on your company's public profile.
*Department The name of your department: Sales, Operations, Accounts

Receivable, Treasury, or Other.

*Role Your role within the department:

» Sales: Sales Manager, Sales Associate, Proposal Manager, Other

» Operations: E-Commerce Manager, Order Fulfillment/Inventory
Management, Other

» Accounts Receivable: Accounting Manager, Accounts Receivable Associate,
Other

» Treasury: Treasury Manager, Other
» Other: Enter free text.

Tip: If you select Other for Department and/or Role, the User Specified
Department and/or User Specified Role fields are displayed for you to
enter free text.

*Email This field cannot be changed. If you want to change your email address, you have
to create a different CSP account using the new email address. If you also want
to use this email, create two company accounts and merge them. For more
information, see Manage Merge Requests.

*Password Use this field to create your password. It must be at least 8 characters long, and it
has to include a number and a letter.

*Password Confirmation This field needs to match the password you typed in the password field.

Note: If you join the CSP from one of two simultaneous invitations received from your administrator and your
customer, you might see a green box with a question asking whether you are an employee of the supplier
organization and you need to select either the Yes — Join or No — Create New Account checkbox.

Welcome message

Note: You can see this feature only if your customer(s) enabled it.

When you join the CSP from a customer-created invitation, you can see a registration page that is different from the
page shown above. The Create your business account page contains the following welcome message and company
logo by default. Your customer can customize the welcome message and add their logo, so the message might be
different from the one shown below.
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{‘i‘; ACME Inc. Powered by {;;*.COI.Ipa

Create your business account

We use Coupa to manage purchase orders, invoices, and communicate with our suppliers. We'll walk you
through a quick and easy setup for your account, so we're ready to do business together.

Email supplier@coupa.com
Password

Use at least 8 characiers and include a number and a letter.
Password Confirmation

[] | accept the Privacy Policy and the Terms of Use.

Get Started

Having an issue with signup?

Forward this to someone

You need to enter your email address and password, and accept the Privacy Policy and the Terms of Use. You can get
help to sign up or you can forward the invitation to others by clicking on the relevant links.

Tip: You can update your information later on the My Account Settings page. For more information, see
Manage Your Account.

By default, this account is the admin account for your company. Once set up, you can add users and assign them roles,
including account administration. For more information, see Administer the CSP.

Forward your invitation

You can invite others any time by entering their email address in the Forward email field in the Forward your
invitation section and clicking Submit, or by clicking on the Forward this to someone link if you see the welcome
message.

For more information, see Reqister for the CSP.
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Log in to the CSP

Login page
Go to supplier.coupahost.com and in the Log In pane on the right, enter your email address and password and click
Log In.

£acoupa supplier portal

Register LogIn
New to Coupa? Create your account or click here for help. Welcome back! Login or click here for help.
First Name * Email Address
Last Name * Password
Company
* Email Forgot Your Password?

Multiple active sessions

You cannot have more than three active sessions simultaneously. When you log in to another session, you are forced to
close an open one. A message notifies you that you have too many active logins and you will be signed out from one of
your other sessions if you click Log In. You can also Cancel the attempt to log in to another session.

Your account currently has too many active logins. If you continue to sign in
here, you will be signed out from one of your other sessions.

corn

Inactivity
Your account is deactivated automatically if it is inactive for a defined period of time, that is, if:

* You have not logged in to the CSP for more than 90 days.
* You have not verified your account for 6 months.

When you try to log in as an inactive user, a red message bar notifies you of the verification email you received. To
reactivate your account, you need to confirm that email. On the CSP login page, a green message bar informs you of
the successful email verification and you can log in. For more information, see Log in to the CSP.
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Welcome message

When you log in for the fist time from a new customer-created invitation, you can see the following welcome message
and company logo by default. Your customer can customize the welcome message, so the message might be
different and have your customer's logo instead of the Coupa logo.

A\'i"; ACME Inc. Powered by {;}.Cl)l.lpa

\We use Coupa to manage purchase orders, invoices, and communicate with our suppliers. We'll walk you
through a quick and easy setup for your account, so we're ready to do business together.

Welcome tour
Once you are signed in, Coupa takes you on a welcome tour.

Note: If you log in from a new customer-created invitation, the welcome tour is not shown, but you can
access it from the Help menu. For more information, see Navigate and Get Help.
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Welcome to Coupa Supplier Portal

v Create Invoices & Get Status Updates v Update Profile & Payment Info

+/ View & Respond to Purchase Orders / Create Time Sheets & ASNs Against Orders

~/ Host & Manage Catalogs v Get Real-Time SMS & Email Notifications

gecoupa supplier portal

o s

You can skip the tour by clicking on the Skip button or closing the window with the X in the top right corner. Clicking
Next takes you to the second page of the tour, which provides you with basic information on the benefits of invoicing
through the CSP.

Welcome to Coupa Supplier Portal

Flexible Ways to Create Invoices

o= N &)

Invoice Against an Order Invoice Without an Order Be Secure & Compliant
Create invoices backed by pre-approved POs or Create invoices from scratch using your Setlogin security and leverage built-in global
contracts customer's invoice form compliance for legal invoicing
Go to Order@; Go to Invoices » Admin Settings »

- . e ]

By clicking on the relevant link, you can go directly to view the Orders, Invoices, or Admin pages, or go to the next tour
page that provides basic information about how the CSP can help you transact and communicate with your customers,
for example, by allowing you to manage your catalogs, orders, and invoices, and setting notification preferences for
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important customer transactions.

The fourth (last) page of the tour summarizes the additional features, for example, the possibility to provide supplier
information through the CSP, update POs with advance ship notice (ASN), update catalog items, and features for
payments, such as, managing payment settings. If you click on the Go to Online Help to Learn More link, you are
directed to the Coupa Supplier Portal Admin and User Guide for details on each feature.

Welcome to Coupa Supplier Portal

Additional Features

o Ik =

Supplier information Service/Time Sheets & Catalogs Payments
Provide up-to-date information to your ASNs Send and update details on Manage payment settings, early pay
customers Update POs with advance ship purchasable items discount preferences, and more

notices or information on provided
services

Go to Online Help to Learn More »

- . ==

Two-factor authentication
When you log in for the first time, you are prompted to enable two-factor authentication. For more information, see
Enable or Disable Two-Factor Authentication.
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£3coupa supplierportal

Two-Factor Authentication

Enable Two-Factor Authentication

Note: Some customers may require you to use two-factor authentication when accessing their information.

Log in with two-factor authentication
If you have enabled two-factor authentication, the Two-Factor Authentication window opens when you want to log in to
the CSP.

If you enabled the Two-Factor Authenticator App, choose open Google Authenticator on your device, choose your
CSP account, and get the validation code.

If you enabled two-factor authentication for SMS, check your text messages to get the verification code.

‘Two-Factor Authentication

Enter validation code that we sent to +12015555555
* Two Factor Code | Code

[[] Remember this computer for 30 days

Cancel Send Code to Mobile

Type the two-factor authentication code in the appropriate field, choose Remember this computer for 30 days if you
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are not using a shared or public computer, and click Log In.

Note: The code is good only for 60 seconds. If you do not type that code on the CSP sign-in page and click
Log In within 60 seconds, you have to get a new code and try again.

For more information, see Enable or Disable Two-Factor Authentication.

Note: If you are locked out and you do not have your six-digit backup validation code, contact your customer
who will ask for a declaration form and either your email used to log in to the CSP or a copy of your photo ID
or passport to verify your identity.
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Create Custom Views

You can create custom views for orders, order lines, order changes, order line changes, service/time sheets, service/
time sheet lines, advance ship notices (ASN), invoices, catalogs, invoice payments, and PO payments.

With a custom view you can create a set of advanced search filters.
1. On the main menu, click on the tab for the function for which you want to create a custom view.
2. At the top of the table whose view you want to change, click Create View in the View drop-down list.

3. On the Create New data table view page, select the customer for whom you want to change the view settings,
and then specify the settings you want to use for your custom view, including filtering conditions, columns to
include, and sorting criteria.
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Select Customer Coupa ~
Create New data table view
General
Name
Visibility @ Only Me
@ Everyone
Start with view | All ~
Conditions
Apply All | ofthese conditions:
Invoice # b is b 9

Columns
Available columns Selected columns
Commented Invoice #
Comments Created Date
custom_field_10 Status
custom_field_9 FO#
Date Of Supply Total
Delivery Mumber Unanswered
Comments
Disputed Date
Actions
Document Type
Invoice Date

Lookup Custom Field
Original Invoice Date
Original Invoice Number
Paid

Payment Information

Payment Term

Default Sort Order

Sort by ~

n  ascending ~ | order.

Cancel Save

If you want to build this view based on another view and modify those settings, use the Start with view option
under the General settings.
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You can use the following settings when creating or editing a custom view for a CSP table.

Group Setting Description
General Name Name of the custom view, visible from the View drop-down list at the top of
the table.
Visibility Defines whether this view can be visible to only you or all the other users that

can see the main table.

Start with view | Use this option to load the settings from another view, and then modify those
settings to fit your needs for this view.

Conditions Apply All - Displays results only for objects that meet all of the conditions you add in
this list.
Any - Displays results for objects that meet at least one of the conditions you
add in this list.
Conditions Create conditions based on the data available in the CSP.
Columns Available This list depends on the table you work with in the CSP. You can select any
columns of these columns to add to your custom view.
Selected These are all the columns displayed in this custom view. They appear from
columns left to right, in the same order that you set them up here.
Default Sort Choose the column by which you want results to be sorted and define whether to sort them in
Order ascending or descending order.

4. Save your settings.

To delete a custom view, open the view for editing by clicking on the Edit View (s ) icon and click on the Delete (0)
button at the bottom of the page.
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Create or Update Your Profiles

In the CSP, you have a public profile and you can have specific profiles for your customers that you are connected with
through the CSP.

You can view and update your public and customer-specific profiles from the Home page or the Profile page.
Tip: When you register or log in to the CSP to do business with a customer that uses an onboarding flow,

you are guided through the process of providing the customer with the necessary information. For more
information, see Update your customer profile.

Note: Some sections are labeled as private and cannot be seen from the CSP. Financial information (for
example, your tax ID, DUNS, and remit-to addresses) are considered private information. This information
appears only on documents that you create through the CSP, for example, on invoices.

Update your public profile

Anyone can find and connect with you through your public profile.

Your public profile is created when you create your account and it contains general information about your company, for
example, name, logo, website, industry, year of establishment, top commaodities, currencies, diversity, and corporate
social responsibility rating (on the Home and Profile / Public Profile pages), the link to your public profile (on the Home
page), and contact information (on the Profile / Public Profile page).
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Action needed: Complete your profile to get paid faster and get discovered Learn More

Profile Progress Last Updated
——— 37% Complete (9 3 months ago e

Profile Summary

& b 4 L

3 1 1
Legal Entities Registered User Connected Customer
View View

'Update your preference for Bribery Policy

v Banking Info & Diversity Info  + Accelerate & Bribery Policy

Flower Supplier

Website (&
Industry &
About

Established ~(,

Top Commodities &

Currencies §
Diversity ® GCanada - Aboriginal and Minority Supplier

Corporate Social 4 CSRHub
Responsibility Rating

Public Profile &3 Profile

Profile progress
At the top of the Home page, you can see your profile progress/completeness.

The following table shows the profile completeness stages.

Profile Progress Bar Color Message

Red Action needed: Complete your profile to get paid faster and get discovered.
Blue Recommended: Complete your profile to get paid faster and get discovered.
Green Great job! A complete profile helps you get paid faster and get discovered.

Next to the progress bar, the Last Updated field shows how long ago the profile was updated, for example, 2 minutes
ago or 10 days ago.
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The following table shows the color of the progress bar depending on the age of the profile.

Percentage of

Completeness

Last Updated < 1 Year
Ago

Last Updated 1-2 Years
Ago

Get Started with the CSP

Last Updated > 2 Years
Ago

<50% Red Red Red
50% - 80% Blue Blue Red
80% - 100% Green Blue Red

The Learn More link next to the profile progress message opens the Get Discovered with a Complete Public Profile
popup with tips and information on the benefits of a complete public profile.

Get Discovered with a Complete Public Profile

With a complete and current profile, you can:

Q

Make your profile searchable by
Coupa's community of buyers,
spendmng hundreds of billions
avery year

181

Get discoverad during sourcing
events and help your Coupa
customers link to your account

A

Increase your opportunities with
Coupa Advantage and Coupa Link
preferred supplier programs

Update Profile

Clicking Update Profile opens your public profile for editing.

Profile summary

Under the section about your profile progress, you can see an actionable profile summary, which shows the number of
legal entities and registered users based on the information provided in your profile, and the number of connected users,
that is, the number of customers linked to your profile.

Clicking on the View link under Legal Entities takes you to the Admin / Legal Entity Setup page where you can add.,
update, or deactivate legal entities.

Clicking on the View link under Registered Users directs you to the Admin / Users page where you can invite new or
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manage existing users.

Ny
The profile summary also indicates if you have (V') or have not ('&') provided banking and diversity information, if you
accelerate orders/invoices, and if you have a bribery policy.

Profile information
To improve your progress by updating your profile, click on the:

» Improve Your Profile button on the Home page next to the section about your profile progress.
» Update Profile button in the Get Discovered with a Complete Public Profile popup.

» Edit Profile button on the Profile page after selecting Public Profile from the drop-down list.
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General Information

Address

Get Started with the CSP

“Name Awesome Supplier

- SNEE D

Address Line 1

Address Line 2

Profile Background m City
Industry \ Growing of cereals (except rice), = State
Year Established Postal Code
Short Description | abcdefghij Country/Region = United States ~
Full Description | aabbccddeeffgghhiij
Primary Contact
Registered Users john.doe@awesupplier.com ry
hallo ween@awesupplier.com
© Add New *First Name  Jane
Web Site | http://www.awesupplier.com
*Last Name Doe
LinkedIn pmmem http:/fwww_linkedin.com/company/awe
*Email | jane.doe@awesupplier.com
Facebook Profile n http://www facebook com/yourcompany Work Phone | B~ +1201-555.5555
Twitter Profile u htp /fwww twitter com/yourcompany Mobile Phone + +1201-555.5555
Fax Number | BB~ +1201.5555555
PO Delivery Email  jane.doe@awesupplier.com
Business Details
Company Size | 100-249 employees ~ Bribery and Corruption @) Yes, we have a policy
E Private — not published to your public profile Policy O No
. = Policy for Bribery and
Top Commedities | | Domestic pet products x Corruption
| Saddlery and harness goods | =
Select the top 5 UNSPSC categories you serve Diversity Uniled Siates ~
Ability One Program
[Alaskan Native Corporation x]
Corporate Social @ Yes
Responsibility Rating | coppup -
O No
O Not Sure
If your company has been rated by a social responsibility agency, indicate it
here

Financial & Legal Information

A Accelerate Enabled  Edit Preferences

Currencies “&H EUR % || HUF %

Select all the currencies you prefer

DUNS Number

ﬂ Secure Information — not published to your public profile

nManage banking information, remit to locati

Legal Entity
w legal entity 1

w legal entity 2
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Fill in the following fields:
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General Information

Get Started with the CSP

Setting Description

*Name

Your company's hame.

Logo

Select an image to upload as your company's logo.

Profile Background

Select an image to upload as the profile background.

Industry

Select your industry from the drop-down list.

Year Established

Enter the year when your company was established.

Short Description

Add a short description of your company.

Full Description

Add a full description of your company.

Registered Users

Add registered users by inviting them. For more information, see Manage Users.

Website

Enter your company's website.

LinkedIn Profile, Facebook
Profile, Twitter Profile

Enter the relevant link(s) to your company's social media profile(s).

Address

Address Lines 1 and 2, City,
State, Postal Code, Country/
Region

Enter your company's address.

Primary Contact

*First Name, *Last Name, *Email

Enter the name and email address of your company's primary contact.

Work Phone, Mobile Phone, Fax
Number

Enter the relevant phone number(s).

PO Delivery Email

Enter the email address where you want to receive your customers' purchase
orders.

Business Details

Company Size

Select a range from the drop-down list to show the size of your company.
Available options: self-employed, 2-9, 10-49, 50-99, 100-249, 250-499, 500-999,
1000-5000, and 5000+ employees.

This is private information and not published to your public profile.

Top Commodities

Select your top five UNSPSC Level 2 (Family) categories from the drop-down.

Bribery and Corruption Policy

Select the relevant radio button:

* Yes, we have a policy
* No

Policy for Bribery and Corruption

If you selected Yes, type in or copy and paste your policy.
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Diversity

Select a country/region along with a diversity type from the drop-down lists to
indicate if your business has a diversity ownership. Available options:

¢ United States
* Outside of the US
* None

Corporate Social Responsibility
Rating

Select a rating agency if applicable. Available options:

* CSRHub

* MSCI Inc.

* Truvalue Labs

+ EcoVadis

» Scope 5

» EnergyStar

* Inoxico (South Africa)
+ D&B

* LexisNexis

* Workato

» Ecodesk Horizon
* RBA

* IntegrityNext

« WBCSD's

* GreenSeal

+ GFSI

» Other

Financial and Legal Information

Accelerate Indicates if Coupa Static Discounting is enabled or disabled. Click on the Edit
Preferences link to modify your early payment discount preferences. For more
information, see Set Coupa Static Discounting Preferences.

Currencies Select all the currencies that you prefer.

DUNS Number

Enter your Data Universal Numbering System (DUNS) number.
This is secure information and is not published to your public profile.

Legal Entity subsection

Lists all your existing legal entities allowing you to manage them or add new ones
directly from this page.

If you have three or more legal entities, they are collapsed. To view their details,
click on the Down arrows.

Clicking on the Add Legal Entity button directs you to the Legal Entity Setup
page. For more information, see Set up Legal Entities.

Reuse your customer-specific profile information in your public profile
When you receive a supplier information form request from your customer to create or update your profile, you can copy/
save the provided information to your CSP public profile. After submitting your supplier information for approval, click

Valid until January 31, 2021




CSP Admin and User Guide Get Started with the CSP

Yes, Copy to Profile in the appearing popup window.

Note: Your existing CSP profile data is overwritten with the data you provided in the supplier
information form only when you save the form.

Save This Information to Your Public Profile?

With a complete and current profile, you can

Q A e

Get discovered by Coupa's buying Help your other Coupa buyers link io your Set early payment discounts and more
Communiy acrount

Nt Mow Yes, Copy to Profile

You are directed to the Public Profile edit page where the following fields are automatically populated (and highlighted
in yellow) based on the provided information: Name, Industry, Full Description, Website, Bribery and Corruption Policy,
Address (all fields), Primary Contact (all fields), PO Delivery Email, and DUNS number. Save your profile to confirm the
updates.

Update and reuse your public profile information in your customer-specific profile
Keep your information accurate and up to date for each of your customers.

Note: Depending on your customers' settings, your customer-specific profile changes may update
the information that your customers have.

To update your customer-specific profiles, go to Profile > Your Customer Profiles. To manage a specific profile, select
the customer name from the Profile drop-down list. If you do not see the customer you are looking for, it means that you
are not connected to them yet. You cannot see them in the Select Customer drop-down list on the Orders, Service/
Time Sheets, ASN, Invoices, Catalogs, and Payments pages either.

If any of your customers uses a supplier information form, and you update information in your CSP public profile, you are
prompted to update your customer profile if you have any supplier information form requests. You can update your
profile also for customers that do not use a supplier information form by requesting help from those customers' supplier
account owners.
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After editing and saving your public profile, you can see a green banner notifying you about your profile update status,
for example: "Your company info was successfully updated on your Public Profile and 2 customer profiles."

Depending on whether your customer profile is for a customer using supplier information forms or not, you can also see
popups with various information and instructions.

Action Needed: Update Customer Information X

You have 5 new or existing information requests. Thess requests must be sent to your
customers in order for them o have your updaled information:

Customer One w’' Can be submitted for approval Open
Customer Two 1 Some edits required Qpen
Customer Three +' Can be submitted for approval Open
Customer Four D Some edits required Qpen
Customer Five 1 Some edits required Open

To update 2 additional customer profiles, contact these customers directly. show details

Close

Customer profile update with supplier information form
The popups depend on the following scenarios:

» One or multiple supplier information customer profiles that are new/blank (not filled out) or saved (filled out and
saved).

» One or multiple supplier information customer profiles that are filled out and submitted for approval, or approved
and applied.

In the Action Needed: Update Customer Information popup, you are informed if you need to edit a specific form and
provide more information (due to the differences between the public profile fields and the customizable customer
profile fields), or if you can submit the form for approval as is.

Click on the Open button to open your customer profile for editing with fields (highlighted in yellow) pre-populated based
on your public profile.
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Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments Add-ons Admin

Your Public Profile *Your Customer Profiles

Customer One Profile | Customer One -

+ We have auto-filled some information from your Public Profile. Show changes

i)
Supplier Information Awesome Supplier
Primary Address
Country/Region | United States ~

Address Name | |
Street Address | 123 Success St |
Street Address 2 | Suite 13 |

City | Money City

State Region | Select 2

Postal Code | 24420

|
Location Code | |
PO Box | |
PO Box Postal Code | 94420 |
Name JonDoe |
PO Method | Email v |
e [omoee
Preferred Currency \:|
DUNS Number 12345678 | @

PO Email ‘ john.doe@awesomesupp |°

Decline Save Submit for Approval

Add the missing information and submit your form for approval.

Note: If you make changes, you are asked if you want to save the new information to your public profile. For
more information, see Reuse your customer-specific profile information in your public profile.

If you try to submit your form for approval before it is approved, you are informed in a red banner that it is pending
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approval. To update your profile, you need to withdraw the request and resubmit your changes.

Tip: If you close the popup, you can open it any time from your Notifications by clicking on the
Update information requests notification. For more information, see View and Manage Nofifications.

Customer profile update without supplier information form
In the Action Needed: Update Customer Information popup, in the yellow banner, you are informed that you
need to contact one or more customers directly to update your customer profiles for them.

Click on the show details link to see the names of customers that you need to contact. Clicking on a name allows you
to email directly to the customer's supplier account owner who can help you with updating your profile.

Action Needed: Update Customer Information X

You have 5 new or existing information requests. These requests must be sent to your
customers in order for them to have your updated information:

Customer One +' Can be submitted for approval Open
Customer Two +/ Can be submitted for approval Open
Customer Three w" Can be submitted for approval Open
Customer Four D Some edits required Open
Customer Five 1) Some edits required Open

To update 2 additional customer profiles, contact these customers directly. hide details

Open each customer profile to view the contact email address, and send them a link to your
public profile. (Note: some customers may not have contact emall listed.)

Customer X
Customer Y

Close

If you select a customer from the Profile dropdown on Your Customer Profiles page, you can see a yellow banner with
instructions depending on whether your customer provided one, more, or no supplier account owners.

If the customer provided supplier owner contact information, you can email them directly by clicking on the email
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address (one contact email) or on the send them an email link (more email addresses).

Home Frofile Orders Service/Time Sheets  ASN Invoices Catalogs Fay
Your Public Profile Your Customer Profilas
Profile  Customery b
To update your information with this customer, send them an email with your new information.
john.doe@customery.com
jane. doe@customery.com
Address

Note: If your customer did not provide a supplier owner contact (email), you cannot contact them from this
popup. You need to contact them through the same channel(s) as before.

If your customer does not use a supplier information form, depending on their settings, you might be able to see the Edit
button and edit your customer profile.

Update your customer profile

When you register or log in to the CSP to do business with a customer that uses an onboarding flow, you

are guided through the following elements of the flow to provide your customer with the necessary information:
welcome message, basics, payment, and profile.

Note: Some elements of the onboarding flow, for example, fields for invoicing setup and bank information for
payment, are available only if you are based in the US, that is, your selected country/region is the United
States. If you are not a US-based supplier, only the basics and profile elements, and the payment discount
preferences settings are available.

You can provide this data when setting up legal entities after onboarding.

Welcome message
For more information, see Create Your Account and Log in to the CSP.

Basics
Clicking on the Get Started or Continue button takes you to the Tell us about your business page where you can
provide your basic information.
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Note: Providing your address is required.

Tell us about your business @

* Company Name | Awesome Supplier

Website

* Country/Region ~
* Address Line 1
Address Line 2
*City
State

* Postal Code

Tip: Click on the Info (0) icon to learn more about the fields.

Fill in the following fields: Company Name (registered company name to be displayed on your invoices), Website,
Country/Region, Address Lines 1-2, City, State, and Postal Code.

Note: Name and address fields are pre-populated if your customer already has the information from you in
their supplier record, or if you are already registered to the CSP to transact with other customers and
provided the information in your profile. You can also choose to update these fields.

Mandatory fields are marked with a red asterisk (*).

If you are not a US-based supplier, at the bottom of the page you are informed that you are All set for now. On your
first invoice with <customer name> , we will guide you through your legal entity setup.
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If you are a US-based supplier, after providing your address, you also have the option to set up a legal entity. You can
Also use this address as: Invoice from location, Pay to location (Remit-To), and/or Ship from location by leaving
the relevant checkbox(es) selected. Or, if you want to provide a different address for invoicing, payment, and/or
shipping, deselect the relevant checkbox(es) and enter the new address.

Basics Payment Profile

Tell us about your business @

*Company Name | Awesome Supplier

r official registered company name

ur o g

Website

* Country/Region
* Address Line 1
Address Line 2
*City

State

* Postal Code

Also use this address as

United States

12345 Success 5t

Money City
CA
99999

Invoice-from location

VILIST maich your officia regisiersd company a0aress

(] Pay to location (Remit-To)

* Address Line 1 | 11111

Address Line 2 | Fruit Ave
*City | Orchard City
State |CA

* Postal Code | 98765

Ship from location

Advanced invoicing [C] We support integration for invoicing (cXML
or SFTP) and plan to use it with ACME Inc.

* Invoice from location is the main address of your registered business or the registered entity you will be invoicing
your customer from.
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» Pay to location is the address your customer will use to send your payment; remittance address.

+ Ship from location is usually your warehouse location.

Also, the Advanced Invoicing checkbox allows you to indicate if you support integration for invoicing (cXML or SFTP)
and plan to use it with your customer.

Tip: If you are already registered to the CSP and you set up a legal entity earlier, you can also see the Use
my current legal entity drop-down from which you can select your existing legal entity to provide it to your
new customer.

Payment
Clicking on the Next button takes you to the Provide your default bank information page where you can provide your
payment information.

Note: You can see the page for bank information only if your customer uses Coupa Pay. Providing your
bank information is required.
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o o

Basics Payment Profile

Provide your default bank information @

ui Bank Information
Country/Region
Currency
Routing Number
Account Number

* Confirm Account
Number

Bank Name
* Address Line 1
Address Line 2
* City

State b
* Postal Code
Card Payment

[0 1accept card payment

Back N

RS- S—

Fill in the following Bank Information fields: Country/Region (defaulted), Currency (defaulted), Routing Number,
Account Number, Confirm Account Number, Bank Name, Address Lines 1-2, City, State, and Postal Code. The
address that you entered when providing your basic information is also linked to this payment account.

Mandatory fields are marked with a red asterisk (*).

Indicate if you accept card payment by selecting the checkbox under Card Payment. If you accept card payment,
you need to specify the email address where you want to receive the card.

Tip: If you selected a legal entity that contains US banking information, at the top of the page you can see
the Payment Address section to select the address from the Remit-To drop-down to pre-populate the bank
information fields for your new customer, instead of providing new bank information.

Clicking on the Next button takes you to the Would you like to offer discounts to get paid faster? page where you
can set your Payment Discount Preferences (static discounting, formerly: Coupa Accelerate preferences). These
preferences are automatically applied to all your invoices with the customer.
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Note: Providing your payment discount preferences is optional. The selected payment terms can be used
only with your Coupa Pay customer(s).

@ @

Basics Payment Profile

Would you like to offer discounts to get paid faster? @

i Payment Discount Preferences

Your default payment term Automatically replace with this discount
you can change this later

Netso P 1%/10 NET 30 v
Net 45 ’ ' Tr— -
Net60 P None

1.5%/M15 NET 45
Net75 dm

1%/25 NET 45
— ’ 0.5%/35 NET 45

Net 120 ’ None -

%Use these preferences for all your customers

On the left you can see your default payment term(s), and on the right, you can select new terms to automatically
replace the existing ones.

If you want to apply the selected payment terms to all your customers, select the Use these preferences for all your
customers checkbox.

Tip: You can modify them later at any time from Setup > Admin > Payment Preferences > Static
Discounting.

Use the Back button to go back to the pages with bank and basic information.

Profile

Clicking on the Next button takes you to the page informing you about your successful setup that allows you to do
business with your customer.
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Basics Payment Profile
zcoupa
Welcome to the Coupa community. You're all set with ACME Inc.!

Make your company stand out in searches.
Find your next customers by updating your profile.

Enhance your Coupa profile

< <«

Show Up In Top Share Your Get Invited To
Search Results Diversity Sourcing Events

Do it later

You are encouraged to update your public profile so that other customers can also find you.

Note: Providing more profile information is optional.

Click on the Enhance Your Coupa Profile button to provide profile information related to your diversity, commodities,
and transactions.

On the Are you a diverse business? page, select a country/region from the dropdown list and select all the diversity
types that apply. Your selections are highlighted.
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Basics Payment Profile

Are you a diverse business? @

Country/Region | United States ~ ‘

You can select diversity in multiple countries/regions

[ Small Business Enterprise J Disadvantaged Business Enterprise
Woman Ownad Small Business Woman Owned Business Enterprise
[ Minority Owned Business Enterprise J Veteran Cwned Business
Show More
Back

Clicking on the Next button takes you to the Do you have diversity certificates? page where you can upload the
relevant document(s).
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Basics Payment Profile
Do you have diversity certificates? @

ncrease the spotlight given to your diversity by uploading a certificate. A verified
diversity status ensures a higner ranking when customers look for new s

LA

mall Business Enterprise - United States

Add Certificate Upload

Agency

Certificate ID

Date Issued | mm/dd/fyy  [a# * Expiration Date | mm/dd/yy [

Description

Cancel Save

Minority Owned Business Enterprise - United States

Add Certificate Upload

Back

Get Started with the CSP

After uploading a certificate, you can select the certifying agency (or add it if it is not in the list), enter the certificate ID,

indicate the issuance date and the (mandatory) expiration date, and provide a description.

Tip: You can upload multiple certificates for a diversity type.

Clicking on the Next button takes you to the Your commodities and area of service page where you can select the top
five UNSPSC categories you serve from the Commodities dropdown list. Indicate your Area of Service by selecting
the relevant radio button: Global or Regional. If you serve several regions, select the widest area that applies. You can

exclude up to five areas by entering them in the Exclusion Areas field.
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Basics Payment Profile

Your commodities and area of service @

Commodities ~

Select the top 5 UNSPSC categories you serve

Area of Service O Global @ Regional

f you serve an entire region out a few exceptions YOou can exclude them nere

=]
w
3
T
L
[
=]

Add a region

Exclusion Areas | Add an exception

pack —

Clicking on the Next button takes you to the Almost ready to do business... page where you can provide your PO
email address (where you want your customers to send you purchase orders), DUNS number, and preferred currencies.
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o & @

Basics Payment Profile

Almost ready to do business... @

PO Email Address | john.doe@awesomesupplier.com

DUNS Number | 12-345-6789 0

Preferred Currencies | USD = AUD = RON x

Back —

Note: The DUNS number is secure information and is not published to your public profile.

Clicking on the Next button takes you to the Congratulations page informing you about your successful setup that
allows you to do business with your customer.
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o o @

Basics Payment Profile

Congratulations!
You are ready to do business with ACME Inc.

Coupa customers look for new suppliers daily.
Make your company stand out in searches, enrich your profile now!

You are encouraged to update your public profile so that other customers can also find you. Click on the Take Me
There button to open your public profile in edit mode. For more information, see Create or Update Your Profiles.

Note: Providing more profile information is optional.

Note: If your customer requested additional supplier information, you are informed that you are one step
away from doing business with your customer, and the Take Me There button directs you to your
customer profile in edit mode to respond to the supplier information form request.

Customer setup progress
You can exit any element of the flow any time by closing it with the x in the right corner above the Coupa logo, and you
can continue the flow to provide your information later.

On the Setup > Customer Setup page, you can see the list of all your customers and the status of your onboarding flow
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(setup progress) with each of them indicated by the green progress bar.
Select the customer name to see the relevant instructions and buttons to take the necessary actions.

+ If you completed the onboarding flow, you can start transacting with your customer. You can go to the Admin page
for more setup options by clicking the Edit Your Setup button, or you can edit your public profile by clicking the
Edit Public Profile link.

Admin Customer Setup

Customer Setup

e We have all the basic info we need for you to begin transacting with
— ACME Inc.

Customer Two
.|

Edit Your Setup

W ACME Inc.

Edit Public Profile

» If you exited the flow before completing it, you can resume it with the Finish Setup button.
» If you have not provided information for your customer, you can Start the flow.

If you have not completed the flow for a customer, you are prompted to complete the customer setup when you log in

again.

Valid until January 31, 2021 61



CSP Admin and User Guide Get Started with the CSP

Enable or Disable Two-Factor Authentication

On the My Account page, click on the Security and Two-Factor Authentication link to enable or disable two-factor
authentication.

Note: Your customers can require you to use two-factor authentication to access their data in the CSP, in
which case you have to enable it.

1 - SUPPLIER1 ~ NOTIFICATIONS HELP ~
£;xcoupa supplier portal (2]
Account Se ' ]
Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Add-ons Admin Notification H &
Log Out

My Account Security & Two-Factor Authentication

Mobile Phone Verification

Mobile Phone - Not verified

=
Secunity & Two-Factor This phone will receive SMS Notifications

Settings

MNotification Preferences

Authentication

Two-Factor Authentication

SMS : Disabled

r mobile phone to receive verification codes by text message

Two Factor Authenticator App : Disabled

Enable two-factor authentication
Note: If you want to receive SMS notifications or verification codes, you must enter and validate your phone

number under Mobile Phone Verification.

Under Two-Factor Authentication, click Enable for SMS or for Two Factor Authenticator App depending on how you
want to receive the verification codes.

» For SMS, enter the verification code in the pop-up window.
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Enter the code that you received by SMS

Your verification code has been sent to: +1 201-555-5555
*Code
Cancel Resend Code OK

After successful validation, you receive the verification codes in text messages.

» For installing and using Google Authenticator, follow the on-screen instructions.
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Two-Factor Authentication

Kesp unauthoized users oul of your aceount by using Bath your passwond and your
phona. Setup your two-Tactor authentication ¢odes with thesa 3 aasy steps. You wil only
he asked 1o enfer valdation codes once eveny 30 days, or when you try toagin from a
differan comgiitar

1. Download Google Authenticater mobile app

oot T GETIT B
L S~ Coosc oy

2. Scan this QA code using Google Authanticator app

3. Enter tha &-d gl[ validation code apen your mobile
device's 'Google Authenticator app to get this. If you lost
your phene ar deletad the app, use a backup code to get
logged in.

Twwe Factor Code

Hemember this computer for 30 days
Mo Thanks, Contins without additional security m

Choose Remember this computer for 30 day if you are not using a shared or public computer, and click Enable.

Print your backup codes or email them to yourself before you click OK. If you ever lose your device, you need these

to regain access to your CSP account.

Note: You can only use a recovery code once, so refresh your list if you have to use a recovery code.
Go to Account Settings > Security & Two-Factor Authentication and click Regenerate Recovery

Codes to get a new list of codes.

For more information, see Install Gooale Authenticator.

Disable two-factor authentication
Under Two-Factor Authentication, click Disable for SMS or for Two Factor Authenticator App and, in the appearing

window, enter your CSP password and click Disable Two-Factor Authentication.
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If you enable or disable two-factor authentication, you get an email notification of the change.
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Manage Your Account

On the My Account Settings page, you can make changes to your personal information (name, department, role, and
password), set or modify your notification preferences, or enable/disable two-factor authentication.

Note: You can access and edit you company information on the Profile page.

To change your account settings, click on your name link and on the Account Settings link.

SUPPLIERNAME ~ | NOTIF

Account Settings
Maotification Preferences

Log Out

Personal information
On the appearing My Account Settings page, fill in the fields you want to change, and then click Save. The asterisk (*)
indicates mandatory fields.
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My Account settings

Settings User Details

Notification Preferences
* First Name | Jane

Security & Two-Factor
Authentication *Last Name |Doe
* Email | jane doe@awesupplier.com

Department | Operations ~

Role | E-Commerce Manager ~

Change Password

* Current Password

* Password

Use at least 8 characters and include a number and a letter.

* Password Confirmation

Setting Description

User Details

*First name This is you personal first name.

*Last name This is your personal last name.

*Email This field cannot be changed. If you want to change it, you have to create a new
CSP account and connect it to your company. For more information, see Manage
Users.

Department The name of your department: Sales, Operations, Accounts
Receivable, Treasury, or Other.

Role Your role within the department:

» Sales: Sales Manager, Sales Associate, Other

Valid until January 31, 2021 67



CSP Admin and User Guide Get Started with the CSP

Setting Description

* Operations: E-Commerce Manager, Order Fulfillment/Inventory
Management, Other

* Accounts Receivable: Accounting Manager, Accounts Receivable Associate,
Other

» Treasury: Treasury Manager, Other
« Other: Enter free text.

Tip: If you select Other for Department and/or Role, the User Specified
Department and/or User Specified Role fields are displayed for you to
enter free text.

Change Password

*Current Password Your current password.

*Password Use this field to change your password. It must be at least 8 characters long and
it must include a number and a letter.

*Password Confirmation This field needs to match the password that you typed in the Password field.

Click on the Notification Preferences link to set or modify your notification preferences. For more information, see
View and Manage Notifications.

Click on the Security & Two-Factor Authentication link to enable/disable two-factor authentication. For more
information, see Enable or Disable Two-Factor Authentication.
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Navigate and Get Help

Help

Chat
Whether you are logged in to the CSP or not, you can chat with Coupa Support to get a quick response or resolution to
your case.

Note: This is not a chat option for communicating with your customers.

1. Click Chat with Coupa Support in the bottom right corner of the page to launch the chat.

gxcoupa supplier portal

Register Log In
New to Coupa? Create your account or click here for help. Welcome back! Login or click here for help.
First Name * Email Address | Email Address
Last Name *Password | Password
Company
* Email Forgot Your Password?

ﬂ Chat with Coupa Support

Note: If all the support agents are offline or busy, you can Send a support request through an offline
form in the same chat window.

2. Provide your contact information: first name, last name, email address, and phone number (optional).

Tip: If you are logged in to the CSP, your contact information is pre-populated, but you can modify it.
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f Chat with Coupa Support X

This support service is for technical issues with the
Coupa Supplier Portal only. For questions relating to
transactions, please contact your customer directly.

This chat session will be saved as part of the supplier
support request ticket. Continuing with this session wil
constitute your consent for this action

*First Name *Last Name

*Email

Phone

Note: If no support agent is available, you also need to provide the subject of your request and a
detailed issue description, after which you can see a confirmation that your case was submitted and
logged. A support agent contacts you as soon as they are available.

3. Start chatting with the support agent.
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Martin L =

How may | help you?

I’_“‘\ i '—'—h‘\
(@) (=)

Save Transcript End Chat

Chat started at 8:27 AM

Hello! I'm Martin, how may |
; be of assistance today?

Martin L

Hi Martin, | need help with
creating a CSP account.

‘ [Type your message

If the support agent asks you to send a file, a paperclip icon appears on the left of the field where you type your
message.

Tip: After the chat ends, you can save the transcript.

Note: Your account and login information is not stored and support agents cannot log in to your CSP.
However, information provided in the chat is logged, so do not provide unnecessary personal information.

When you browse, the chat window persists on all the pages except for your Public Profile page, and you can minimize
it by clicking on the opposite arrows icon in the top left corner.

The chat is available also when accessing the CSP from a mobile device.

Help Tour and Online Help
When you log in for the first time, you are greeted by the Help Tour (welcome four) on the Home screen.

Click on the Help link in the top right corner of the page to access the Online Help or to view the Help Tour any time.
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NOTIFICATIONS )  HELP ~

Help Tour
Online Help

Main menu
To access a CSP function, click on the relevant tab on the main menu at the top of the CSP main page.

£xcoupa supplier portal SUPPLIERNAME ~ | NOTIFICATIONS HELP v
Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments  Add-ons Admin
Great job! A complete profile helps you get paid faster and get discovered Learn More Announcements viewa )
Profile Progress Last Updated . 4 Welcome! (Coupa Customer #1)
— (0% COmplete (D about 2 weeks ago Improve Your Profile Thank you for using the Coupa Supplier Portal to

transact with Coupa customers. Here you can view

Prof”e SUmmary A4 Acknowledging POs (Coupa Customer #1)

In the header area of our POs there is a checkbox
called "Acknowledged". If you think there is a delay

7 2 P Merge Accounts
Legal Entities Registered Users Connected Customers IT your company has more than one CSP account, we
View View try to list it below. Consider merging them fo reduce
confusion for existing and potential customers.
Mot seeing the account you want to merge with? Click
+ Banking Info  + Diversity: Minority-owned business « Accelerate « Bribery Policy here.
Supplier Name Latest Customers

Coupa Customer #1
Website () hitp:/iwww suppliercompanyname com Coupa

Industry & Your industry classification
About 4 Short description of your company

Established = 1974
Top Commeoedities & Your top commodities
Currencies § USD EUR

Diversity & Minority-owned business

Corporate Social 4 CSRHub
Responsibility Rating

Public Profile ) Profile

Menu Item Description

Home View and improve your public company profile, see the list of customers you are
connected to, edit your customer-specific company profile, and merge accounts.
You can go to the Home page from any page by clicking on the coupa supplier
portal logo/link in the top left corner above the main menu.

Profile Create, modify, and manage your public and customer-specific profiles, and
specify which remit-to addresses each customer can use.

Orders View the purchase orders you received from your customers.

Valid until January 31, 2021 72



CSP Admin and User Guide Get Started with the CSP

Menu Item Description

Service/Time Sheets View the list of service/time sheets and related purchase order lines.

ASN Send advance ship notice, that is, notifications about when you ship items to your
customers.

Invoices Create and manage invoices to send to your customers.

Catalogs Create and manage customer-specific catalogs.

Payments Accept payment through digital checks from your customers if they use
Coupa Pay.

Business Performance View a summary of orders and invoices that may need attention, your year-to-

date order and invoice trends, and your lead time to shipping goods.

Add-ons Access Coupa supplier add-ons, for example, Coupa Advantage, Coupa
Accelerate, supplier profile update, and more.

Admin Manage users, merge requests, and remit-to addresses, set up electronic
invoicing, add fiscal representatives, view and accept the Terms of Use, and set
preferred accelerated payment terms.
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View and Manage Notifications

Hover your cursor over the Notifications link to see your unread system notifications. Only the three most recent
notifications are shown.

SUPPLIERNAME ~ | NOTIFICATIONS @@ | HELP ~

An invoice Is approved ®
Invoice 101814 for $36.00 has been approved to pay

by Coupa Customer #1
nol A new order is received ®
—J Mew PO 2827 for $36.00 issued by Coupa Customer
#1
We
ank | New Early Pay Customer ®
— Coupa Customer #1 can pay your invoices faster
using Coupa Accelerate. Update your preferences

Ack
the

See All Motifications

To view all the notifications with their details and to manage them, click on the Notifications or the See All
Notifications link.

M y N Otlfl Cat | ons Notification Preferences

View

Message Received
0 z:f:ad Invoice 101814 for $36.00 has been approved to pay by Coupa Customer #1. 09/10/19 02:35 PM
O Announcements New PO 2827 for $36.00 issued by Coupa Customer #1. 09/08/19 02:30 PM
0 Coupa Customer #1 can pay your invoices faster using Coupa Accelerate. Update your preferences. 07/3119 07:29 PM
0 Update your profile for Coupa Customer #1 07/31/19 07-:28 PM
0 You are now connected to Coupa Customer #1 07/31/19 07:28 PM
Delete Mark as Read

On the My Notifications page, you can view all your (read and unread) notifications, or you can filter by category (FYI,
Todo, Unread, or Announcements). You can select and delete them all or one-by-one.

Clicking on a natification link takes you to the relevant page.

To change your notification preferences, click on the Notification Preferences button in the top tight corner. Or click on
your name link and on the Notification Preferences link.
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SUPPLIERNAME ~ | NOTIF

Account Settings
Maotification Preferences

Log Out

You can access the notification preferences also from your Account Settings. For more information, see Manage Your
Account.

On the My Account Notification Preferences page, select the radio buttons for the items that you want to receive any
or all of the notification types: online (to do list), email, or SMS (short text message). You will start receiving notifications
when your customers enable them.

Note: You can choose to receive notifications in short text messages only if you have an SMS-capable
device and you validate your phone number. For more information, see Enable or Disable Two-Factor
Authentication.

SMS notifications are turned off by default.

If you turn SMS notifications on, but you disable mobile phone verification, your SMS notification selections are deleted.
You can also stop receiving SMS notifications if you reply STOP.

Setting Description

Announcements

New Customer Announcement Enabled by default: Online and Email

Note: You cannot disable online notifications for announcements.

Business Performance

Business Performance role Enabled by default: Online

granted

Catalogs

A new comment is received Enabled by default: Online and Email
A catalog is approved Disabled by default.

A catalog is rejected Disabled by default.

A catalog is about to expire Disabled by default.

Coupa Accelerate

New Early Pay Customer Enabled by default: Online and Email

Valid until January 31, 2021 75



CSP Admin and User Guide

Get Started with the CSP

Setting Description

Coupa Pay — Available only if your customer uses Coupa Pay and enabled the related features.

New digital check

Enabled by default:

Online and Email

New virtual card

Enabled by default:

Online and Email

Virtual card reissued

Enabled by default:

Online and Email

Virtual card reminder

Enabled by default:

Online and Email

Payment role given to user

Enabled by default:

Online and Email

Virtual card processing failure

Enabled by default:

Online and Email

Bank transfer remittance advice

Enabled by default:

Online and Email

Virtual card remittance advice

Enabled by default:

Online and Email

Zero payment remittance advice

Enabled by default:

Online and Email

Digital Check Cancelled

Enabled by default:

Online and Email

Virtual Card Cancelled

Enabled by default:

Online and Email

Early Payments — Available only if your customer enabled the feature.

Early payment request expired

Enabled by default:

Online and Email

Early payment request rejected

Enabled by default:

Online and Email

Early payment request matched

Enabled by default:

Online and Email

Early payment request paid

Enabled by default:

Online and Email

Form Responses

A form response is approved

Enabled by default:

Online and Email

A form response is rejected

Enabled by default:

Online and Email

Supplier information is updated

Enabled by default:

Online and Email

A new comment is received

Notifies you if your customer sends you a new comment or a reply to your
question/comment regarding a Supplier Information Management (SIM) form

request/response.
Enabled by default:

Online and Email

A form response needs your
attention

Enabled by default:

Online and Email

Integration Errors

Enable notification for integration
error

Disabled by default.
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Setting Description

Invoices

A new comment is received

Enabled by default:

Online and Email

An invoice is approved

Enabled by default:

Online and Email

An invoice is paid

Enabled by default:

Online and Email

An invoice is disputed

Enabled by default:

Online and Email

An invoice is withdrawn from
dispute

Enabled by default:

Online and Email

Legal Invoice Export Ready

Enabled by default:

Online and Email

An invoice is abandoned

Enabled by default:

Online and Email

Orders

A new comment is received

Enabled by default:

Online and Email

A new order is received

Enabled by default:

Online and Email

An order is canceled

Enabled by default:

Online and Email

Order Header Changes

Order change request is rejected

Enabled by default:

Online and Email

Profile

Public profile is updated

Disabled by default.

An information update request is
received

Enabled by default:

Online and Email

Profile update reminder is
received

Disabled by default. Future functionality.

Update information requests

Disabled by default. Future functionality.

Receipt Request

Receipt created

Disabled by default.

Terms of Use

New Terms of Use are received

Enabled by default:

Online and Email

Users

A new customer connection is
created

Enabled by default:

Online and Email

Service/Time Sheets
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Setting Description

A Service/Time Sheet is Enabled by default: Online and Email
approved

A Service/Time Sheet is rejected | Enabled by default: Online and Email

You also receive notifications displayed in a green bar following certain actions, for example:

Catalog is being deleted X

Note: If you change your notification preferences, remember to save them.
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This chapter contains the following topics:

View Business Performance Data

You can view a summary of orders and invoices that may need attention, your year-to-date order and invoice
trends, and your lead time to shipping goods.

View Customer Announcements
View announcements from your customers.

Configure Punchouts
Configure customer-specific punchouts by going to the Catalogs page and clicking on the Configure Punchout button.

Configure the PO Delivery Method
Select how you want to receive orders on the Orders page by configuring the PO delivery method.

Create or Edit an ASN
Notify your customer in advance of a shipment.

Create or Edit an Invoice
Work with existing invoices or create new invoices without a backing PO.

Create or Edit a Catalog
Create or edit a customer's catalog by going to the Catalogs page and by selecting the specific customer.

Create or Edit a Service/Time Sheet
Work with service/time sheets to provide information about your progress.

Create or Edit Catalog Iltems
Create or edit items in your customer-specific catalogs.

Edit a PO

Edit purchase orders and purchase order lines.

View and Download Digital Checks
Accept payment through digital checks from your customers if they use Coupa Pay.

View and Manage ASNs
View ASN information that you shared with your customers.

View and Manage Catalogs
View, edit, or delete your customer-specific catalogs.



View and Manage Invoices
View and edit invoices that you sent to your customers.

View and Manage Payments
View and manage overdue payments, early payment discount requests, tasks, and payment preferences.

View and Manage POs

View purchase orders received from your customers.

View and Manage Service/Time Sheets
View, edit, delete, or withdraw service/time sheets.

View Invoice Lines
View individual invoice lines by going to Invoices > Invoice Lines.

View PO Lines
View individual PO lines by going to Orders > Order Lines.

View Public Sourcing Events
You can access and participate in public sourcing events.

View Service/Time Sheet Lines
View individual service/time sheet lines by going to Service/Time Sheets > Service/Time Sheet Lines.
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View Business Performance Data

Click on the Business Performance tab on the main menu to view a summary of orders and invoices that may need
attention, and year-to-date order, invoice, and delivery time trends.

Note: You can see this page only if you have the Business Performance permission. For more information,
see Manage Users.

View the order/invoice summary dashboards
In the top left corner, select from the list or search for the customer for which you want to see performance data.

Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments Business Performance Sourcing  Add-ons
-~
Setup
My Customers
/ 9 Best Buyer
Best Buyer
Leamlng Center O rde s Orders that you haven't invoiced
Add a customer R
jRaniisetipadisaiie) Past Due Change Requested Not Invoiced
25 0 31 5
Feedback View View View

Tell us what you think

Invoices
Pending Approval Unpaid Overdue Disputed
7 23 6 0
View View View View

The selected customer name appears at the top of the page and below it, you can see a summary (with numbers and
statuses) of your orders and invoices that need attention as follows:
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Document Status Description
Type
Orders
Past Due For an issued order, if the "need by date" has passed and the order is not
complete.
Not Acknowledged The number of orders that you have not acknowledged. Shown only if you
acknowledged at least one order in the past.
Change Requested Orders for which you or your customer have requested a change.
Not Invoiced Orders that you have not invoiced yet.
Invoices
Pending Approval Invoices that have not been approved by your customer yet.
Unpaid Coupa Pay customer invoices that have not been paid yet.
Overdue Invoices that have not been paid yet and are past the due date.
Disputed Invoices that you or your customer have marked as disputed to indicate an
invoice discrepancy.

Tip: To see the description for a status, hover your cursor over the relevant number.

Clicking on the View links takes you to the Orders or Invoices page, respectively, showing only the list of orders/
invoices relevant to the status selected to view.

Note: The View links are visible only if you have permission to view orders/invoices.

View order/invoice/delivery time trends
Below the summary dashboards, you can find graphs for order, invoice, and delivery time trends for the past 12 months.

Note: The data provided is directional and for informational purposes only, and may be delayed up to one-
two weeks.

The order/invoice graphs show the volume/amount and count/number of your orders/invoices by month.
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Order trends
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Hover your cursor over Volume or Count in the legend to highlight the relevant data.

Order trends
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Hovering your cursor over the volume bar or count line shows you the volume or count of orders/invoices by month.
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Delivery time trends show the average delivery days (time in days between the order date and the receipt date) and the

number of orders delivered by month. Hover your cursor over the graph to see details.

Delivery time trends
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Data provided is directional and for informational purposes only, and may be delayed up to 1-2 weeks.
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Cases when data or customer is missing

 If no data is available, for exmaple, there are no orders or invoices with the selected customer, the We could not
find any relevant (order/invoice) data message is displayed.

+ If you have no transactions (orders or invoices) with a customer, the Before we can show you any cool stuff we
need you to get some orders and invoices in here! message is displayed.

+ If you are not connected to any customers, the following message is displayed: You need to be connected to
your customer before we can show you any cool stuff. Ask your customer to send you an email invitation
from Coupa. This document explains the steps they need to take. It's super easy. The This document link
takes you to the page where you can learn how to add and connect with a customer in the CSP.

Learn more and provide feedback
In the top right corner below the list of customers, you can find the Learning Center and Feedback sections. Click on

the following links:
« Add a customer to learn how to add and connect with a customer in the CSP.

» Want to get paid earlier? to learn about payment options.

» Tell us what you think to provide feedback and suggestions to Coupa.

Tell us what you think X

We're thrilled that you tried out this feature and want to provide
suggestions to help improve it.

From:

jane.doe@supplier.com

Your message:

Cancel

The Submit button is enabled only when you enter text in the Your message field. After submitting your message,
a green notification bar informs you about Feedback sent.
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View Customer Announcements

Your customers can create announcements to be shown to you on the Home page and/or other Coupa Supplier Portal
(CSP) pages to help you understand their unique onboarding requirements and communicate with you about initiatives,
promotions, and changes required for your collaboration through the CSP. With this one-way communication, your
customers can, for example, provide you with instructions on how to join or what to do after joining the CSP, share with
you information necessary for transactions, inform you about upcoming orders, remind you of updating supplier
information, and more.

You can see your customers' announcements at the top of the right section of the Home page.

SUPPLIERNAME ~ | NOTIFICATIONS @) @ HELP -

Announcements View Al (4
N,
# Upcoming Holiday (Customer1)
Please note that our offices will be closed on
Thursday, July 4

&4 2019 Customer2 Supplier Day (Customer2)
Download information on our 2019 Customer2
Supplier Day

Merge Accounts

Note: By default, only previews of the two most recent announcements are displayed. You can see the full
text of an announcement in a popup after clicking on it.

To view all the announcements with their full message, click on the View All (n) link that takes you to the My
Notifications page filtered by Announcements. For more information, see View and Manage Notifications.

The announcements are also shown where all the other notifications appear, that is, in the Notifications and My
Notifications sections.
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SUPPLIERNAME ~ = NOTIFICATIONS @& | HELP -

A new order is received ®
Mew PO 2971 for $10.00 issued by Customer

« New Customer Announcement
Igle] Upcoming Holiday (Customer1)
B [lcase note that our offices will be closed on “

s Upg 4 New Customer Announcement
sase 2019 Customer? Supplier Day (Customer?)

wrsdl Download information on our 2013 Customer2 Supplier

» 201 See All Motifications

P e -y T S . . B o = VAP e .}

Online notifications are on by default.

Note: You cannot disable online notifications for announcements. Customers' announcements are always
shown on the Home and My Notifications pages for the set period of time.

Depending on your notification preference settings, you can also get online and/or SMS notifications.

If your customer selected other pages to inform you about their announcements, you can see a yellow banner at the top
of those pages notifying you about the number of announcements for those specific areas from the selected customers
and the link from which to access those announcements.

Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments  Add-ons Admin

4 You have 4 customer announcements related to Invoices (Customeri) View All Announcements
Select Customer Customer1 ~

Y

The banner is not visible on the Home, customer-specific Profile view, Admin, and Add-ons pages, and on the Public
Profile page accessed from the link under the Public Profile section on the Home page.

Clicking View All Announcements directs you to the My Notifications page filtered by Announcements. For more
information, see View and Manage Notifications.

Your customers can delete or edit their announcements. Deleted and expired announcements disappear from the CSP.
Also, if you delete a notification for an announcement, the announcement disappears from the Home page, too.
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Configure Punchouts

You can configure a punchout for a specific customer.

Note: You can configure your punchout only if your customer allows you to modify your profile.

On the Catalogs page, select the customer whose settings you want to modify and click on the Configure
Punchout button.

In the appearing window, provide the necessary information.

Punchout settings
All the fields are mandatory.

Setting Description

Name Name of the punchout, as it appears to users within Coupa.

URL The full punchout URL required to receive purchase orders in Coupa.
Buyer ldentity Your customer's buns OF Networkib.

Buyer Domain Part of the From section of the header in the orderrequest CXML. It can be

anything you define, but it is usually puns or networkin, depending on the
corresponding identity value.

Supplier Identity Your buns Of NetworkIDp.

Supplier Domain Part of the To section of the header in the orderrequest CXML. It can be anything
you define, but it is usually buns or wetworkin, depending on the corresponding
identity value.

Shared Secret A password that you and your customer agreed upon. If no shared password is
specified, Coupa automatically passes none.

Protocol This field should always be cxni.
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Configure the PO Delivery Method

You can configure how you receive POs from a specific customer.

Note: You can configure your PO delivery method only if your customer allows you to modify your profile.

On the Orders or Order Lines page, select the customer whose settings you want to modify and click on the Configure
PO Delivery button.

In the appearing window, select your PO delivery method and provide the necessary information.

PO delivery settings

Column Description

Purchase Order Method Choose how to receive POs from your customer:

* Email: Coupa automatically emails POs to the email address you enter.

* cXML: Coupa sends the PO via cXML. You have to enter the cXML settings
to use this option.

*« None

Note: If you want to use a method not listed here, talk to you customer
about alternatives.

PO Email This field is required for receiving POs via email. Coupa sends POs to this email
address. To specify multiple addresses, separate them with a comma.

cXML URL The full PO routing URL to receive POs.

cXML Domain Part of the From section of the header in the orderrequest CXML. It can be
anything you define, but it is usually buxs or wetworkin, depending on the
corresponding identity value.

cXML Identity Your customer's puns Of Networkip.

cXML Supplier Domain Part of the To section of the header in the orderrequest CXML. It can be anything
you define, but it is usually puxs or networkin, depending on the corresponding
identity value.

cXML Supplier Identity Your puns Of NetworkID.

cXML Secret A password that you and the customer agreed upon. If no shared password is
specified, Coupa automatically passes none.

cXML Protocol This field should always be cxni.
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Create or Edit an ASN

Note: This feature is available only if your customer enables it in Coupa.

When you receive a purchase order, you can flip it into an ASN and send it to your customer by clicking on the Flip to

ASN (::) icon for it in the Purchase Orders table. For more information, see View and Manage POs.

To edit a draft ASN or update one in pending receipt status, click on the Edit (s/) icon for it in the Advance Ship

Notices table.

On the Create Advance Ship Notice page, fill in at least the mandatory fields (marked with a red asterisk).

Create Advance Ship Notice

i) General Info & Ship To
~asN# |11 | Address 123 Value Drive
San Mateo, CA 94402
Status draft UsA
Ship Date )
Delivery Date ] £ Shlpplﬂg Info

Tracking Number
Carrier

Shipping Method

Ship Note
Lines
1 Description Quantity uom Received Quantity Status @
Blue Pens 0.00 Box 0 draft
Supplier Part Num PO # PO Line Po Line Quantity
123456789 3049 1 100.0
Invoice Num Reference Invoice Invoice Line Invoice Line Qty
Comments

Cancel s Save h Submit

Click on the Submit button to send the ASN to your customer, or on the Update button if you are sending an updated
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ASN.

Note: When you send an ASN to a customer, the PO status changes to Issued even if you have not sent
the customer an invoice yet.
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Create or Edit an Invoice

From the drop-down list in the top right corner of the Invoices page, select the customer for whom you want to create or
edit an invoice or a credit note.

Click on the relevant button above the Invoices table to:

* Create Invoice from PO.

» Create Invoice from Contract.

Create Blank Invoice.

* Create Credit Note.

Select Customer Coupa ~
Invoices
Create Invoices @
Create Invoice from PO Create Invoice from Contract Create Blank Invoice Create Credit Note
Invoice # Created Date ~ Status PO # Total Unanswered Comments Dispute Reason Actions
123 06/01/17 Draft 3050 113.20 No ,/Q
456 06/01/17 Disputed None 150.00 No
789 058/2717 Pending Approval 2949 3,750.00 MNo
121314 05/16/17 Approved 2891 15,000.00 No

Perpage 15 45 90

Note: Buttons are active only for the actions that you can do. For example, if your customer did not enable
you to create invoices without a backing document, the Create Blank Invoice button is inactive.

The Info icon with the tooltip next to the Create Invoices header advises you what to do if you cannot create an invoice
as expected, for example, contact your customer to enable more invoicing options for you.

Note: At the top of the page, you might see instructions from your customer.

Create an invoice from a PO

1. Go to the Orders page or, on the Invoices page, click on the Create Invoice from PO button above the table to
go to the Orders page.

2. On the Orders page, do one of the following:
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o Click on the Create Invoice ( =) icon for the PO in the Actions column of the Purchase Orders table.

Depending on your customer's settings, the tooltip text of the icon can also be Accept PO and Create
Invoice.

o Click on the PO Number link to open the purchase order and click on the Create Invoice button.

Purchase Order #3050

Status Issued - Sent via Email o Sh|pp|ng
Order Date 05/31/17

Ship-To Address 1855 South Grant Street
Revision Date 05/31/17 San Mateo, CA 94402
United States
Requester FirstName LastName Attn- FirstName LastName

Email FirstNamelLastName@coupa.com
Terms MNone
Payment Term Net 30 rzi Accelerate Payment

Attachments Nope

Acknowledged [

Lines
1 Type Iltem Qty Unit Price Total Invoiced
= Purple Spiral Notebook 200 Each 0.50 100.00 0.00
Part Number
MNaone

Perpage 15 45 | 90

Total 100.00 uUsD

Create Invoice Create Service/Time Sheets Request Change Save =i Print View

0 Comments

Add Comment

3. Add new or choose existing invoicing details, that is, add or select an invoice from, remit-to, and/or ship from
address.

When you select a legal entity, the popup displays the Invoice From addresses available for the legal entity and
information about how your customer(s) associated with the legal entity can pay you, for example, "This customer
can pay you by Bank Account or Credit Card."
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In case of multiple payment types, you might see multiple Remit-To and Ship From addresses for the different
payment types. To accept a new payment type, you might need to add a new remit-to type.

Choose Invoicing Details X

* Legal Entity | Legal Entity 1 v o Add New

Invoice From Success Street
Customer City, 12345
United States
United States

* Remit-To | Select v & Add New
* Ship From Address | Select v 0 Add New
Cancel

If you do not have a legal entity, you need to add one by clicking on the Add New link or on the add/plus (9) icon.
You are guided through creating your legal entity. For more information, see Set up Legal Entities.
The selected or newly created legal entity is added to your invoice.

4. On the Create Invoice page, fill in at least the mandatory fields (marked with a red asterisk) in your invoice. Some
of the fields are pre-populated with information from the PO. For more information, see Edit an invoice.

Create an invoice from a contract

1. Click on the Create Invoice from Contract button above the Invoices table on the Invoices page and select the
relevant contract from the drop-down list.

Select Contract

Select a Contract

| Test Hyper Contract 1 s |

Test Hyper Contract 1
Test Hyper Contract 2 incel
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2. Create a new or choose an existing invoice-from address. See step 3 in Create an invoice from a PO.

3. On the Create Invoice page, fill in at least the mandatory fields (marked with a red asterisk) in your invoice. For
more information, see Edit an invoice.

Create a blank invoice
1. Click on the Create Blank Invoice button above the Invoices table on the Invoices page.

2. Create a new or choose an existing invoice-from address. See step 3 in Create an invoice from a PO.

3. On the Create Invoice page, fill in at least the mandatory fields (marked with a red asterisk) in your invoice. For
more information, see Edit an invoice.

Create a credit note
You can issue a credit note to:

* Resolve a dispute on an invoice, correct an invoice, or cancel a duplicate invoice. For more information, see
Disputed invoices.

» Record miscellaneous credit, for example, return/cancellation of goods, price adjustments, rebates and refunds.
To create a credit note:
1. Click on the Create Credit Note button above the Invoices table on the Invoices page or, on the Orders page,
click on the Create Credit Note (E=E) icon for the PO in the Actions column of the Purchase Orders table.

2. Inthe appearing Credit Note popup, select the reason for your credit note.

Credit Note X

Ifyou are issuing a credit note in regards to a problem with an invoice or goods shipped, please
include the invoice number. If you are issuing a credit note purely to offer a credit to your

customer please select othar.

Reascon (@) Eesolve issue for invoice number Selzct an Option

i) Other (e.g. rebzte) 4@

o Resolve a dispute

If the credit note is related to a problem with an invoice or the goods shipped, select the Resolve issue for
invoice number radio button and, from the drop-down list, select the invoice number. Click Continue to
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select how you want to resolve the issue.

Credit Note X

How do you want to correct invoice "123466739" 7

i@ Completely cancel the invoice with a credit note o
() Adjust invoice with a credit note o

You can choose to issue a credit note to cancel and optionally correct the invoice or to adjust it. For more
information, see Disputed invoices.

Note: Only quantity or price can be reduced through partial credit notes.

o Record a credit

Select Other and click Continue. If a contract is available, you can also select it from the drop-down list.

Credit Note X

If you are issuing a credit note in regards to a problem with an invoice or goods shipped, please
include the invoice number. If you are issuing a credit note purely to offer a credit to yvour
customer please select other

Reason() Resolve issue for invoice number Select an Option L

@ Other (e.g. rebate}
Select a Contract (If applicable)

L

Create the credit note similarly to creating an invoice. For more information, see Edit an invoice.

If you completely cancel the invoice, you can edit the following fields: Credit Note Number, Credit Note Date, Supplier
Note, and Discount Amount. You can also add attachments (file, URL, or text) and an Image Scan, and modify PO
lines, the UNSPSC, and tax reason descriptions. The other fields are pre-populated and not editable so that all the
information is carried over from the original invoice.

If you adjust the invoice, you can also edit the price or quantity. Line level taxes are carried over from the invoice and
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are prorated based on the credit amount.

Note: Header level charges (for example, shipping, handling, miscellaneous, or header level tax) are not
brought over from the original invoice. To provide a credit for header level charges, you need to submit a
separate stand-alone credit note.

If you selected Other, you are asked to create a new or choose an existing invoice-from address before editing the
invoice. See step 3 in Create an invoice from a PO.

Edit an invoice

Fill in at least the mandatory fields (marked with a red asterisk) in your invoice.

If you create or edit a credit note or a PO-backed invoice, some of the fields are pre-populated with information from the
original invoice or the PO.

Depending on your customer's settings, you might be required to accept the PO and the following restrictions might
apply to the corresponding invoice:

» Currency — Cannot be changed from PO currency.

* UOM - Cannot be changed from PO line UOM.

* Price — Cannot be changed from PO line unit price.

* Quantity — Can be changed from 0 to the remaining quantity on the PO line.

» Amount — Can be changed from 0 to the remaining amount on the PO line.
These restrictions do not apply to credit notes.

To edit a draft invoice, do one of the following:

» Click on the Edit (+ ) icon for the invoice in the Invoices table.

+ Click on the Invoice # link to open the invoice and click on the Edit button.
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Create Invoice create

General Info
* Invoice #
01/11/19

* Invoice Date

Payment Term MNet 30 r# Accelerate Payment

*Currency | USD &
Delivery Number

Status Draft
Shipping Term | Standard ~

Image Scan | Browse... | Mo file selected.

Supplier Note

From

* Supplier
Supplier Tax ID

* Invoice From Address

* Remit-To Address

* Ship From Address

SUPPLIERNAME
MNaone

ABCD
123 Success Ave

Results City, XY 99999

United States

ABCD
123 Success Ave

Results City, XY 99999

United States

ABCD
123 Success Ave

Results City, XY 99999

United States

Work with the CSP

To
* Attachments o Add File | URL | Text
Customer Coupa
Discount Amount
*Bill To Address No address selected
Payment Order
Reference Buyer Tax ID v
Ship To Address MNo address selected
Lines [ Line Level Taxation

& AddLine Subtotal 0.00
Shipping

Tax Description (Shipping) ~ 0.000
Handling

Tax Description (Handling) ~ 0.000
Misc

Tax Description (Misc) ~ 0.000

Tax Description hd 0| 0.00 0
Total Tax 0.00
Total 0.00
€ Delete Cancel Save as draft Calculate Submit

o Comments

Add Comment

Fill in at least the mandatory fields (marked with a red asterisk). You can create or choose an invoice from, a remit-to,
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and/or a ship from address by clicking on the corresponding Search (magnifying glass) icon in the From section. You
are guided through creating your legal entity. For more information, see Set up Legal Entities.

You can also attach files to an invoice using Image Scan. One attachment can be up to 100 MB, but for performance
reasons, consider limiting the attachment size to 16 MB or so. Image attachments on invoices must be of the following
types: PNG, GIF, JPG, JPEG, PJPEG, TIFF, or PDF.

In the Subtotal section, you can enter values and select tax rates for shipping, handling, and miscellaneous costs.

Applicable tax rates are determined by the tax code on the invoice. The tax rate is a government-regulated rate to be
paid to the tax authorities as part of the sale and it is shown as a percentage. It applies to all commodities sold in a
specified geographical area.

Subtotal 363.00
Shipping 10
Tax Description (Shipping) = US: CA - 8.2F » 8.25 0.83
Handling 8
Tax Description (Handling) | US: CA - 8.2° 8.25 0.66
Misc 1
Tax Description (Misc) | US: CA - 8.2° ~ 8.25 0.08
Total Tax 157
Total 383.57

Clicking Calculate will give you the gross total amount considering the tax values.

You can add invoice lines to your invoice by clicking on the Add Line link or the Add (‘3‘) icon next to it.

Selecting the Line Level Taxation checkbox, allows you to enter tax information for each invoice line.
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LineS [ Line Level Taxation
Type Description Price 22 5 OO Q
(T Print Services 225.00 !

PO Line Contract Supplier Part Number UNSPSC
2819-1 O Clear ~ Select an Option v

Pick Order Line(s)

Billing

SF-Marketing-Indirect

Taxes

Tax Description Tax Rate Tax Amount Tax Reference

& Add Tag

@ AddLine @) Pick lines from PO Totals & Taxes

Lines Net Total 225.00
Lines Tax Totals 0

If you create an invoice from a PO and your customer allows you to pick lines from POs (enabling you to reference
multiple POs on one invoice) and update/correct PO references on invoice lines, you can Clear PO lines and select PO

lines from invoices by clicking on the Pick Order Line(s) magnifying glass ( E}) icon. In the appearing Pick Order
Line(s) popup, Choose the PO line that you want to be mapped to your invoice line.

Pick Order Line(s) X

Invoice Line
Line Type Description uom Quantity Price Total
1 Amount Print Services 225.00 225.00
PO Lines
All ~ Advanced Search f—‘l
Match Conditions | Match all conditions ~ Add group of conditions

Filter By| PO Number ~ |Filter Clause || 2819 x| (+]

PO Number Line = Item Uom Qty Price Invoiced Actions
2819 1 Print Senvices 1 125.00 0.00 ©ch
2819 2 Print Senvices 2 100.00 0.00 ©ch

You can also add PO lines from other open orders by clicking on the Pick Lines from PO link or the Add (9) icon next

to it. In the appearing Pick Lines to Add popup, click on the Add (9) icon in the Actions column for the order line
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that you want to add.

Pick Lines to Add

Invoice #
Line Desc Total
1 Print Services 225.00 )

1lines €3 Delete Invoice m

Advanced

Invoiced Actions

200.00 0.00 0

PO Number Description

2814 1 Print Services

Invoices associated with digital checks and bank transfers are populated with the following payment information:
invoice paid or not, payment date and number, amount paid, and payment notes. For more information, see View and

Download Digital Checks.

Submit the invoice or save it as a draft to submit it later. You can also add comments for your customer.

When you try to submit an invoice that does not meet your customer's requirements, depending on your customer's
settings, you might get the following warning message: "This invoice has the following warning(s):", followed by details

on what to correct.

Before submitting the invoice, you can cancel or delete it. You can delete only draft invoices.

Note: If you want to make changes to the invoice after submitting it, you have to contact your customer
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Create or Edit a Catalog

To create a catalog for a customer, go to the Catalogs page, select the customer from the Select Customer drop-down
list in the top right corner, and click on the Create button.

To edit a draft catalog, do one of the following:

» Click on the Edit (+ ) icon for the catalog in the Catalogs table.
 Click on the Catalog Name link.
On the Catalog Edit page, fill in at least the mandatory field (marked with a red asterisk).

You can change the default catalog title ([Your Company Name] Catalog [Number]) in the mandatory Catalog
Name field.

You can select a start and expiration date for your catalog and a currency to be applied to your catalog items.
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Catalog 3 Fai Back

Customer Coupa

*Catalog Name | Catalog 3

Status Draft
Start Date [ | date when catalog prices become effective
Expiration Date ™4 | date when catalog prices become expired
Currency | USD ~

0 Items Changed ( 0 unchanged )

So: Do: Oo Qo Qo

Price Increase Price Decrease Other Fields Updated New Items Deactivated Items

Save Submit to buyer

Items Included in Catalog

Create Load from file Advanced
Name Part Number Status Change Price Price Change Currency Other Fields Changed Actions
INo ToWs.

Perpage 15 45 | 90

Iltems Offered to Coupa Inspire

Advanced Searc o]

Name Description Part Number Price Currency UOM  Purchasable Last Submitted to Buyer Catalog Actions
IND rows.

Perpage 15 45 90

0 Comments

You can create as many catalogs as you want, but each catalog must be approved by your customer before it can be
included in Coupa search results.

Item changes
The n Item(s) Changed section provides information on changes that your customer made to the catalog:

Item Changes Description

n Items Changed (n Unchanged) | Total number of items that changed and did not change.

Price Increase Total number of items in the catalog that increased in price. New items do not
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Item Changes Description

appear in this count.

Price Decrease Total number of items in the catalog that decreased in price. New items do not
appear in this count.

Other Fields Updated Total number of items that were modified in a way other than a change in price.

New Items Total number of new items included in the catalog since the last upload or
creation of new items.

Deactivated ltems Total number of items that are no longer available in the catalog or search within
Coupa.

If you accept the changes, click Submit to buyer to have your customer approve the catalog for inclusion in their Coupa
environment.

When you submit your catalog, your can see the following message in the green notification bar: "Catalog was submitted
and buyer will be notified."

You can also add comments for your customer. After your catalog is accepted, you cannot edit it. Instead, you have to
change or update it by submitting a new verison.

Items included in catalog
This table lists all the items included in this catalog. They are not available in Coupa until the catalog is approved by
your customer. Once approved, the items are also listed in the ltems Offered to [Customer Name] table below.

If the items included in the catalog match items already offered, any status, price, or other field changes are listed in the

table.
Status Change Description
New The item is new, and has not been offered to this customer before. If the item is
listed in Items Offered to [Customer Name], make sure the part number is
correct since this is the unique identifier.
Updated The item has been updated and something has changed.
Deactivated The item is no longer available for purchase.

You can also update catalog items. For more information, see Create or Edit Catalog ltems.

Items offered to [Customer Name]
This table lists all the items that have been accepted and published in the customer's Coupa environment.

Note: Unlike Items Included in Catalog, which can be deleted before submitting the catalog for approval,
Items Offered to [Customer Name] cannot be deleted. Once an item is accepted and published, it cannot

Valid until January 31, 2021 105


https://success.coupa.com/Suppliers/For_Suppliers/Coupa_Supplier_Portal/Work_with_the_CSP/Create_or_Edit_Catalog_Items

CSP Admin and User Guide Work with the CSP

be deleted, only deactivated.

You can export the tables of included and offered items in CSV or Excel format.

You can filter the tables by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.
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Create or Edit a Service/Time Sheet

Note: The Service/Time Sheets feature is available only if your customer enables it for you. You also have to
enable it for the CSP user(s) on the Admin page.

When you receive a purchase order, you can flip it into a service/time sheet by clicking on the ®# icon in the Actions
column of the Purchase Orders table or on the Create Service/Time Sheets button on the PO. For more information,
see View and Manage POs.

To edit a service/time sheet, perform the following steps:
1. On the Service/Time Sheets page, do one of the following:

o Click on its number in the Service/Time Sheets column and click on the Edit button.

o Click on the Edit (+* ) icon for it in the Actions column.

Tip: You can also edit a service/time sheet by clicking on its number on the Service/Time Sheet Lines
page.
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Service/Time Sheets #504

PO DB0O110000461

© Time Sheet < January 06, 2019 - January 12, 2019 »
Sun Mon Tue Wed Thu Fri Sat * Total
6 7 8 9 10 1 12
PO Line # Item
1 Senior Developer 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0 (%]

Submitted: 0.0 Hour

Attachments
Add File | URL | Text

Total hours: 0.0

4 Services
Line # Submission PO Line # Item * Quantity Unit Of Measure
2 Type 2 Project Plan 0.000 Each (%]
New
Due Date Actual Completion Attachments
MNone I Add File | URL | Text

Notes To Supplier

None
Line # Submission PO Line # Item * Amount
3 Type 3 Testing Assistance 0.000 usD %]
New
Due Date Actual Completion Attachments
MNone I Add File | URL | Text

Notes To Supplier

None
Cancel Save as Draft
0 Comments v

Add Comment

2. Confirm or enter time, quantity, and/or amount against the PO line items.
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Note: You can enter only one week at a time. The week applies to all the lines.

3. Save or submit the service/time sheet, or add comments for your customer.

Note: You can submit multiple service/time sheets for any amounts or quantities against one PO and against
one PO line.

The service/time sheet is routed for approval to your customer.

Approval or rejection can happen on the entire PO or on individual PO lines. Your customer can accept and pay you for
partial work and you can see which service/time sheet lines are approved, pending approval, need rework, or are
discarded.

If the service/time sheet or one or more of its lines are approved, a receipt and an inventory transaction are created in
Coupa for the values of each PO line and you get a notification.

If the service/time sheet or one or more of its lines are rejected, you receive a notification of the required rework and you
have to submit the service/time sheet again. The type of notification depends on your notification preference settings.

To delete, withdraw, or edit a service/time sheet, click on the relevant (Delete, Edit, or Withdraw) icon in
the Actions column.

Note: You can edit or delete only draft service/time sheets. You can withdraw service/time sheets only in
pending approval status.
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Create or Edit Catalog Items

On the Catalog Edit page, you can create or modify items one-by-one or with the bulk loader.

Create or update an item

In the Items Included in Catalog table, click on the Create button to add a new item or on the Edit icon (s’) to edit a
saved item.

Iltems Included in Catalog

Create Load from file Exportto - All ~ Advanced
Name Part Number Status Change Price Price Change Currency Other Fields Changed Actions
Ilte""1 1 New 100.00 UsD V4 9

On the Catalog Item Create page, fill in at least the mandatory fields (marked with a red asterisk).

Setting on Ul Column in the CSV Description
Template
*Name Name* The item name that Coupa displays in search results.
*Description Description* The item description that Coupa displays in search

results. Coupa also searches this description for any of
the keywords searched for.

*Unit of Measure UoM Code* The UoM you use must match the UoM your customer
has already set up in their Coupa environment; otherwise,
you will not be able to save or load items. Talk to your
customer to make sure that all the units of measure you
use are set up in Coupa.

ISO standard is preferred.

Purchasable Active*® Catalog items cannot be deleted, so if an item is no
longer available, deselect this checkbox to prevent the
item from being visible in catalogs and search results.
If the value for "Active" is "Yes", the item can be
purchased. If "No", the item cannot be purchased.

Supplier Item Attributes

*Part Number Supplier Part Num* The unique identifier for the item in the catalog database.
Usually the supplier part number. It may be different from
the Manufacturer part number.

Auxiliary Part Number Supplier Aux Part Num Another part number that helps identify the item, for
example, a quote number. It will be included in any
purchase order.

Manufacturer The name of the item's manufacturer.

Lead Time Lead Time The time between when you receive the purchase order
and when you ship the item.
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Description

Template

Enter a single value not a range.

UNSPSC Code

UNSPSC Code

This is the United Nations Standard Products and
Services Code® (UNSPSC®). For more information,

See WWWw.unspsc.org.

Standard classification code that best describes the item.
If UNSPSC is not available at the item level, assign a
Segment or Family classification code that most applies
to the item. If acceptable to your customer, a single
Segment may be used for all items in your catalog.

Contract

You can specify the customer contract (if any) associated
with the item.

Pricing Type

Limited to Fixed Price.

*Price

Price*

The price of the item you are selling to your customer. Do
not include a currency sign, for example, $, or any
punctuation other than a decimal separator.

*Currency

Currency”

The currency is determined at the catalog level. The
currency selected for the catalog is the default currency
selected when you create a new catalog item.

Use ISO Currency Codes, for example, USD.

Savings %

If you offer a discount off retail price, you can indicate the
savings percentage here. This is for reference only, and it
does not affect the selling price or invoicing.

Browse

Image URL

You can also upload an image for your item by clicking
Browse. Coupa displays this image in your search
results. You can use any image that fits on a regular
screen. The image is scaled to 64x64 for search result
thumbnails, and 300x300 for the detailed view. Coupa
shows full resolution when the user zooms in on the
image.

In CSV, enter the fully qualified URL to the image file (not
the containing page).

Pack Quantity

The number of items included in the specified UoM. For
example, if the item UoM is BX and describes a box that
contains 100 items, then the Pack Quantity is 100.

Upload or update multiple items
You can use the bulk loader to add or update multiple items in a catalog.

In the Items Included in Catalog table, click on the Load from file button and follow the steps on

the Bulk Load Item Updates for [Catalog Name] page.
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Bulk Load Item Updates for Catalog1

Follow these steps to upload items

1. Download the CSV template or the current list of items.
2_Fill in or update the CSV file. Click here for a description of the required and optional fields in the template.
* Fields marked with a ™" are mandatory.

3. Load the updated file

Mo file selected.

Note: If you are loading csv files with non-English characters, please consult the following help note.

Start Upload

» To get a blank CSV file to build your new catalog, click on the CSV template link. For information on the fields to be
filled in, see the table above.

+ To add or modify items from your existing catalog, click on the current list of items link.

After making the changes, click on the Browse... button and navigate to your modified CSV file, click Open, and
then Start Upload.

Note: Do not change the column header names in the .csv file.

Once the upload is complete, Coupa checks your file and shows you the Verify Data screen where you can check your
changes and Finish Upload. All changes are highlighted in orange.

Click Cancel if you need to correct data in the .csv file, and then upload it again.
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Verify Data

The first rows of your upload have been loaded. All changes or additions are highlighted in
After reviewing the results, click Finish Upload to continue the upload or Cancel to stop the upload and discard any changes.
Row 1 Row 2
New New
Supplier Part Num*
Supplier Aux Part Num
Name*

Description*

Price*
Currency*
UOM code*
active*
tem Classification Name
UNSPSC Code

Lead Time
Manufacturer
Contract Number
Contract Term

Finish Upload Cancel

After clicking Finish Upload, wait for the system to complete loading the items. You can see the status of the upload
change from Submitted for Processing through Submitted to Resque to Loading and Upload completed
successfully. Click Done.

The n Item(s) Changed section is updated with your changes.
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Edita PO

Request PO changes

Note: You can request PO changes if your customer allows you to submit PO change requests and you
have the Order Changes permission. For more information, see Manage Users.

You can request changes to POs created in Coupa and submit them for approval to your customer. You cannot request
changes to closed or soft-closed POs or PO lines.

Click on the Orders tab on the main menu, and on the appearing Purchase Orders page, click on the number of the
PO that you want to modify.

At the bottom of the purchase order, click on the Request Change button. If you have saved but not submitted your
change request, click on the Edit Change button.

Lines
LTl g d " Line Number: 0 — 9 ~
1 Type Item Price Total Invoiced
() Print Services 200.00 200.00 0.00

Need By Part Number
08/03/19 None Additional Information

Job Type Poster - Binding - Color Prints? | Yes - Need By Date 08/07/19 - Additional Instructions

Perpage 15 45 90

Total 200.00 usD

Create Invoice Request Change Save =i Print View

You can edit the fields that your customer allows you to change, for example, Ship to User, Department,
and Estimated Arrival Date on the order, and Need by Date, item Qty/Amt, and Price on an order line. You can also
delete PO lines that cannot be fulfilled.

Note: You cannot reduce the quantity/amount below the values already received or invoiced against.

You need to select a Reason for Change from the drop-down list:

» Cannot fulfill order quantity/amount

» The ordered item is no longer available
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» Cannot fulfill orders by the Need-by date
» Other - In this case, you also need to provide a comment.
Cancel, Save, or Submit the change request.

At the bottom of the page, you can also add comments for your customer.

Note: Only one change request can be pending approval at a time. You cannot submit a PO change request
while your customer has a change pending approval.

Changes are effective when a change request is approved. When a PO change request is rejected, you receive
the Order change request is rejected notification. For more information, see View and Manage Notifications.

After submitting your change request and while waiting for your customer's approval, you can view the pending
changes if you Click to view pending change at the top of the PO. You can also select a PO revision to view by
clicking the drop-down list next to the PO number.

Purchase Order #2819 | Revision 2 (Curront aug 30 .

There is a pending change request on this purchase order. Click to view pending change

Status Issued - Sent via Email Shl ppll’]g

When viewing pending changes, the Pending Change Request page shows the PO number, the revision date, the date
when the change request was submitted, the reason for the change, change status, change type, and more.
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Purchase Orders #2613
Pending Change Request

Initiated By Supplier
Submitted On 09/11/19
Change Reason Cannot fulfill orders by the Need-by date

Justification

' General Info ' Shipping

Change Status Pending Approval Address
Status Issued - Sent via Email
Order Date 07/31/19
Revision Date 08/30/18

Terms
Requisition # U4z

You can withdraw your change request by clicking Withdraw at the bottom of the page.

On the Order Changes and Order Line Changes tabs, you can see tables listing all your PO and PO line changes.
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Column Description

Purchase Order Changes

PO Change # PO change number generated by Coupa. Click on it to view the PO change.

Order # PO number generated by Coupa. Click on it to view the PO.

Version # PO revision number generated by Coupa.

Ship to User Name of the user to whom the item/service needs to be shipped/delivered.

Status Status of the PO change: draft, pending approval, or approved. If a PO change
request is rejected and you view the PO change, it moves into draft for you to edit
and resubmit it. A PO change request status changes to draft also when you
withdraw it.

Items Item(s) or service(s) on the PO.

Total Total price of the item(s)/service(s) on the PO.

Supplier Initiated

Indicates whether the PO change was initiated by you/supplier (change requests
in draft or pending approval status). Approved change requests are not initiated
by suppliers.

Created By

Name of the user that created the change request.

Reason Code

Shows the Reason for Change as selected from the drop-down list: Cannot fulfill
order quantity/amount, The ordered item is no longer available, Cannot fulfill
orders by the Need-by date, or Other.

If you select other, you need to provide a comment.

Justification

Shows the comment provided along with the reason for change.

Purchase Order Line Changes

PO Change # PO change number generated by Coupa. Click on it to view the PO change.
Order # PO number generated by Coupa. Click on it to view the PO.

Line # PO line number.

Line Type Line type: quantity or amount.

Supplier Supplier name.

Account Billing account code.

Chart of Accounts Name of the chart of account.

Commodity Commodity name.

Item [tem name.

ltem # Item number.

Marked for Deletion

Indicates if the PO line is marked for deletion.
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You can filter both tables by columns, use the search bar to filter with a search term, or click on the View drop-down list
to perform advanced filtering. The Purchase Order Changes table has the Change orders initiated by suppliers and
Pending approval order changes built-in filters, and the Purchase Order Line Changes table has the Pending
approval order line changes built-in filter. For more information, see Create Custom Views.

Add shipment tracking information

Note: You can add shipment tracking information to POs if your customer enables real-time shipment
tracking.

In the Shipment Tracking section in the PO, click on the Add (O) icon. In the appearing Create Shipment Tracker
popup window, enter the tracking number for the entire PO, select a carrier (FedEx, USPS, UPS) from the drop-down
window, and add a note (optional).

Note: You can enter only one tracking number on a PO. For partial shipments, you can create an advance
ship notice (ASN).

Create Shipment Tracker

Enter tracking number for entire PO. To ship PO partially, create ASN

* Number

* Carrier
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View and Download Digital Checks

You can accept payment from your customers through digital checks that you can download and print from the CSP.

Tip: If you provide your bank account information, your customers can also pay your invoices through bank
transfer.

Prerequisites
* You are a US-based supplier.
* Your US-based customers use Coupa Pay.

* You are linked to the CSP. If not linked, you receive an email invitation to register for the CSP.

Notifications

When your customer releases a payment batch for you, the payment moves from Approved to Payment in progress
status and a digital check email notification is sent to the email address of the payee (supplier payment account
email) or, if not available, of the primary contact.

If you are not linked to the CSP, your email contains the Sign up to Print Digital Check button.

;“;}coupa New digital check for Payment #651

Hi Supplier Name,

Coupa Pay Customer 1 has sent you a digital check for 2,460.00 USD. This check will expire 90 days from the date printed on it.

To view the digital check, you need to create an account on Coupa, which is completely free fo join and transact and has other
benefits like login security, SMS notifications, transaction visibility and more.

Payment Number 651
Customer Coupa Pay Customer 1
Amount 2,460.00 USD
Check Date 03/04/2019

Sign ‘;p to Print Digital Check

Note: To access the digital check, you need to register for the CSP.

If you are linked to the CSP, your email contains the Log in to Print Digital Check button.
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{,‘}coupa New digital check for Payment #651

Hi Supplier Name,

Coupa Pay Customer 1 has sent you a digital check for 2,460.00 USD. This check will expire 90 days from the date printed on it.

To view the digital check, you need to log in to Coupa below.

Payment Number 651
Customer Coupa Pay Customer 1
Amount 2,460.00 USD
Check Date 03/04/2019

Log in to Print Digital Check

Online and email notifications are on by default, so if you have not turned off your online notification for Coupa Pay /
New digital check, you also get a New digital check online (system) notification in the CSP with the following
message: "[Your customer's name] sent you a digital check for [amount] for payment [number]."

For more information, see View and Manage Notifications.

View and download your digital check

If you are logged in to the CSP and click on the Log in to Print Digital Check button, you can see the Download
Digital Check popup window.

Download Digital Check X

Thiss will be 2 of 4 allowable times W view and download this check. Arg you sure you want to confinue? This
downioad contains unencrypled bank account information, please handle appropnately

]

i

If you are not logged in and click on the Log in to Print Digital Check button, you are directed to the Payments page.
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Select Customer Coupa Pay Customer 1 ~

Payments

Instructions From Customer

Payments made by Coupa Pay Customers will be displayed below

Exportto ~ View WAl ~

Payment # ~ Invoice # Payee Status Payment Method Download Count Total Actions <
651 388 Supplier Name Downloaded Digital Check 10of 4 2,460.00 USD 4
639 380 Supplier Name Ready to Download Digital Check 0of 4 4,620.00 USD 3

Perpage 15 45 90

If you log in to the CSP for the first time after registering or you log in directly (not from the email notification), you are
taken to the Home page first, so you need to click on the Payments main menu item to see all the payments: bank
transfers and digital checks.

Note: The Payments menu item and the Payments page are visible only to supplier users with the
Payments permission that have at least one Coupa Pay customer. For more information, see Manage Users.

From the Select Customer dropdown, select the customer whose payments you want to see.

Note: On the Payments page, the Select Customer dropdown lists only your Coupa Pay customers.

To download your digital check, you have the following options:

 Click on the OK button in the Download Digital Check popup window.

+ Click on the Download Digital Check ( * ) icon in the Actions column of the Payments table.

* Go to the specific payment and download the check directly from the payment.

Payment #6571

Payment Info

Payment # 651
Status Downloaded
Payee Supplier Name
Payment Method Digital Check
Digital Check 10f4 "%
Expiration Date 06/02/19 Download Digital Check
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Note: You can view and download a digital check only four times to prevent, for example, multiple deposits.

You can see how many times you have downloaded a check also in the Download Count column of the
Payments table and in the Digital Check field of the Payment Info section.

In the appearing window, you can open or save the digital check .pdf file, and then print, sign, and deposit it.

Invoices associated with digital checks and bank transfers are populated with the following payment information:
invoice paid or not, payment date and number, amount paid, and payment notes.
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View and Manage ASNs

Note: This feature is available only if your customer enables it in Coupa.

Click on the ASN tab on the main menu. The Advance Ship Notices page appears.

1 - SUPPLIERNAME ~ | NOTIFICATIONS HELP ~
zcoupa supplier portal 12/
Home Profile Orders Service/Time Sheets | ASN Invoices Catalogs Add-ons Admin
Select Customer Coupa ~

Advance Ship Notices

ASN Number Status Delivery Date « Last Updated By Last Updated Date Actions
I m Draft MNone John Doe 06/08/17 Ve @

222 Pending Receipt 06/02/17 Jane Doe 05/3117 ‘j 4

From the Select Customer drop-down list in the top right corner, select the customer whose ASNs you want to see.

Note: When you visit the page again, it shows you the ASNs for the customer you selected last time.

The Advance Ship Notices table shows the following information for all the ASNs you sent to the selected customer.

Column Description

ASN Number ASN number generated by Coupa. Click on it to view the ASN.

Status Current status of the ASN. For more information, see the ASN status list below.
Delivery Date Date when the ASN was sent.

Last Updated By Name of the person who updated the ASN for the last time.

Last Updated Date Date when the ASN was updated for the last time.

Actions Click on the icons for the following actions:

« /" _Edit the ASN.
. @ - Delete the ASN.

« 4" - Cancel the ASN.

You can edit ASNs in draft or pending receipt status. You can delete ASNs in
draft status. You can cancel ASNs that are pending receipt.
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ASNSs can have the following statuses:

Status Description

Draft The ASN has been created, but it has not been submitted to your customer.
Cancelled The ASN has been cancelled.

Partially Received The customer has received a part of your shipment.

Pending Receipt The customer is waiting for the shipment.

Received The customer has received your shipment.

You can export the ASNs table in CSV or Excel format.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.
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View and Manage Catalogs

Click on the Catalogs tab on the main menu. The Catalogs page appears.

1 - SUPPLIERMAME ~ | NOTIFICATIONS HELP ~
gyscoupa supplier portal 2]
Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Add-ons Admin
Select Customer Coupa ~

Configure Punchout

Catalogs
~ Advanced
Catalog Name Created Date ~ Submitted Date Start Date Expiration Date Status Unanswered Comments Actions
ICatang‘l 0515117 05/16/17 06/01/17 1203117 Accepted  No
Catalog2 07/06/17 Naone 01/01/18 06/30/18 Draft No V4 @

Perpage 15 45 S0

From the Select Customer drop-down list in the top right corner, select the customer whose catalogs you want to see.

Note: When you visit the page again, it shows you the catalogs for the customer you selected last time.

The Catalogs table shows the following information for all the catalogs you created for the selected customer.

Column Description

Catalog Name Name of the catalog. Click on it to view the catalog.

Created Date Date when the catalog was created.

Submitted Date Date when the catalog was submitted.

Start Date Date when the catalog becomes effective.

Expiration Date Date when the catalog expires.

Status Current status of the catalog. For more information, see the catalog status list
below.

Unanswered Comments Your comments on the catalog for your customer. Also, your customer's

comments that you need to respond to.
You can see all your customer's comments or add your comments for the
customer when you open the catalog.

Actions Click on the icons for the following actions:

./ - Edit the catalog.
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Column Description

. @ - Delete the catalog.

You can edit only draft catalogs. You can delete catalogs in draft or awaiting/
pending approval status.

Status Description

Accepted The catalog has been accepted by your customer, and all the items in it are now
available for purchase within Coupa.

Awaiting/Pending Approval The catalog has been received by your customer, but it has not gone through the
approval chain yet.

Draft The catalog has been created, but may be missing information necessary to send
it to the customer.

Error Something is wrong with the catalog. Contact your customer to get the
catalog back on track.

Rejected The catalog has been rejected. Contact your customer to find out why, and then
resubmit.

You can export the catalogs table in CSV or Excel format.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.
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View and Manage Invoices

Note: If you use Coupa’s invoice compliance, see Compliance as a Service for more information.

Click on the Invoices tab on the main menu. The Invoices page appears.

i SUPPLIERNAME ~ | NOTIFICATIONS HELP ~
coupa supplier portal 12/
Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Add-ons Admin
Select Customer Coupa ~
Invoices
Create Invoices @
Create Invoice from PO Create Blank Invoice Create Credit Note
view [ v [ searcr 0
Invoice # Created Date = Status PO # Total Unanswered Comments Dispute Reason Actions
123 06/01/17 Draft 3050 113.20 No ‘/0
456 06/01/17 Disputed None 150.00 No
789 058/2717 Pending Approval 2949 3,750.00 MNo
121314 05/16/17 Approved 2891 15,000.00 Mo

Perpage 15 45 90

From the Select Customer drop-down list in the top right corner, select the customer whose invoices you want to see.

Note: When you visit the page again, it shows you the invoices for the customer you selected last time.

The Invoices table shows the following information for all the invoices you sent to the selected customer.

Column Description

Invoice # Invoice number generated by Coupa. Click on it to view the invoice.

Created Date Date when the invoice was created.

Status Current status of the invoice. For more information, see the invoice status list
below.

PO # PO number generated by Coupa for the order on which the invoice is based. Click

on it to view the PO.

Total Total amount of the invoice.

If your customers use country compliant invoicing and enabled the relevant field
setting, on legal invoices (PDFs) you can also see the Totals with Early
Payment Discount section with discounted totals.
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Column Description

Unanswered Comments Your comments on the invoice for your customer. Also, your customer's
comments that you need to respond to.

You can see all your customer's comments or add your comments for the
customer when you open the invoice.

Dispute Reason Your customer's reason for disputing the invoice.

Actions
Click on the Edit (s/) or Delete (9) icon to edit or delete an invoice. You can
edit or delete only draft invoices.

Invoices can have the following statuses:

Status Description

Abandoned The disputed invoice has been abandoned. Your customer can choose to notify
you of this invoice status change and provide instructions. You can set notification
preferences for abandoned invoices.

Approved The invoice has been accepted for payment by your customer.

Disputed The invoice has been disputed. For more information, see Disputed invoices.
Draft The invoice has been created, but it has not been submitted to your customer yet.
Invalid Specific for compliant e-invoices for clearance countries, for example, Mexico. It

indicates that a CFDI (Mexican legal invoice form) that you sent failed validation.
Invoices with this status are visible only to you, not to your customer.

Pending Approval The invoice is currently under review by your customer.
Processing The invoice is being processed by the AP department and should be paid soon.
Voided Something is wrong with the invoice. Contact your customer to get the invoice

back on track.

Above the table you can have instructions from the customer specifying, for example, policies or best practices.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.

You can export the invoices table in CSV or Excel format.

If your customers use country compliant invoicing, you can also bulk export all the legal invoice attachments (usually
PDFs) in a compressed (.zip) file by selecting the Legal Invoice (zip) option from the Export to dropdown.
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Invoices

C3V (current columns) I

I Excel (current columns)

A green message bar informs you that "The data you requested will be emailed to you shortly."

Note: The export usually takes about one minute. In case of a large number of invoices it may take longer.

There is no limitation on the number of invoices or file size when exporting legal invoices. For more information,
see What does the Export to button do? in CSP FAQ / Invoices.

Tip: You can set your Invoices table view to show and export your legal invoices by status, created date,
invoice date, period of time, and so on.

Online and email notifications are on by default, so if you have not turned off your online notification for Legal Invoice
Export Ready, you also get a notification in the CSP. For more information, see View and Manage Nofifications.

Warning: If you turn off notifications for this feature, the .zip file is not generated, so you cannot bulk export
your legal invoices. You can see a warning in the message bar to enable your notifications.

When you click on the Download Legal Invoices button in the email or on the notification in the CSP, the compressed

file is downloaded to your device.

Note: If you are not logged into the CSP, you are directed to the Login page and you need to go to your
notifications to download the file; or after logging in, you can click on the Download Legal Invoices button

from your email notification again.

Warning: The .zip file expires 30 days after you export it. After expiration you cannot download it from your

email or online notification.

Disputed invoices
Invoices with disputed status are invoices with information that your customer does not agree to, needs clarification on,

or finds incorrect.
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When the status of an invoice changes to "Disputed"”, you receive an email notification with the invoice number, the date
of the dispute, the reason for the dispute, and optionally any additional comments. Your customer can leave comments
on the invoice while it is in "Disputed" status.

Warning: Your customer does not process disputed invoices for payment until you resolve the dispute.

In the Invoices table, click on the invoice number or on the Resolve button in the Actions column for the disputed
invoice that you want to resolve.

To resolve a dispute, click on the relevant button at the bottom of the invoice. Depending on the type of invoice, you
have the following options:

Standard e-invoice
» Void
If an invoice was issued in duplicate or has already been paid for through an earlier invoice, void it.
+ Correct Invoice

If an invoice has some incorrect information, correct it. When submitting a corrected invoice, you can use the same
invoice number.

Country compliant e-invoice

Tip: Country compliant e-invoices are marked with a green checkmark next to the country code in their top
right corner.

« Cancel Invoice

If an invoice was issued in duplicate, create a credit note to cancel it.

If an invoice has some incorrect information (other than price or quantity), for example, incorrect tax rate or item
description, create a credit note to cancel it and issue a new corrected invoice. The original invoice remains in
disputed status and the corrected invoice is submitted for approval.

Warning: The corrected invoice must have a new number.

» Adjust

If the price and/or the quantity for invoice lines(s) is incorrect on an invoice, issue an adjustment credit note (partial
credit) to correct it. You can adjust credit line quantity also in case of returned goods or if an invoice has already
been paid for.
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If your customer disputes an invoice in error, or you choose not to resolve the dispute, your customer can withdraw the
invoice from dispute and process it.
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View and Manage Payments

You can view and manage your invoice payments, payment accounts, and early pay discount preferences, and you can
process your card payments and digital checks from the Payments page.

Note: If you want to see the new Payments page, send your request to csp-bpm@coupa.com.

Go to the Payments page and on the left of the page, click on the customer's name for which you want to see payment
details.

Tip: If you have more than ten customers, you have the option to search for a customer name by entering it
in the search bar under the My Customers header.

You might need to provide some information to see payment details.

Home Profile Orders Service/Time Sheets ASN Invoices Catalogs Payments Busi

F

Sewp

My Customers 9 Best Buyer

Best Buyer

Set up to get paid from Best Buyer

Learning Center

Update your business information
Coupa Pay Overview * UpP y

Add customers e Provide information about the bank account to receive direct deposits
Early Pay Discounts

Get started
Feedback

Tell us what you think

If you have not provided a legal entity, you are asked to update your business information and clicking Get Started
takes you to the Admin / Legal Entity Setup page to set up a legal entity.

If you have not added or shared your bank account with the customer, you need to provide your bank information to
receive direct deposits, or you need to provide an email address if you want to receive credit card information for virtual
card payment. Clicking Get Started takes you to the Admin / Remit-To page to add a remit-to account.

Tip: You are prompted to provide payment information also when you join the {{CSN_short} through an
email invitation from a Coupa Pay customer. For more information, see Create or Update Your Profiles.
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If you have set up a payment account, you can see an overview of your payment transactions, a list of tasks, and
payment setup progress and options.

Note: The data provided is directional and for informational purposes only, and may be delayed up to 1-2
weeks.

Home Profile Orders Service/Time Sheets ASN Invoices Catalogs Payments Business Performance Sourcing Add-ons
-~
Setup
My Customers
i Awesome Customer
Awesome Customer
Best Buyer OVErVieW
Learning Center Payments Received To Date Payments Due Early Pay Requests
Coupa Pay Overview USD 170 653 UsD 71 0
Add customers !
16 payments 1 invoices 0 requests
Early Pay Discounts
Feedback To Do List vewsl  Payment Setup —
Tell us what you think
A new digital check for 833.33 USD for payment #43 from Awesome o Bank account Manage
Customer is ready to download
10/14/20 07-20 AM Email to receive card payments Setup
Awesome Customer has approved your early payment request #3976 and o Static Early Pay Discounts Manage

you should expect to be paid in -15 days

10/14/20 07:00 AM

Data provided is directional and for informational purposes only, and may be delayed up to 1-2 weeks

From this page, you can manage your invoice payments, payment accounts, and early pay discount preferences, and
you can process your card payments and digital checks.

Overview
The Overview section shows the total amount and number of payments received to date, payments due, and early pay
requests (visible only if your customer enabled dynamic discounting).

Note: Payments Due includes invoices that have not been marked as paid in Coupa. Payments made
outside of Coupa are not included.

Clicking on the link that indicates the number of payments takes you to the Invoice Payments page that lists all the
payments made by your Coupa Pay customer.

The link showing the number of invoices directs you to the Invoices page. For more information, see View and Manage

Invoices.
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The link for the number of requests takes you to the page where you can select invoices for early payment and then set
you payment discount preferences.

To do list

The To Do list contains payment-related notifications that need your attention or action, for example, early pay requests
to be accepted, digital checks to be downloaded, or customer announcement notifications to be viewed. Clicking the
View all link takes you to the My Notifications page.

If your list is empty, you are reminded to check your notification preference settings. For more information, see View and
Manage Notifications.

Payment setup
In the Payment Setup section, you can set up or manage your bank account, the email to receive card payments, and
your static or dynamic early pay discounts.

If you need to provide or manage your bank information for bank payments or email address for card payments, click the
Set up or Manage link to go to the Admin / Remit-To page. For more information, see View and Manage Remit-to
Information.

The Set up or Manage link for static or dynamic early pay discounts directs you to the Static Discounting or
Dynamic Discounting page, where you can set your relevant payment preferences.

A green bar indicates your setup progress.

Help and feedback

On the left of the Payments page, below the list of customers, you can find the Learning Center with links to the
supplier.coupa.com pages about Coupa Pay, early pay discounts, and connecting with customers on the CSP.

Click the Tell us what you think link to provide feedback.
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Tell us what you think X
N

We're thrilled that you tried out this feature and want to provide
suggestions to help improve it

From:

jane doe@fruitsupplier.com

Your message:
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View and Manage POs
Click on the Orders tab on the main menu. The Orders page with the Purchase Orders table appears.

grzcoupa supplier portal SUPPLIERNAME ~ | NOTIFICATIONS @ | HELP -

Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments  Add-ons Admin

Orders Order Lines Order Changes Order Line Changes

Select Customer Coupa ~

Configure PO Delivery

Purchase Orders

Click the == Action to Invoice from a Purchase Order

PO Number Order Date ~ Status Acknowledged At  Items Unanswered Comments Total Actions
I 3050 05/3117 Issued Mone 200 Each of Purple Spiral Motebook Mo 100.00USD =2 §=E &
3049 05/31/17 Issued None 1 Box of Blue Pens No 90.00USD =g g &
2818 07/3113 Issued 08/19/19 Print Services No 200.00 USD "":55 =

From the Select Customer drop-down list in the top right corner, select the customer whose POs you want to see.

Note: When you visit the page again, it shows you the POs from the customer you selected last time.

The Purchase Orders table shows the following information for all the POs you received from the selected customer.

Column Description
PO Number PO number generated by Coupa. Click on it to view the PO.
Order Date Date when the PO was created.
Status Current status of the PO. For more information, see the PO status list below.
Acknowledged At Date when you acknowledged the receipt of the PO, or "None" if not

acknowledged.

You can choose to let your customer know that you received their PO by selecting
the Acknowledged At checkbox on the PO. When you select the checkbox, the
current date appears in the Acknowledged At column.

This checkbox is a simple toggle, so you can also un-acknowledge an invoice by
deselecting the checkbox. If you re-acknowledge at a later time, the new date

appears.
Items List of items on the PO.
Unanswered Comments Your comments on the PO for your customer. Also, your customer's comments

that you need to respond to.
You can see all your customer's comments or add your comments for the
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Column Description

customer when you open the PO.

Note: If you need urgent communication, contact your customer directly.

Total Total amount of the PO.

Assigned To Contains the email address of the users that have been assigned the Restricted
Access to Orders and Restricted Access to Service/Time
Sheets permissions.

Note: This column is visible only if the Restricted Access to
Orders and Restricted Access to Service/Time
Sheets permissions are assigned to at least one user.

Actions Click on the icons for the following actions:

. - Create (flip the PO into) an invoice.
Depending on your customer's settings, the tooltip text can be about creating
an invoice from the PO or accepting the PO and creating an invoice.

. == - Create a credit note.
}‘,r -

Create a service/time sheet.

. [ - Create (flip the PO into) an advance ship notice (ASN).

You can also print POs. Click on the PO Number link to open the PO and at the end of the PO, click on the Print View
button. Depending on your browser, click on the three vertical dots or the three horizontal lines icon in the top right
corner of the appearing window to open the browser menu, and select Print from the list of options.

Tip: You cannot reject a PO, but if you do not accept it, you can add a comment on it for your customer.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.

POs can have the following statuses:

Status Description

Buyer Hold The PO is approved but pending buyer review.
Cancelled The PO is cancelled and does not need to be fulfilled.
Closed The issued PO was received and then closed, either manually or automatically

within Coupa.

Currency Hold The PO is on hold due to a currency exchange rate issue.
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Status Description

Error Something is wrong with the PO. Contact your customer to get the PO back on
track.

Issued The PO was approved and sent to you.

Soft Closed The PO is closed but can be reopened. You cannot invoice against a PO in this
status.

Supplier Window Hold The PO was approved outside of the order window schedule under contract
terms.

Above the table you can have instructions from the customer specifying, for example, policies or best practices.

Valid until January 31, 2021 138



CSP Admin and User Guide Work with the CSP

View and Manage Service/Time Sheets

You can view, create, edit, and submit service/time sheets against purchase orders (POs).

Note: The Service/Time Sheets feature is available only if your customer enables it for you. You also have to
enable it for the CSP user(s) on the Admin page. For more information, see Administer the CSP.

Click on the Service/Time Sheets tab on the main menu. The Service/Time Sheets page appears.

ﬁmupa Supp|.ier Donal SUPPLIERNAME ~ | NOTIFICATIONS @ = HELP -

Home Profile Orders Service/Time Sheets ASN Invoices Catalogs  Add-ons Admin
Senvice/Time Sheets Senice/Time Sheet Lines

Select Customer Coupa ~

Service/Time Sheets

(8]

View v Advanced
Service/Time Sheets ~ Purchase Order Status Submitted At Approved At Actions
I 468 3472 Draft None None 7 9
353 3434 Approved 03/02M17 03/02M17
352 3434 Pending Approval 03/02/17 None 4
317 3306 Pending Approval 02/25M17 None 4
316 3305 Pending Approval 02/25/17 None 4
315 3305 Draft None None /7 e

From the Select Customer drop-down list in the top right corner, select the customer whose service/time sheets you

want to see.

Note: When you visit the page again, it shows you the service/time sheets for the customer you selected last
time.

The Service/Time Sheets table shows the following information for all the service/time sheets and their PO lines that
you selected in the PO details.

Column Description

Service/Time Sheets Service/time sheet number generated by Coupa. Click on it to view the service/
time sheet.
Purchase Order PO number of the order that contains the line associated with the service/time

sheet. Click on it to view the PO.

Status Current status of the service/time sheet: approved, draft, or pending approval.
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Column Description

Submitted At Date and time when you submitted the service/time sheet to your customer.
Approved At Date and time when your customer approved the service/time sheet.

Created By Date and time when you created the service/time sheet.

Assigned To Contains the email address of the users that have been assigned the Restricted

Access to Orders and Restricted Access to Service/Time
Sheets permissions.

Note: This column is visible only if the Restricted Access to
Orders and Restricted Access to Service/Time
Sheets permissions are assigned to at least one user.

Actions Click on the icons to perform the following actions on a service/time sheet:

./ CEdit.
. Q-Delete.

o A" - Withdraw.

You can edit or delete only draft service/time sheets.
You can withdraw service/time sheets only in pending approval status.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.
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View Invoice Lines

Click on the Invoice Lines tab to see information on the invoice lines for each invoice.

Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments Business Performance Sourcing  Add-ons
S

Sewp

Invoices Invoice Lines Payment Receipts

Select Customer Acme Inc ~

Invoice Lines

view [ == °]

Invoice # Line # Description Status Inveoice Date PO Line # Total
I 1234 2 description invoice line 2 Pending Approval 10/15/20 2 300.00
1234 1 description invoice line 1 Pending Approval 10/15/20 1 100.00

From the Select Customer drop-down list in the top right corner, select the customer whose invoice lines you want to
see.

Note: When you visit the page again, it shows you the invoice lines from the customer you selected last
time.

The Invoice Lines table shows the following information for all the invoice lines:

Column Description

Invoice # Invoice number generated by Coupa. Click on it to view the invoice.

Line # Invoice line number.

Description Invoice line description.

Status Current status of the invoice. For more information, see View and Manage
Invoices.

Invoice Date Date when the invoice was created.

PO Line # PO line number.

Total Total amount of the invoice line.

You can export the invoice lines table in CSV or Excel format.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.
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View PO Lines

Click on the Order Lines tab to see information on the PO lines for each PO.

Home  Profile | Orders Service/Time Sheets ~ ASN Invoices  Catalogs Payments  Add-ons Admin

Orders Crder Lines Order Changes Order Line Changes

Select Customer Coupa ~

Configure PO Delivery

Purchase Order Lines

PO Number (Header) Line  Order Status (Header) Item Total Item Quantity Line Total

I 30501 Issued 200 Each of Purple Spiral Notebook 100 100.00
3048 3 Issued 1 Box of Pen 101 1 90.00

3048 2 Issued 1 Box of Pen 102 1 80.00

3048 1 Issued 1 Box of Pen 103 1 100.00

From the Select Customer drop-down list in the top right corner, select the customer whose PO lines you want to see.

Note: When you visit the page again, it shows you the PO lines from the customer you selected last time.

The Purchase Order Lines table shows the following information for all the PO lines:

PO Number (Header) PO number generated by Coupa. Click on it to see the PO line.

Line PO line number.

Order Status (Header) Current status of the PO. For more information, see View and Manage POs.
Item List of items on each PO line.

Total Item Quantity Total quantity of the PO line.

Line Total Total amount of the PO line.

For your custom view, you can select to see the following additional information: ASN lines, carrier, confirmed quantity,
delivery date, invoiced, line level text, need by date, received, ship method, ship note, shipment date, shipped quantity,
and tracking number.

You can export the PO lines table in CSV or Excel format.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.

PO lines for services include fields that show how much work has been confirmed, is pending approval, needs rework,
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or has been discarded.

Lines
Advanced Search o Line Number: 0 — 9 b |
1 Type Item Price Total Invoiced
0.00

[T Service Amount Line 20,000.00 20,000.00

Confirmed Pending Approval Pending Rework Discarded Part Number

0.00 1,000.00 0.00 0.00 None

Each amount is clickable and provides a filtered table view showing all the lines that have amounts.

Service/Time Sheet Lines

All Advanced

Add group of conditions

Match all conditions ~
Order Header ID ~ s ~ || 10000459 0 9
and | Order Line Number ~ s ~ 1 0 0
and | Status v | is Approved i (% N+
Draft

Pending Approval

Service/Time Sheet Line Number Service Type  Description Quantity Unit Of Measure

1 Senvice (Amt) Senvice Amount Line Mone Mone

Service/Time Sheet ~

499

For more information, see View Service/Time Sheet Lines.
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View Public Sourcing Events

Go to Sourcing > Public Sourcing Events to view public sourcing events created by your customer(s) and all the
other customers that use Coupa.

Note: You can see this page only if you have the Sourcing permission. For more information, see Manage
Users.

The All Public Events page shows a table with the following details of the public sourcing events: Event Name,

Company (customer), Commodity (customer), Start Date, End Date, Type, State, and Actions. Click on the Info ('ﬂ')
icons to learn more about the events.

Home Profle  Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments Business Performance ~ Sourcing  Add-ons

Fe

Setup

Public Sourcing Events

All Public Events

Event Name Company Commodity Start Date End Date Type State Actions

Event One Laptops4All Ltd. Computer Software i?\fﬂ]fg 0556 g\ifafg 12.00 RFP Active Request Sent o
Event Two ACME Inc Telecommunications i?\f;fg 100 ii;ﬁfg 1200 RFQ Active Request Participation
Event Three Phones4All Telecommunications i?\fﬂ.lfg 1007 ii?afg 12.00 Auction Complete Not available o

You can search for events by event name, commodity, and type.

Both complete (not available) and active events are shown. Complete events are listed for your information, but they are
not available for participation.

If you want to participate in an event, click on the relevant Request Participation link in the Actions column. The action
name changes to Request Sent and if your request is approved, you receive an email invitation to the event and the
action for the event changes to Request Approved.

Note: Events are displayed in the languages that customers use to create them.

If there are no public events, you can see a relevant message instead of the events table.
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View Service/Time Sheet Lines

Note: The Service/Time Sheets feature is available only if your customer enables it for you. You also have to
enable it for the CSP user(s) on the Admin page. For more information, see Administer the CSP.

Click on the Service/Time Sheet Lines tab to see information on the service/time sheet lines for each service/time
sheet.

Home Profile Orders Service/Time Sheets ASN Invoices Catalogs Add-ons Admin

Senice/Time Sheets Senvice/Time Sheet Lines

Select Customer Coupa ~

Service/Time Sheet Lines

. m— ]

Service/Time Sheet -~ Service/Time Sheet Line Number Service Type  Description Quantity Unit Of Measure
I 352 1 Senvice (Amt) Senvice Amount Line Mone None
352 2 Senvice (Qty) Senvice Quantity Line 2 Each

From the Select Customer drop-down list in the top right corner, select the customer whose service/time sheet
lines you want to see.

Note: When you visit the page again, it shows you the service/time sheet lines from the customer you
selected last time.

The Service/Time Sheet Lines table shows the following information for all the service/time sheet lines:

Column Description

Service/Time Sheet Service/time sheet number generated by Coupa. Click on it to see the service/
time sheet line.

Service/Time Sheet Line Number | Service/time sheet line number.

Service Type Type of the service, for example, service amount, service quantity, or resource.
Description Description of the service.

Quantity Service quantity.

Unit of Measure Unit of measure (UOM) of the service.

For your custom view, you can select to see the following additional information: is rework, notes to supplier, remaining
rework amount/quantity/count, status, action taken by the customer (accept, rework, or discard), and so on.

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to
perform advanced filtering. For more information, see Create Custom Views.
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When you view service/time sheet lines, you can see the customer's notes, for example, about what work was accepted,
what needs additional rework, and if any work was discarded, with Submitted Qty, Action, Notes to Supplier, and
Sign Off clearly shown.

4 Services

Line # Submission Type PO Line # Item Quantity

1 New 2 Translation Document & Each
Due Date Actual Completion Atinchments
None 0319/19 MNone
Submitted Qty Action Notes To Supplier Sign Off
5 Accept they look fine Yes
2 Rework Pages 25- 50 don't look right. Mo
1 Discard Do not translate document 8 further Mo

Total: 12,000.00 USD
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This chapter contains the following topics:

Admin Page
The admin page lets you manage merge requests, set up your remit-to addresses, accept the terms of use, and more.

Manage Users
Manage user permissions and customer access.

Manage Merge Requests
Merge accounts and manage merge requests.

Set up Legal Entities
Set up your account by adding legal entities to be able to create e-invoices.

Add Fiscal Representatives
Add fiscal representatives in countries where you are not registered with a local address but need to be registered for tax
purposes.

View and Manage Remit-to Information
Provide remit-to information to meet compliance regulations when invoicing.

Terms of Use
View and sign the terms of use to work with the CSP.

Set Static Discounting Preferences
Set your early payment discount terms and apply them to invoices and/or purchase orders to get paid faster.

Create SFTP Accounts
Create and manage SFTP accounts to load invoices quickly.

View cXML Submission Errors
Receive notifications of and view cXML submission errors.

Access Add-ons
Access Coupa supplier add-ons, for example, Coupa Advantage, Coupa Accelerate, supplier profile update, and more.

View SFTP File Upload Errors
View SFTP file upload errors.
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Admin Page

Administer the CSP

On the Admin page you can manage users and merge requests, and the remit-to addresses for your customers; you
can set up legal entities and fiscal representatives; you can view and sign the terms of use, set your early payment
discount terms (Coupa Accelerate preferences), create SFTP accounts, and view cXML submission errors.

Home Profile Orders

Setup

Admin Customer Setup

Admin users

Users

Users

Jane Doe
jane.doe@supplier.com

Merge Requests

Legal Entity Setup

Fiscal Representatives

Remit-To

Terms of Use

Payment Preferences w
Static Discounting
SFTP Accounts

cXML Errors

Service/Time Sheets ASN

Edit

Invoices Business Performance Add-ons

Catalogs

Payments Sourcing

Permissions Customer Access

ASNs Customer 1
Admin

Business Performance

Catalogs

Invoices

Order Changes

Orders - Restricted Access to Orders

Pay Me Now

Payments

Profiles

Senice/Time Sheets - Restricted Access to Senice/Time Sheets
Sourcing

Menu Item Description

Users

Invite new users, and manage what each user can do in the CSP and which customers your
users can interact with.

Merge Requests

Manage any merge requests that you sent to or received from other supplier accounts.

Legal Entity Setup

Set up your account for electronic invoicing.

Fiscal Add fiscal representatives that you need if you have operations in a country/region where you
Representatives are not registered legally but you need to be represented for tax purposes.
Remit-To Create and manage multiple remit-to addresses that are used to determine the payment

location for invoices. This is important for creating legally compliant invoices.

Terms of Use

To use the Coupa Supplier Portal (CSP), you must accept the terms of use.

Payment Preferences
[ Static Discounting

Set preferred payment terms (early payment discounts terms) to be applied to any of your
customers across all your invoices.

SFETP Accounts

Create and manage SFTP accounts to load invoices quickly.

cXML Errors

Get cXML error notifications and view the list of cXML errors to ensure timely correction and
better handling of cXML transmission failures.

SFTP Errors

View the list of SFTP (CSV) file upload errors to ensure timely correction and better handling
of SFTP transmission failures.
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Permissions grant access for users to corresponding menu items. As an admin user, you have all the permissions by

default.

You can manage user permissions and customer access by assigning certain users to only certain customers and by
limiting what types of documents they can access and what functions they can perform with their assigned customers.

Go to Setup > Admin. The Admin Users page appears.

Home Profile Orders Service/Time Sheets

Setup

Admin Customer Setup

Admin users

Users
Users

Jane Doe

el jane_doe@supplier com

Legal Entity Setup Edit
Fiscal Representatives
Remit-To
Terms of Use
Payment Preferences w
Static Discounting

SFTP Accounts

cXML Errors

Click on the Edit button to open the Edit user access for [User Name] window.
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Permissions

ASNs

Admin

Business Performance

Catalogs

Invoices

Order Changes

Orders - Restricted Access to Orders
Pay Me Now

Payments

Profiles

Senice/Time Sheets - Restricted Access to Senice/Time Sheets
Sourcing

Sourcing  Add-ons

Customer Access

Customer 1
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Edit user access for Jane Doe

User info

*First Name | Jane
*Last Name | Doe

* Email | jane.doe@supplier.com

Permissions @ Customers
] AN All
Admin Customer 1
Orders

@ Restricted Access to Orders
Al

Invoices

[«] Catalogs

Profiles

ASNs

Service/Time Sheets

@ Restricted Access to Service/Time Sheets
O Al

Payments
Order Changes
Pay Me Now

Business Performance

Sourcing

Cancel Deactivate User

You can change the user's name, modify the user's permissions and customer access, or deactivate the user.

Note: The Deactivate User button is inactive when you edit your own access to avoid deactivating your own
account.

You cannot change the user's email address. If a user wants to change the email address, send a new invitation to that
user.
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The Invite User and Edit user access for [User Name] windows are almost identical, but when you invite a user, you

can specify an email address.

User permissions

Administer the CSP

Permissions Description

All Gives full access to all CSP functions, except for user administration.

Admin Has full access to all CSP functions, including user administration. Non-admin
users can still view the Users tab of the Admin page and invite users, but they
cannot edit existing users. The permissions on the invitation cannot exceed the
permissions of the user creating the invitation.

Orders Allows viewing and managing purchase orders (POs) received from customers.

When selected, All is on by default.

Restricted Access to Orders

Allows accessing specific POs (assigned to specific users). The permission is off
by default.

All Allows viewing and managing all POs received from customers. When Orders is
selected, it is on by default.
Invoices Allows creating and sending invoices to customers.
Catalogs Allows creating and managing customer-specific electronic catalogs.
Profiles Allows modifying customer-specific profiles.
Note: All users, regardless of permissions, can edit the public profile.
ASNs Allows creating and sending advance ship notices (ASNs) to customers.

Service/Time Sheets

Allows creating and submitting service/time sheets against POs. When selected,
All is on by default.

Restricted Access to Service/
Time Sheets

Allows accessing specific service/time sheets (assigned to specific users). The
permission is off by default.

All Allows creating and submitting any service/time sheets against POs.
When Service/Time Sheets is selected, it is on by default.
Payments Allows viewing payments and downloading digital checks.
Order Changes Allows submitting PO change requests.
Pay Me Now Available only if your customers use Coupa Pay and enabled the feature related

to this permission.

Business Performance

Allows viewing business performance information, for example, order, invoice,
and delivery trends.

Sourcing

Allows viewing public sourcing events.
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Tip: Click on the Info (o') icon next to the Permissions header for more information.

The Info ('ﬂ) icon tooltip shows the following information:
Permissions grant access for the user to the corresponding menu items.

For Orders and Service/Time Sheets, an additional level of granularity allows restricting a user’s access to documents
that are specifically assigned to them. If you want to apply this restriction, select the Restricted Access to Orders and
Restricted Access to Service/Time Sheets permissions.

Some customers may not support restricting access to orders and service/time sheets. Contact the Customer Company
Admin to confirm if needed.

Note: For auditing purposes, Coupa does not allow users to be deleted, so you cannot delete a user from
your profile. Instead, you can deactivate a user when you no longer want that user to be able to access the
account.

Reactivate users

You can deactivate users when necessary. Also, users are deactivated automatically due to inactivity. For more
information, see [nactivity.

You can see the relevant user status: inactive or deactivated. If you hover over a user's status, the following tooltip text
is displayed informing you about the reason why a supplier user is not active:

» Deactivated: This user has been manually deactivated by an admin. It can be reactivated only by admin
reactivation.

» Inactive: This user's account has been deactivated due to inactivity. It can be reactivated by validating the user's
email during their next login attempt.

You can activate both inactive and deactivated users. If you activate them, they receive an email notification to verify
their email.

If you deactivate users, you can always reactivate them later. If you reactivate a user, the customer access is reset for
that user, so you'll have to assign customers to that user again.
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Manage Merge Requests

Your company may have more than one account/profile in the CSP. This can happen when several users from the same
company register or are invited to the CSP through different email addresses.

Note: Accounts with the same email address are merged automatically (regardless of which invite
message you use to create your account, since both invites are sent to the same email address).

The suggestions to merge accounts are based on email domain. For example, all the users with the @example.com
domain get suggestions to merge. Merge suggestions appear in the right-hand column on the Home page.

Merge Accounts

If your company has more than one CSP account, we
try to list it below. Consider merging them to reduce
confusion for existing and potential customers.

Not seeing the account you want to merge with? Click

here

SupplierA
supplierAgsupplier.com

Request Merge Remove

SupplierB

supplierB@supplier.com

Request Merge Remove

If you know that a suggestion is invalid, click on the Remove button and you will not see the request again.

If you want to merge an account, click on the Request Merge button and select an account to be the parent account
and add a note.
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Request Account Merge

You're about to merge your profile and users with Supplierd. Select the owner for the merged account. For
more info on merging, Click here.

* Account Owner @ My Account

i© Their Account

* Note

I'm not a robot

Cancel Send Request
Selection Description

*Account Owner / My Account This causes the other account to be merged into your company account. The
other user's company account is removed.

You continue to be the administrator for the merged company account, and the
previous administrator becomes a regular user in the merged account. You can
make them an administrator if you want. For more information,

see Manage Users.

*Account Owner / Their Account | Your company account is removed. The other user's company account becomes
the only company account.

You can no longer be the account administrator, but the administrator of the
existing account can choose to make you an administrator of the merged account.

*Note Add a note about the merge request, for example, the reason for the account
merge.

Merged accounts use the following rules:

Element Merge Behavior

Connected customers and Any connected customers are retained in the new account. The existing email
customer profiles address remains the contact email for the customer. If the customer is connected
to both accounts, the parent account connection is retained and the merged
account connection is removed.

Remit-to addresses Remit-to information is transferred only for addresses that are available to all
customers.

You can also search for a specific account to merge, for example, if the account is not listed or the list is too long to

Valid until January 31, 2021 154



CSP Admin and User Guide Administer the CSP

search for the specific account that you want. Clicking on the Click here link takes you to the Admin Merge Requests
page. You can access this page also by clicking on the Admin tab on the main menu and on the Merge Requests link
on the left.

Admin Merge Requests

Initiate Merge Request
Users e o

Merge Requests
Request Merge

Legal Entity Setup

Fiscal Representatives e 'l
I'm not a robot
reCAPTCHA
Privacy - Terms

Remit-To
Terms of Use By submitting the merge request | confirm that the user whose email address | am providing belongs to my organization
Payment Preferences w

Static Discounting Open merge requests

SFTP Accounts All clear! No open merge requests

cXML Errors

SFTP Errors

Provide the email address of the account you want to merge, and click Request Merge.

You can see purchase orders and create invoices for both supplier records after selecting a customer from the Select
Customer drop-down.
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Set up Legal Entities

You can set up your account to create electronic invoices from the Admin / Legal Entity Setup page. You can add,
manage, or deactivate legal entities, or manage remit-to accounts.

You can provide more remit-to accounts and add this information to your legal entities so that your customers can use
different payment methods when working with you.

Note: You can receive payments through the CSP only if your customer(s) enabled Coupa Pay.

View and manage legal entities
On the left of the Admin page, click on the Legal Entity Setup link.

Admin Legal Entity Setup Add Legal Entity
. Legal Entity
Merge Requests 35 TestLE3 W
I Manage Legal Entity
Legal Entity Setup
v TesiLE2 ‘ Manage Remit-To Accounts
Fiscal Representatives Deactivate Legal Entity
v TestLE1 ;

Remit-To

If you have three or more legal entities, they are collapsed. To view their details, click on the Down arrows.
Each legal entity has the following sections:

* Invoice From

* Remit-To Accounts — Can be of type: Address, Bank Account, or Virtual Card.

* Locations

» Customers — The name(s) and number of customers that you provided with the specific legal entity are also shown.
Hovering your cursor over n customers displays the name(s) of the customer(s) associated with the legal entity.

Admin Legal Entity Setup Add Legal Entity
Legal Entit
Users egal Entity
Merge Requests > TestLE3 | ¥
Legal Entity Setup Invoice From Remit-To Accounts Locations Customers
Fiscal Representatives 111 Invoice From Bank Account 2 customers 123 Other
Remit-T Address Address
emit-io 12345 Bank Name Bank One 66666
Beneficiary Name Jane Doe

San Mateo Somewhereelse
Terms of Use KRR R

United States ATz Y United States

Transit Code 123456789
Remit-To Address 111 Remit-To
Preferences Address

12345

San Mateo
United States
Active

Coupa Accelerate

SFTP Accounts

cXML Errors
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To add a legal entity, click on the Add Legal Entity button in the top right corner.

Tip: You can add legal entities also from the Profile edit page directly or when creating an invoice.
See Create or Update Your Profiles and Create or Edit an Invoice for more information.

Enter the official name of your business that is registered with the local government (legal entity name) and select the

country/region where it is located. Click Continue, and in the appearing Tell your customers about your organization
window, fill in at least the mandatory fields, that is, the fields marked with a red asterisk (*).

Field/Checkbox Description

Which customers do you want
to see this?

Select all or the specific customer(s) that you want to see your legal entity
information.

Customers that use Coupa for payments are marked with the Coupa Pay (D)
icon.
If you select a Coupa Pay customer, the payment information that you enter is

validated. The icon and tooltip are different depending on whether your banking
information is:

* Valid: ta
. Invalid: &

* Pending validation: 1:3

What address do you invoice
from?

Required for invoicing. Is critical for compliance in some countries.

Registered address of your legal entity. This is the same location where you
receive government documents. It might differ from the physical address.
Sometimes this is called your address of record or registered company address.
Address line 1, city, and postal code are mandatory.

Country/Region

The country/region you selected when adding the legal entity.

Use this address for Remit-To*

Selected by default. Deselect it if your remit-to address is different from your
invoice-from address or you have more than one remit-to locations.

Use this for Ship From address*

Selected by default. Deselect it if your ship-from address is different from your
invoice-from address or you have more than one location.

Tip: Include this information on the invoice when the addresses are
different. For many countries, including this information is mandatory.

What is your Tax ID?

Enter your tax/VAT ID.

Note: If you are exempt from tax registration in some regions/countries,
select the | don't have TAX ID Number checkbox and enter your local tax
ID or write N/A in the appearing Local Tax ID field.
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Field/Checkbox Description

Country/Region Select your tax country/region from the drop-down list.
Tax/VAT ID Enter the tax/VAT ID, including the prefix to the number, for example,
GB1234567890.
Tip: You can add more tax IDs by clicking on the Add additional Tax ID
link.
| don't have a TAX ID Number Select the checkbox to add your local tax ID or write N/A in the Local Tax ID field.

Miscellaneous

Invoice from Code Tie your CSP invoice-from address (that is, registered address) with the
corresponding address in your ERP.

Preferred Language Select your language from the drop-down list.

*If your remit-to and ship-from addresses are different from your invoice-from address, you need to provide also that
information.

Atfter filling in the fields, click Save and Continue. In the appearing Where do you want to receive payment? window,
select from the following payment types: Address, Bank Account, and Virtual Card.

Note: You can see these options and provide your information even if your customer does not use Coupa

Pay. However, when you create an invoice for a customer that does not have Coupa Pay enabled, you
cannot select the virtual card option.

Where do you want to receive payment?

* Payment Type = Address v
Address

What is your Re.
Virtual Card
Address Line 1 222 Invoice From
Address Line 2 Address
City Big City
State
Postal Code 33333

Country United States

Cancel Save & Continue
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If you select Address (default option), you can continue to the next step as you already provided the address(es) on the
previous page.

If you select Bank Account, you can provide your banking information to be shown on your invoices.

Note: The available bank account fields and field names depend on the selected country.
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Field/Checkbox Description

What are your Bank Account
Details?

Optional but recommended banking information for the remit-to address. You can
use both domestic (US) and international (global) banking information.

Note: Banking information is required for compliant invoicing in some
countries when indicated (with a red asterisk). Otherwise, banking
information is not required and remains private.

Some banking information is also required if your customers use Coupa
for payments.

Tip: Click on the Info (0) icons next to the fields to see the tooltips
showing the number and type of characters allowed in the banking
information fields depending on the selected bank account country.

This information is displayed on the invoice.

Bank Account Country/Region

Select the country from the drop-down list. By default, your legal entity country/
region is selected.

Bank Account Currency

Select the currency from the drop-down list. By default, it is the currency of the
bank account country/region.

Beneficiary Name

Enter the name of your beneficiary. By default, it is your legal entity name.

Bank Name

Enter the name of your bank.

Account Number

Enter your account number.

Confirm Account Number

Confirm your account number by entering it again.

IBAN

Enter your International Bank Account Number.

Confirm IBAN

Confirm your International Bank Account Number.

Routing (Bank Code) Number

Select one of the Routing Number (default), Bank Code, BSB, IFSC, Sort
Code, or Transit Number and Institution Number fields and fill in the field next
to it accordingly.

SWIFT/BIC Code

Enter your SWIFT/BIC code.

Bank Account Type

Type of the bank account: business or personal.

What is your Bank's Branch
Address?

Includes address-specific fields: Address Line 1, Address Line 2, City, State,
and Postal Code.

What is your Remit-To
Address?

Address where you want to receive payment. (If you receive payments to a
different location than where your business is registered.).

Includes mandatory address-specific fields: Address Line 1, Address Line 2,
City, State, Postal Code, and Country/Region.

What is your Remit-To
Integration Code?

Code to tie your CSP remit-to address to the corresponding address in your ERP.

Who is your Remit-To Contact?

Optional contact information for the remit-to address: name, email, phone
number, fax number, and website.
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Which customers can use this | Select all or the specific customer(s) that you want to see your remit-to account.
account?

If you select Virtual Card, you need to provide an email address and you can indicate if you accept credit cards.

Where do you want to receive payment?

* Payment Type | Virtual Card ~

Virtual Card information

* Email Address

Accept credit cards? [

What is your Remit-To Address?

Address Line 1 222 Invoice From
Address Line 2 Address
City Big City
State
Postal Code 33333

Country United States

Cancel Save & Continue

The Where do you want to receive payment window shows both the Remit-To Account and the Remit-To Address.
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Where do you want to receive payment?

Remit-To locations let your customers know where to send payment for their invoices. Click Add Remit-To to

Add Remit-To
add more locations, otherwise click Next.
Remit-To Account Remit-To Address Status
Address 222 Invoice From Active Manage
Address
Big City
33333
United States

Deactivate Legal Entity Cancel m

To manage your legal entities, click on the Actions button on the Legal Entity Setup page, select Manage Legal

Entity, and click Continue. In the appearing Where do you want to receive payment window, you can add a new
remit-to address.

You can deactivate a legal entity by selecting Deactivate Legal Entity from the Actions button or on any of the
appearing windows.

Click Next to add the address where you want to ship goods from, if it is different from the remit-to address. Fill in at
least the mandatory fields and click Continue.

After completing the legal entity setup by clicking Done, that is, after adding a legal entity, you can use it on new
invoices. From the Setup Complete page you can choose to Go to Orders, Go to Invoices, or Return to Admin page.
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Setup Complete

Congratulations!

This legal entity can now be used on new Invoices.

Once you are invited to do business on the Coupa Supplier Portal by your customer(s), this
information will be available for you to share with them and use on invoices. Request an invitation
from your customer(s) today to start transacting.

Go to Orders Go to Invoices Return to Admin m

To manage your remit-to accounts, go to Setup > Admin > Remit-To. For more information, see View and Manage
Remit-to Information.
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Add Fiscal Representatives

You need a fiscal representative if you are legally registered in Country/Region A, but you have some operations in
Country/Region B that requires you to be registered for tax purposes in Country B. As you are not legally registered
(with a local address) in Country/Region B, you need a representative/agent to represent you towards the tax authorities
if they need to contact your business. Furthermore, in some countries this information must be on the invoice.

If you add a fiscal representative, this is associated with a tax registration number that you set up when adding a legal
entity. For more information, see Set up Legal Entities.

Note: Add fiscal representatives before setting up a legal entity. This ensures that you can assign your fiscal
representative to your legal entity.

On the left of the Admin page, click on the Fiscal Representatives link and on the Add Fiscal Representative button.

Admin Fiscal Representatives Add Fiscal Representative

None
Users

Name Country Tax ID Associated Tax Registrations
Merge Requests
Legal Entity Setup
Fiscal Representatives
Remit-To

Terms of Use

Coupa Accelerate
Preferences

SFTP Accounts

cXML Errors

In the appearing window, fill in at least the mandatory (address) fields (marked with a red asterisk): address line 1, city,
postal code, country/region, and VAT ID.
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Code

Address
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* Address Line 1
Address Line 2
* City

State

* Postal Code

* Country

*VAT ID

Contact

First Name

Last Name

Email

Work Phone

Mobile Phone

Fax Number

Web Site

The entry appears in the table on the Admin Fiscal Representatives page. Click on the Manage button in the right

corner of the table to manage/edit the information for your fiscal representative.
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View and Manage Remit-to Information

Remit-to addresses ensure global electronic invoice compliance. To meet compliance regulations for most countries
outside of the US, an invoice must include a remit-to address and associated tax information. If you want to do business
with a customer who enabled compliant invoicing, you need to provide the necessary information.

You are required to add a remit-to address when setting up (adding a legal entity for) electronic invoicing or creating
invoices. For more information, see Set up Legal Entities and Create or Edit an Invoice.

View remit-to accounts

Go to Setup > Admin > Remit-To to view the list of remit-to accounts and their details: associated remit-to address and
legal entity, payment type, the (up to five) customer(s) they are assigned to, and possible actions (update, share, and
disable).

Setup

Admin Customer Setup

Admin remit-To

Add Remit-To
Users Remit-To Account Remit-To Address Payment Type Legal Entity Customers Actions
P Bank of All #5555 stn ’Ei;:.::j;m Bank Account Fruit Supplier LE1 ¥ Orange Buyer \Fe
. CA
Legal Entity Setup 94015
Fiscal Representatives Urited States
Remit-To Bank of All 9012 111 Other Street Bank Account Fruit Supplier LE2 + Orange Buyer Fo
B Suite A A Banana Buyer

Terms of Use Cincinnati

OH

45202

Payment Preferences w
United States

Static Discounting

None 123 Main Street Address Fruit Supplier LE1 ®
SFTP Accounts Suite A
Cincinnati
cXML Errors OH
45202
SFTP Errors United States

Icons in the Customers column indicate the status of the remit-to accounts.

The most recently added remit-to account is at the top of the list.

Manage remit-to accounts
You can add new, or update, share, or deactivate existing remit-to accounts by going to Setup > Admin > Remit-To.

Add

To create a new remit-to, click the Add Remit-To button, select the legal entity to be associated with it, and click Next.

Note: If only one legal entity is active, it is selected by default and you cannot change it.
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You can add remit-to accounts also from the Setup > Admin > Legal Entity Setup page. Click on the Actions button,
select Manage Remit-To Accounts, and in the appearing Add a new Remit-To account window, click Add Remit-To.

In the appearing Add a new Remit-To account window, fill in at least the mandatory address fields and select a
payment type (marked with a red asterisk).
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Add a new Remit-To account

What is your Remit-To Address?

* Address Line 1

Address Line 2

|

* City | | If you receive payments fo a

different location to where your

State | Select an Option v ]

business is registered, add the

* Postal Code | | address here.

* Country/Region | United States - |

Code | |

Payment Method

* Payment Type | Bank Account |

What are your Bank Account Detailz? @

Bank Account | United Sfates e |
Country/Region:

Bank Account Currency: | uso b |

Beneficiary Name: ‘ Ahmad Supplier 2 |

Bank Mame: ‘ |

Account Number: ‘ |°

Confirm Account ‘ |
Number:

Routing Number: ‘ | o

SWIFT/EIC Code: ‘ | i ]

Bank Account Type: | Business b |

What is your Bank's Branch Address?

Address Line 1: | |

Address Line 2: | |

City: | |

State: [ Select an Option b ]
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For more information about the fields, see Set up Legal Entities.

If the selected payment type is Bank Account, you can see fields for bank account details that are relevant to the
selected bank account country/region.

Bank account fields are validated.
Tip: Tooltips marked with the Info (o) icon provide information about the valid format for the fields.

If you enter an invalid format in a field, the field is highlighted in red and information about the expected format is
displayed in red text under the field.

Click Save and Continue. The new remit-to account is added to the list.

Note: When you try to save a remit-to account with invalid fields, you can see an error message. You can
decide to ignore the errors and save the account anyway; however, it is not recommended as it may result in
delayed processing for the affected customer(s).

You can save an invalid remit-to account only once; later you are required to correct the invalid fields.

Invalid remit-to accounts are marked with red in the Customers column and a tooltip provides details about the error.
Deactivate, Update, or Share
To deactivate a remit-to account, click Manage in the Add a new Remit-To account window, and then click Deactivate

Remit-To. You can deactivate remit-to accounts also from the Admin / Remit-To page by clicking the Disable ()
icon in the Actions column.

Deactivating a remit-to account also deactivates the corresponding supplier payment account on your Coupa Pay
customer side. If the deactivation is unsuccessful, you are informed about it in a message bar.

Note: Deactivation cannot be undone, so you are asked to confirm the action.

Click the Update (¢ ) icon to update remit-to information, for example, to correct invalid fields.

Note: After you submit the updated remit-to information, a new remit-to account is created and the original
account is deactivated.

You can share your remit-to accounts with some or all customers. Click the Share (#" ) icon and in the appearing Edit
Remit-To Usage window, select the customer(s) from the Add Additional Customers drop-down list, and click Add
Selected. To share it with all your customers, select Add All from the Add Selected drop-down.
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Edit Remit-To Usage

Legal Entity Fruit Supplier LE1
Remit-To Bank of All =™ 7777

111 Other Street
Suite A
Cincinatti
United States

Which customers can use this account?

Add Additional Customers [ Add Selected ~

2 Denotes customers that require validation with Coupa Pay. Additiona I'ﬁgeﬁ t-To account details
will be shared with these customers.

Customer Status Date added

Qrange BuyerEg) Active & Valid 10722120

Back ——

Note: If you merge accounts, your remit-to addresses are not merged unless you make them available for
all customers. Once the merge is complete, you can assign the remit-to address to the specific customer(s)
again.

Add remit-to addresses to your SIM form response

Your customer might request you to add a remit-to address to your Supplier Information Management (SIM) form
response. You can create a new remit-to address or choose an existing one from the legal entities.

Go to your customer profile in the CSP to fill in/fupdate your supplier information by doing one of the following:
» Click on the View Online button in the Update Profile email notification from your customer.
» Go to Notifications and click on the Update your profile for [Customer Name] link in the CSP.

» Go to Profile > Your Customer Profiles in the CSP and select the customer for whom you want to update your
profile.

On the appearing page, click Add Remit-To to add a new or an existing remit-to address to SIM. You can add one or
more remit-to addresses.

If you already provided remit-to information to your customer, for example, on an invoice, the Remit-To Address fields
are pre-populated based on the most recently used or created remit-to. If you added multiple remit-to addresses and
your customer requests more remit-to addresses, all of them are pre-populated.
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If your customer marked the Remit-To Address section to be mandatory when creating the form, there is an asterisk
next to it, and you cannot submit your response without providing the remit-to address.

Home Profile Orders Service/Time Sheets ASN Invoices Catalogs Payments Business Performance Sourcing  Add-ons

-

Setup

Your Public Profile Your Customer Profiles

Halloween Customer Profile | Halloween Customer -

Supplier Information Pumpkin Patch Supplier

Name | Pumpkin Patch Supplier
Default Commodity

Industry | Growing of rice ~

«Remit-To Addresses

Add one or more Remit-To Addresses by either filling out a new Compliant Inveicing Form or choesing an Existing Remit-To Address

Add Remit-To

*Remit-To Address

Beneficiary Name Pumpkin Patch LE 0
Street Address 400 Orchard Street
Street Address 2
City Sewickley
State Region PA

Postal Code 15143

The Choose Remit-To Address window lists all the remit-to addresses that you already created in the CSP as part of
your legal entity to be used for e-invoicing and payment.
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Choose Remit-To Address p 4

Choose existing or create new Remit-To Address:

431 Pumpkin Road Virtual Card e e
Pumpkin Patch Farms, PA 14321 kat™" " ***@cou™"""

United States

United States

431 Pumpkin Road Bank Account (Bank of 0 et
Pumpkin Patch Farms, PA 14321 Ally

United States

United States

400 Orchard Street Bank Account (Bank of 0 e
Sewickley, PA 15143 Ally

United States -
1 b

O Create New Remit-To Address

Cancel

When you choose an existing remit-to address, the new remit-to address is created for SIM and its fields are pre-
populated with data from the chosen remit-to address. Remit-to addresses that are no longer valid are marked with a red
icon and a tooltip provides details.

Note: From among populated fields, only bank fields and empty fields are editable.

You can see only those fields that your customer who requests the SIM response included in the SIM Remit-To
subform, for example, location code, address, bank and account information, and whether the remit-to address is active
or inactive.

All the fields with validation have the Info icon ('ﬂ') with a tooltip to provide guidance on the requested information.

If you see invalid fields, update your remit-to address for your Coupa Pay customer(s).
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After filling in the fields, submit your form; you can update it any time.

You are notified in the message bar and you receive an email notification of the successful update, and the new remit-to
address is added to the top of the remit-to address list.

If you want to create a new remit-to address from the CSP, you are directed to Legal Entity Setup.

Unlike when creating a remit-to address for e-invoicing in the CSP, when adding a newly created remit-to address to
SIM, you can decide to add it to your customer profile immediately or later on the Setup Complete page.

Click on the Add Now button to add the newly created remit-to address to the SIM form response.

Note: If you click Add Later, the new remit-to address is not added to the form, but you can select and add it
later.

You can fill in your SIM form response also through Supplier Actionable Notifications (SAN) by creating a new remit-to
address.

Note: Deactivating a legal entity on the CSP does not deactivate the remit-to address on SIM.
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Terms of Use

To use the CSP and to allow Coupa to create invoices on your behalf when you use compliant e-invoicing, you must
sign the Coupa Open Business Network legal Terms of Use. Otherwise, you cannot create and submit invoices through
Coupa and the CSP.

The legal terms of use lists the terms and conditions for using e-invoicing through Coupa and the CSP. You as a
supplier, especially if you are responsible for managing legal tax invoices, are required to have read, assessed, and
agreed to these terms of use and to be aware of your responsibilities towards the content and handling of these
invoices.

To issue a legal compliant invoice, you need to set up a remit-to address for a compliance country. When you use a
compliance country remit-to address for the first time, Coupa validates if you have signed the latest terms of use.

If the Terms of Use has not been signed yet or there is an updated version of the Terms of Use, you are prompted to
review and sign it.

Zyscoupa supplier portal BLUE -  NOTIFICATIONS @@ = HELP

Home  Profile  Orders  Service/TimeSheets ASN | Invoices Catalogs Add-ons  Admin

Our compliant invoicing Terms of Use have been revised.
Please confirm that you have read and agree to the current Terms of Use.
If you do not agree, you will not be able to send invoices to Coupa compliant customers.

1 Accept

Your customer can notify you in an email of an updated version of the Terms of Use. You can use the embedded link to
review and sign the legal terms of use.

The Terms of Use is available when you register and log in to the CSP for the first time, when you are notified in the
CSP of an updated version, and any time on the left of the Admin page and in the table below.

Time Period Terms of Use

March 1, 2017 - Present Coupa_Open_Business_Network_Terms_of Use_v.2_28 17.pdf - last updated:
February 28, 2017

Dec 1, 2016 - Feb 28, 2017 Coupa_Open_Business_Network_Terms_of Use v.11_30_16.pdf - last updated:
November 30, 2016
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Set Static Discounting Preferences

Overview

Coupa Static Discounting helps you to get paid earlier by allowing you to set and update preferred accelerated payment
terms (early payment discounts terms) and by applying those terms automatically to all or selected Coupa customers
across some or all your invoices and/or purchase orders. Your customers can also set payment terms specific to you.

Note: You can use Coupa Static Discounting successfully only if your customers have it enabled.

You receive notifications of customers who are ready to accept early payment discount offers, and you can set your
payment terms directly from the CSP notifications or accelerate from a PO email.

You can change a net payment term (for example, Net 60) to a discount payment term (for example, 2%/20 Net 60).

Note: Coupa Static Discounting only changes payment terms. It is at your customers' discretion whether to
pay the invoice early and take the discount, or to pay the full amount in the net term days.

Coupa Static Discounting does not update existing early payment discount terms. It only updates net
payment terms to early payment discount terms as you selected. Thus, it does not change a 2%/10 Net 30
term to 1%/10 Net 30. It only changes Net 30 to 1%10 Net 30.

If you always prefer early payment discounts on your Coupa purchase orders and invoices, set your Static Discounting
preferences to apply to all invoices. If you only prefer early payment discounts on some transactions, set those
discounts on the specific orders and invoices.

Setting the Static Discounting preferences to apply to all invoices means changing a net payment term on a Coupa
transaction (for example, a Net 60 payment term on an order or an invoice) to the discount payment term chosen on the
Coupa Accelerate Preferences page (for example, 2%/20 Net 60) for all invoices in Coupa, regardless of whether
there is a purchase order or what channel the invoice is submitted through. (Invoices can go to Coupa from the CSP, on
paper, in emails to the buying company, and through automated data feeds.) This option ensures that you get faster
payment on as many invoices as possible through the CSP, and it is recommended if you want accelerated payments
on non-PO invoices.

If you do not choose to set the Static Discounting preferences to all invoices, Coupa only applies the discount payment
term to an invoice from an order that has an accelerated discount payment term. This option is recommended if you
want your accelerated preferences to be applied only to invoices from purchase orders to ensure that the payment terms
on your original invoices match the payment terms in Coupa before you create the invoice. If the payment term you
selected matches one of the discount terms on your Coupa customer side, that discount is automatically assigned to the
transaction, that is, to the Coupa purchase order you receive or the invoice you send through the CSP, Supplier
Actionable Notifications (SAN) (creating invoices from PO emails), or other invoicing channels.

View and set payment terms

Click on the Coupa Accelerate Preferences link on the left of the Admin page.
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Admin Coupa Accelerate Preferences

Users

Merge Requests
Legal Entity Setup
Fiscal Representatives
Remit-To

Terms of Use

Coupa Accelerate
Preferences

SFTP Accounts

cXML Errors

Applies To Default Customer Preferences Edit Preferences

Coupa Accelerate Preferences

To get your invoices paid faster by offering an invoice discount, please click the 'Edit Preferences' button. Your customers can, at their discretion, use
Coupa Accelerate to automatically apply the preferred payment term to any of your invoices. You can change your preferences at any time on this
page. Email accelerate@coupa.com if you need any assistance.

Your original payment Your preferred accelerated payment term
term

Net 30 None

Net 45 None

Net 60 None

Net 75 None

Net 90 None

Net 120 None
Approver name
Approver email

Apply accelerate No
preference to all
invoices

Click on the Edit Preferences button in the top right corner. Fill in the mandatory name and email fields, and select your
preferred accelerated payment terms to be applied to all your customers by default if Default Customer Preferences is
selected. If you have customer-specific payment terms, you can also modify them on this page after selecting the

specific customer from the Applies To drop-down.

You can choose from a standardized list of possible discounts for each term length.
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Coupa Accelerate Preferences

Applies To | Default Customer Preferences w

To get your invoices paid faster by offering an invoice discount, please set your preferences below. Your customers can. at their
discretion, use Coupa Accelerate to automatically apply the preferred payment terms to any of your invoices. You can change your
preferences at any time on this page. Email accelerate@coupa.com if you need any assistance.

Your original payment Your preferred accelerated payment term

term

Net 30 | None ~
Net 45 | None V)
Net60 |1one

0.5%/35 NET 45
Net 75 | 19%/25 NET 45

o
Net 90 1.5%/15 NET 45

Net 120 | None v

Person or Group at your company (typically finance or treasury) who has approved your preferred accelerated payment term

* Name
* Email

] Apply to ALL invoices. (Including non-PO invoices and Coupa invoices not submitted through this Supplier Portal).Learn more

For a specific transaction (purchase order or invoice), you can choose to change a net payment term (for example, Net
60) to a discount payment term (for example, 2.5% 10 Net 60) if your customer's configured Payment Terms is enabled
for these Coupa-preferred payment terms. You can "accelerate" the order or the invoice.

If your choice matches one of the discount terms on the customer side, that discount is automatically assigned to the
transaction.

Select the Apply to ALL invoices checkbox to apply your Coupa Accelerate preference to all invoices, including non-
PO backed invoices and invoices sent to your Coupa customer through cXML, email, and so on.

Accelerate orders or invoices

Open the order/invoice and click on the Accelerate Payment button next to the Payment Terms field.
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guscoupa supplier portal

Home Profile Orders Service/Time Sheets ASN Invoices

Orders Order Lines

Purchase Order #4227

Status |ssued - Scheduled for email
Order Date 11/23/17
Revision Date 11/23/17
Requester John Doe
Email john.doe@doe.com

Payment Terms Met 600 A Accelerate Payment

Attachments MNone - -
[ Get paid faster with Coupa Accelerate

In the appearing Accelerate Payments dialog box, select a payment term from the available options and
click Update. Your customer might have assigned payment terms specific to you. Only those payment term options are
visible that have the same net payment terms as your default.
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Accelerate Payments

Get paid faster with Coupa Accelerate. Learn more
Select tha naw term and click the Update button to change the terms for PO #4227

Current Payment Term New Payment Term

Net 80 >

0.7% 40 Met 60

| am authorized to choose payment tarms.

If you accept the terms, you are asked in a popup if you want to update your default Coupa Static Discounting payment
preferences on all the future orders and invoices with the specific customer. If you decide to Update them, you

are directed to the customer-specific Coupa Static Discounting Preferences page. Here, you can also choose to apply
your discount payment terms globally to all customers by selecting Default Customer Preferences.

Coupa Accelerate Preferences

Applies To| Default Customer Preferences w

Default Customer Preferences

To get youri voice discount, please set your preferences below. Your customers can, at their discretion,
use Coupa Accelerate to automatically apply the preferred payment terms to any of your invoices. You can change your preferences at
any time on this page. Email accelerate@coupa.com if you need any assistance.

Your original payment Your preferred accelerated payment term

term
Net 30 0.5%/20 NET 30 ~
Net45 = 1%/25 NET 45 ~

Note: Customer-specific payment term preferences override default customer preferences.

The new payment term is applied and your order is accelerated.
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Purchase Order #4227

Congrats! You have accelerated payment for PO #4227

Status |ssued - Scheduled for email
Order Date 11/23/17
Revision Date 11/23/17
Reguester John Doe
Email john.doe@doe.com

Payment Terms 1.5/30 Net 60
Acceleratedﬁ

Attachments MNone

Note: Accelerated payment terms automatically apply to invoices created against accelerated orders.

When an accelerated payment term is applied to an order or an invoice, that payment term is available on the order or
the invoice and it has the Accelerated flag. You are notified of the action in the message bar and the change is
recorded in the History section.

For a specific transaction, if one of the listings in your customer's Payment Terms table matches your

selected preferred discount, that invoice or order is automatically marked as "Accelerated”. If there is no match, you can
see the Accelerate Payment button in the Payment Term field of the invoice. Clicking on it allows your customer to
select from their list of authorized payment terms.

Accelerate orders from PO emails
You can accelerate orders directly from PO emails if:

* Your customers enabled Coupa Static Discounting.
* You set accelerate preferences.

» POs have net terms that can be accelerated.

* Your customers set up matching payment terms.

Click on the Accelerate Payment button in the PO email.
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Z,#CoUPA Purchase Order #1000000109

Hi Jim,

This is PO #1000000109

Submitted By John Doe
Supplier Acme Games

Total 220.00 USD

ltems Test-Qty-1 1.0 Hour @ 20.00 20.00 uso
Test-Amt-1 200.00 uso

e

More Detail
PO ID 1000000709 Department None
Status Issued - Sent via Email Last Opened Mone

From the email, you are directed to the PO and the Accelerate Payment dialog box appears. For more information,
see Accelerate orders or invoices.

Notifications

If your customers turn on Coupa Static Discounting and you are linked to the CSP, you receive notifications of the early
payments opportunity. Depending on your notification preference settings, you receive email, online, and/or SMS
notifications.

Note: Notifications are sent within 24 hours after your customers enable Coupa Static Discounting.
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Email notification

f:}COLIpa Acme Inc. Can Pay Faster with Coupa Accelerate

Hello Jim,

We're excited to announce that Acme Inc. can offer you the flexibility to get your invoices paid faster using Coupa Accelerate.

Accelerate is a feature within Coupa's Supplier Portal that allows you to opt-in for fasier payment terms in exchange for a discount of your choosing. You can decide now to enable this globally with one easy configuration
for all invoices in Coupa. Otherwise, there may still be the opportunity to get paid faster on individual orders and invoices.

Click "Update your preferences” below and we'll try to navigate you to those preferences. If not - just click on your "NOTIFICATIONS' in the top right after you login.

In the future, you can find this setting in the "Admin" tab under "Coupa Accelerate Preferences”

Update your preferences

Online notification
JM~ | NOTIFICATIONS @)  HELP ~

New Early Pay Customer
Acme Inc. can pay your invoices faster using Coupa

Accelerate. Update your preferences. ‘b

¢ A new order is received
1 Mew PO 1000000575 for $444.00 issued by Acme Inc.

When you click on the Update your preferences button in the email notification or on the New Early Pay Customer
notification in the CSP, you are directed to the Coupa Accelerate Preferences page where you can set your payment
terms.
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Create SFTP Accounts

You can create and manage your SFTP accounts for loading invoices for your customer(s) that have not disabled this
feature.

Tip: Before starting to create SFTP accounts, ensure that your customers support invoicing and this
functionality.

Click on the Admin tab on the main menu. On the left of the Admin page, click on the SFTP Accounts link.

On the SFTP Accounts page, select a customer and click Create.

Note: You can create only one account for each customer.

Admin
SFTP Accounts
Users
Merge Requests Select Customer Customer 1 ~
Legal Entity Setup
SFTP Accounts
Fiscal Representatives
Remi-To [son P

Terms of Use Username Hostname Actions

Mo rows.
Coupa Accelerate I

Preferences Perpage 15 45 90

SFTP Accounts

On the appearing Create sFTP Account page, you can choose the file with your own SSH public key to upload, or you
can create the account and Coupa generates a password for you.

SFTP Accounts

Select Customer Customer 1 ~

Create sFTP Account

SSH Key (optional)

Browse... No file selected.

The SFTP account is created.

If a password is generated for you, you can see it in the Password field.
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Your password is found below (warning: Copy and store password securely as it is only shown once)

Username supplier_sftp_account

Hostname fileshare xyz.com
Your password is found below (warning: Copy and store password securely as it is only shown once)

Password 4XGudedpkix
Uploaded public key

Note: Write down your password because it is not revealed when you view your account.

The newly created account is listed in the sFTP Accounts table with username and hostname. The username is

generated automatically and cannot be modified.

sFTP Accounts

Instructions From Customer

Hostname Actions

Username

I supplier_sftp_account fileshare xyz.com /

Perpage 15 45 90

Click on the username link to view details of the SFTP account, including the history.
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SFTP Account

Username supplier_sftp_account
Hostname fileshare xyz.com
Password =

Uploaded public key

Note: Password and key are cryptographically processed and original values not shown

(Y History v

Supp“er_awesome On 041219 at 03:18 AM

Sftp account supplier_sftp_account Created

You can also edit the account by clicking on the Edit (s* ) icon in the Actions column. You can upload SSH keys (one
for each of your customers) to replace previous keys, or you can regenerate passwords.

Edit sFTP Account

Username | supplier_sftp_account

Hostname | fileshare.xyz.com

Regenerate Password
SSH Key (optional)

Browse... Mo file selected.

When you have an SFTP account and password, you can start uploading your invoices.

Note: You need to have an SFTP client, for example, Filezilla or Cyberduck, to make the connection and
transmit invoices through SFTP.

Tip: If you have an SFTP account, you can view SETP file upload errors.
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View cXML Submission Errors

If you use cXML for PO and invoice submissions to your customers, you can receive notifications of cXML transmission
failures and view details about cXML errors.

Note: You can view cXML errors if your customer enabled sending cXML error notifications to you and you
provided a supplier integration contact.

You can enable/disable cXML error notifications by changing your notification preferences for Enable notification for
integration error under the Integration Errors section. For more information, see View and Manage Notifications.

Note: Notifications for cXML errors are off by default.

The online notification for integration errors is Encountered cXML error for <customer name>.

Note: A notification contains up to ten cXML errors and is sent only every 24 hours.

Clicking on the online notification or the link in the email notification directs you to the error. You can view and manage
the errors for cXML orders and invoices for a specific customer by going to Admin > ¢cXML Errors and selecting
the customer from the drop-down list.

Admin
cXML Errors
Users
Merge Requests Select Customer Coupa ~
Legal Entity Setup CXM L I nVOl ce ~

Fiscal Representatives
Invoice  Purchase Order
Remit-To -

Terms of Use
All ~ Advanced

Coupa Accelerate

Invoice Number Created Date Category Request Error Response Error
Preferences
12345 0870719 11:07 Invalid <?xml version="jkhjkh1.0" encoding="UTF4444-8"7> <Pxml version="1.0" encoding="UTF-8"?> <IDOCTYPE
SFTP Accounts PM attributes  <IDOCTYPE XML SYSTEM “http:/fxml.cXML org XML SYSTEM “http:/fxml.cxml.org/schemas
XML Errors in /schemas/cXML/.2.020/InvoiceDetail dtd"™>= <cXML feXMLA.2.020/cXML.dtd"> <cXML xml:lang="en-US"
document. version="1.0" timestamp="2019-08-08T06:07:47+00:00"

payloadD="1240598937@SUBDOMAIN.coupahost.com” payloadlD="1240598937@SUBDOMAIN.coupahost.com™
timestamp="2009-05-04T01:24:51-07:00"> <Header= <Response> <Status text

By default, the cXML Invoice page is shown. To view the cXML errors for orders, click on the Purchase Order tab.
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Access Add-ons

Add-ons

An add-on is a value-creating product or service that you can begin to use or express interest in using, for example,
Coupa Advantage, Coupa Accelerate, or invoice financing.

As a CSP admin, you can access information about all the available add-ons and let Coupa know if you are interested in
these services, and you can update your supplier profile or set your early payment discount terms, all from a single

page.

Note: Coupa add-ons are free.

When you click on the Add-ons tab, you can see the following page:

Home Profile Orders Service/Time Sheets ~ ASN Invoices Catalogs Payments Add-ons Admin

Add-ons

Increase Sales v
Coupa Advantage

g? Cou pa Pre-negotiated pricing of your goods or services you can offer to any Coupa buyer, as a trusted supplier for the Coupa
ADVANTAGE Community.

Lower Costs v
w

One-Click Savings
X Start Saving todayl Explore deals for your company, exclusive to the Coupa Community

Business Spend Management

* Coupa Learn more about using the Coupa platform to better manage your own spend.

Improve Cash Flow v

Early Payment Discounts

Get access to cash earlier by directly offering early pay discounts to Coupa buyers.

Clicking on a box (icon and text) directs you to the relevant pages to find more information about these add-ons:
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Add-on Description

Increase Sales

Coupa Advantage Pre-negotiated pricing of your goods or services you can offer to any Coupa
buyer, as a trusted supplier for the Coupa Community.
You can express interest in becoming a Coupa Advantage supplier.

Lower Costs

One-Click Savings New.

Start saving today! Explore deals for your company, exclusive to the Coupa
Community.

You can learn about the Coupa Cares program, explore savings opportunities
with Coupa Advantage suppliers, and express interest in becoming a Coupa

Advantage supplier.

Business Spend Management Learn more about using the Coupa platform to better manage your own spend.
You can express interest in becoming a Coupa customer.

Improve Cash Flow

Early Payment Discounts Get access to cash earlier by directly offering early pay discounts to Coupa
buyers.

You can set your preferred early payment discount terms by clicking on

the Update Static Discounting Preferences button, which takes you to the
Admin > Static Discounting page.

One-click savings

When you log in to the CSP, you can see a banner at the top of the Home page above the profile progress information
with the following message: "New: Exclusive discounts for your business to thank you for being a part of the Coupa
Community." and the One-Click Savings section under the Announcements section.

You can close the banner, but it is displayed every time there is a new offer.

Home  Profile  Orders  Service/Time Sheets ~ ASN Invoices  Catalogs Payments  Add-ons  Admin

% New: Exclusive ﬁrlri‘szou“ts for your business to thank you for being a part of the Coupa Community. b4
Action needed: Complete your profile to get paid faster and get discovered Learn More Aﬂ nouncements viewan ©
Profile Progress Last Updated _
o - Improve Your Profile - .
- 16% Complete () 5 days ago One-Click Savings viewai
. ) Start saving today!
PrOﬂ ‘ € SU mma ry Explore deals for your company, exclusive to the

Coupa Community.

@ x a& Merge Accounts

Legal E Resi duU c qc If your company has more than one CSP account, we
ega‘ Yy EgIS[_e_re ser onnected Lustomer try to list it below. Consider merging them to reduce
Add view confusion for existing and potential customers.

Go to the One-Click Savings page by clicking on the:
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» Exclusive discounts link on the banner.
+ View All link under the One-Click Savings section under the Announcements.

* One-Click Savings box on the Add-ons page.

One-Click Savings

Explore the deals below for immediate savings, exclusive to the Coupa Community.

View details

Want to Offer Your Own Deals?

This program offers pre-negotiated pricing to all Coupa customers from trusted suppliers. As a member of the program, your company could be
recommended to hundreds of global companies. Express interest

View the discounts and special offers of Coupa Advantage suppliers, along with the expiration date and geographical
availability (one or multiple regions) of these savings opportunities. To explore the deals, click on the View details link
on each coupon.

 If you select a direct discount coupon, you can see more details about the supplier, the offer, and the region(s) of
availability, find the discount code, and start shopping on the supplier's shopping website.
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Mention promo code COUPA10 and get 10% off X

Simplify Your Operations from Warehousing to Delivery. Get 1-2-day delivery for all yvour orders with
Ware2Go's flexible fulfillment netwark

Digcount Code: Shop Now

COUPA10

We are aflexible and on-demand warehousing and fulfillment netwark, enabling seamless inventary
and order management

Offer available in the LS only, expires 272172021

 If you select a special offer (that requires email contact for a commercial relationship to be handled outside of
Coupa), you can see more details about the supplier, the offer, and the region(s) of availability, find a disclaimer
with a link to the supplier's privacy policy, and send an offer request to initiate a commercial relation between you
and the Coupa Advantage supplier.

10% discount on all candy brands X

Your Deal: Spangler Candy company offers a 10% discount on all their candy brands

Disclaimer "Your name and email will be sent to Spangler _
Candy Company, and a representative will contact you with tdl e
more details on how to redeem this offer. The processing of

your data is subject to Spangler Candy Company's privacy
policy

spangler Candy company 15 a leading global provider of candes

Offer availabla in the US only, expires 100312026

When you click on the Send Offer Request button, the supplier and the Coupa Advantage Team receive an email
with the following subject: "A Supplier is Interested in Your Coupa Advantage Offer", and a green banner is
displayed with the following message: "Your request to redeem this deal has been sent to the supplier.”

If you already sent this offer request earlier, the following message is shown: "This request has already been
submitted. The supplier will contact you shortly." The other supplier does not receive an email if you try to send the
same offer request within three days.

Note: Your name and email are sent to the supplier whose coupon you want to use, and a

representative contacts you with more details on how to redeem the offer. The processing of your data
is subject to the supplier's privacy policy that is linked in the disclaimer text.
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If an offer is not available in a selected region, you can see the "Sorry, there are no savings available in your region yet,
check back soon, we are regularly adding new deals." message.

To express interest in becoming a member of the Coupa Advantage program, click on the Express Interest link at the
bottom of the page.

Clicking on the Express Interest button on the Coupa Advantage, Invoice Financing, or Coupa Business Spend
Management page generates an email message template. You can check your contact email and modify the message

body if you want. Submitting the email informs the relevant Coupa team about your interest and you get a response in a
couple of days.

Express Interest
We are thrilled that you are interested in this offering. Before submilting your request, please review our parficipalion critesia Delow

= You agree fo provide a compelling discount on your goodsfservices to the Coupa Community

= You will agree to a revenue share agreement which wil be provided, and signed by both parties

» Coupa will review the offer 1o defermine if it fils our cniena of being a valuable good o service
for typical community members based on geography, and type of commodity or service

Werity Your Contact Bmail

e dosidaupplier com

Your Message

| am interested n offering a One-Click Savings deal. Here is the link to my Public
Profile: hitps:#supplier_publicprofile_esxample_link

Wa will send sorme of your basic comfact informalion fo the proper Coupa feam when yow
click Subwmil. Please lef us know any oifier relevant informaiion reganding your fnterest in
theis Ao,

3 &3
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View SFTP File Upload Errors

If you use SFPT to upload your invoices through CSV, you can view processing errors for a specific customer by

going to Admin > SFTP Errors and selecting the customer from the drop-down list.

Admin
SFTP Errors
Users
Merge Requests Select Customer Acme Inc.
Legal Entity Sef H
R SFTP File Upload Errors
Fiscal Representatives
Exportto -
—
. - File Name Created Date
erms o s5e
| sfip_template_invoice_header_list.csv 10/16/20 08:17 AM

Payment Preferences w
Perpage 15 | 45 | 90
Static Discounting
SFTP Accounts
XML Errors

SFTP Errors

Click the file name links to download and view the .csv files.

Click the links in the Upload Errors column to see the detailed error messages. Successful file uploads are listed

without the Click for Errors link.

For more information, see Create SETP _Accounts.
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CSP FAQ and Troubleshooting

This chapter contains the following topics:

Account, Login, Registration
Find answers to questions on how to register for and log in to the CSP, and manage your account.

Admin
Find answers to questions on how to administer the CSP.

Catalogs
Find answers to questions on managing catalogs/punchouts from the CSP.

Invoices
Find answers to questions about invoicing with the CSP.

Orders

Find answers to questions about handling purchase orders in the CSP.

Other

Find answers to miscellaneous questions about the CSP.
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Account, Login, Registration

How much does it cost to join the CSP?
Coupa doesn't charge suppliers to use the CSP.

Where do | register for the CSP?
You can request an invitation to join the CSP. Ask your customer to send you an invitation email or
visit https://supplier.coupahost.com. For more information, see Register for the CSP.

Why don't | receive the email invitation to join Coupa?
Check your spam/junk email folder.

Emails sometimes get flagged as spam. If you still cannot find the email invitation, you can register instead. However, if
you register, make sure to use the same email address to register that your customer used to invite you.

Why can't | register for the CSP?
If you received the email invitation with the link and can't register, check the I'm not a robot field. If there are any other
issues, write to supplier@coupa.com.

How do I register if the admin/owner of the CSP account left the company?
Contact your IT department or your customer.

Your IT department can sometimes grant someone temporary access to email to log in as the Admin that left your
company, and add you as a user with full access to all roles and permissions. You can also have your customer change
the contact information for you as a supplier and then "unlink” from the old admin's account, then "relink" or invite using
your email. All the transaction data remains. Some basic company information and payment locations/details may need
to be updated in the new account, but most of the important information and transaction details are carried over
automatically to the new account. For more information, see Create Your Account.

Where do | sign in to the CSP?
http://supplier.coupahost.com

How do | cancel my CSP account?
If you're no longer doing business with the customer who set you up on the CSP, ask the customer to make you inactive
in the system.

What do | do if | am locked out of the CSP?
Using two-factor authentication protects you against fraud. For more information, see Enable or Disable Two-Factor
Authentication.

If you don't have your six-digit backup validation code, contact your customer who will ask you to fill in a declaration form
and provide either a copy of your photo ID or passport or your CSP login email to verify your identify.
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Why don't | get the password reset emails?
Check your spam/junk email folder.

Emails sometimes get flagged as spam. If you still cannot find the email, write to supplier@coupa.com.

Why can't | log in to the CSP?
Make sure you have followed the instructions in Log in to the CSP. If you still have issues, reset your password. If the
problem persists, write to supplier@coupa.com.

Why can't | log in after resetting my password?
Check if you are using the correct URL: https://supplier.coupahost.com.

Sometimes users bookmark the password reset URL (instead of the login URL) or bookmark a test site.

How can | log in if | forgot my two-factor authentication code, the code is not working, or | lost my device?
If you don't have them, contact your customer. For more information, see Log in with two-factor authentication.

If you cannot log in because of missing two-factor authentication codes, try to find and recover them first by
using Google Authenticator or your device for text messages (SMS) to get new codes, or by using backup codes that
you were told to copy or write down.

If you lost your codes, contact your customer or supplier@coupa.com. You need to provide proof of identification to
ensure security of spend-related transactions for you and your customer.

For more information, see Log in to the CSP.

What do | do if | am not the admin/owner of my CSP account but | can't log in or don't have full access?
Contact your admin to activate your account or set your permissions.

Some users in the CSP have more power to activate and deactivate users, and decide which customers and types of
information they can access (forexample, invoices but not orders or catalogs). Contact those admins to see why your
access is not correct and have them fix it. If this is not possible, contact supplier@coupa.com.

Why do | get the "unauthorized or expired account" error?

Your customer has probably deactivated a setting on their end. Contact your customer to find out if this was intentional.
ask them to check your supplier record or your supplier user in the system. If they can't solve the problem, they can
contact Coupa support.

What do | do if | receive the "We're sorry, but something went wrong" error?
Contact your customer and ask them to open a support ticket because something is wrong on their end with a
configuration or an update that they need to resolve with Coupa support.
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Admin

How do | enable two-factor authentication?
After logging in to the CSP, go to Account Settings under your login name in the top right of the page to enable two-
factor authentication. For more information, see Enable or Disable Two-Factor Authentication.

How can | disable two-factor authentication?
You can disable two-factor authentication from the Account Settings under your login name in the top right of the page.

Note: If you disable two-factor authentication, you might not have access to your customers' information if
they decided to request you to use this additional form of authentication.

How do | connect with my customer?
Contact your customer and send your login email.

You can create an account in the CSP either by using a link from a customer or a supplier that invited you, or you can
register without an invitation. If you register with the link you received, you are automatically linked to your customer. If
you register without the link, your customer needs to connect with you by changing the Primary Contact email on their
supplier record and by inviting you, which automatically gets you linked. The customer can also find you in the Supplier
Portal Directory and connect with you from there. To prevent soliciting and spamming, suppliers are not allowed to
initiate connections through the CSP.

For more information, see Reaqister for the CSP.

How do | know that I'm connected to my customer?
Once you're signed in to the CSP, scroll down. On the bottom right of the page, you can see your Latest Customers.

What do | do if | am connected to a customer in Coupa and a new customer also wants to connect?
If the customer uses Coupa Release 18, they can find you in their Coupa Supplier Portal Directory and add a
connection to you.

Also, you can provide your new Coupa customer with the same email address that you use to connect to your other
Coupa customer(s). When your new customer has that email address, they need to send you an email invite to join.
Once you confirm the new connection request, you are connected to your new customer and your previous customers.

Where's the tab for my customer?

Once you're signed in to the CSP, if you don't have a tab for your customer, it's probably because you registered for the
CSP using a different email address than the customer used for the invite. Ask your customer to send another invite
using the address you registered with.

How do | add an employee?
On the main menu, click on the Admin tab. On the Users tab, click on the Invite User button. Provide the required
information in the window that opens.
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Why can't | access POs/invoices?
On the main menu, click on the Admin tab and check if you have access to the right roles and customers. If you have
access but do not have the right roles or customers, add them. If you do not have access, ask your admin to give you
access to the right roles or customers.

Why do | receive notifications if my notification preferences are turned off?
Log in to the CSP to check if the notifications are turned off. If they are turned off, contact your Coupa customer to open
a ticket with Coupa support.

Note: Some PO notifications from customers are not generated by the CSP, so you can't turn those off.
Contact your customer if you don't want to receive those notifications.
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Catalogs

How do | learn about hosting my catalog within Coupa?
You need to talk to your customer about how they would like to access your catalog.

How do | implement a cXML/punchout on my website?

You'll need a dedicated cXML developer or a third-party consultant, for example, Punchout2Go, to make your website
cXML compliant. Once your site is cXML ready, provide your credentials to your customer. They'll handle the rest. For
more information, see http://cxml.org.
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Invoices

How do | create an invoice?

On the main menu, click on the Orders tab. If you are connected to more than one Coupa customer, select their name
from the Select Customer dropdown menu. In the PO table that appears, choose the PO you want to invoice, and then
click on the yellow coins to create an invoice. For more information, see Coupa Supplier Portal.

If you don't have a PO and your customer has given you permission to create invoices without a backing document, click
on the Invoices tab on the main menu. Click on the Create Blank Invoice button above the Invoices table.

If you don't have a PO and your customer has given you permission to create invoices with a backing document, click on
the Invoices tab on the main menu. Click on the Create Invoice from Contract button above the Invoices table.

For more information, see Create or Edit an Invoice.

How do | create an invoice that isn't backed by a purchase order?

To create a non-PO backed invoice, click on the Invoices tab on the main menu. If you are connected to more than one
Coupa customer, select their name from the Select Customer dropdown menu. Click on the Create Blank

Invoice button above the Invoices table. For more information, see Create or Edit an Invoice.

Note: If you don't see the Create Blank Invoice button, contact your customer and ask them to configure
your supplier account so that you can submit invoices without a backing PO.

How do | submit an invoice?
Your account needs to be configured to handle invoices through your customer's Coupa instance. Contact them to get
set up with an invoicing method.

What options are available for me to submit invoices to my customers?
You should talk to your customer about which of the following methods they want to use:

» The CSP, where you sign in to manually flip a PO to create an invoice.

» Supplier Actionable Notifications (SAN), where you act on an email without logging in to the CSP.

» cXML, where you can automate the process of sending an invoice file using Coupa's standard cXML format.
» API, where you can automate the process of sending an invoice file using Coupa's API.

» Excel spreadsheet, emailed by your customer, which you fill out and send back to them.

Can | reuse an invoice number once my customer has deleted it on their end?
Yes, if a customer deleted an invoice number, you can reuse it.

Can | submit PDF invoices created from my system instead of using online invoicing?
Yes, you can. You can upload your PDF invoices in the following ways:
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» Log in to the CSP to create an invoice and attach the PDF. You don't need to contact your customer to do this, and
it only takes a moment.

« Email the PDF directly to your customer. This is ideal for invoices without a PO. However, your customer might
have to manually enter the PDF invoice information into Coupa, which may cause a delay in payment. Check with
your customer if this option works for them. They need to set up a specific email address where you can send the
PDF.

Why can't | send cXML invoices?
Check if you are using the supported protocols: TLS 1.1 or TLS 1.2. If you still have problems, contact
supplier@coupa.com.

How do | know if an invoice has been registered?
On the main menu, click on the Invoices tab. For the desired customer, look for invoices that are still listed as drafts.
They need to be edited and then submitted. If the invoice is not there, it's not in the system.

How do | add shipping charges to an invoice?
You can add shipping charges at the bottom of the invoice or at the line item level. Ask your customer which method
they prefer.

Do I need to include accounting information on cXML invoices?

Invoices against a PO don't need accounting information, because that information is part of the requisition and is
carried over to the PO. When an invoice references a PO line number, Coupa takes the accounting information
associated with the line and adds it to the invoice.

How do | credit or cancel an invoice that's already been billed?
To create a credit, enter a negative quantity. For more information, see Create a credit note.

Once an invoice is submitted, it can't be changed in any way. For more information, see Create or Edit an Invoice.

How do | make a part claim on an invoice?
You can invoice multiple times against a single PO. Just click the gold coin icon and enter the amount you'd like to
appear on the invoice.

Why can't | edit, void, or delete an invoice?
Once an invoice has been submitted, it can't be changed in any way. This ensures invoice processing integrity.
However, you still have options:

1. Ask your customer to reject or void the existing invoice. You can then create a new one.

Note: If your customer is using compliant invoicing, they can only reject invoices but not void them.

2. Create a new credit memo that credits the customer for the original value, and then create a new invoice.

Ask your customer which method they prefer.
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What does the status "Tolerance Hold" on an invoice mean?
It means your invoiced amount differs from the PO by more than your customer allows without manual approval. If an
invoice has been on hold for awhile, ask your customer to review it.

What do | do if an invoice was rejected?
Just create a new invoice to replace the one that was rejected.

Once an invoice has been approved, what do | need to do next?
Nothing. The invoice is your customer's queue and you'll be paid based on the payment terms you set with your
customer.

What if | have an invoice that hasn't been paid?

For questions regarding payment information, contact your customer directly. Some payment details might be on the
invoice document in Coupa, but not all customers update this information. Also, in your notification settings you can
choose to receive payment notifications via email or short text message (SMS).

Do | need to see a purchase order on the CSP before | can invoice my customer?
It depends on how your customer has you set up. Contact them and ask how you're configured, and if you can send
non-PO backed invoices.

What does the Export to button do?
You can export the rows to a CSV file, an Excel document, or bulk export legal invoices in a compressed (. zip) file.

By default, the maximum number of rows that you can export is 200,000. If you try to export a larger table, you receive
an error message stating that only 200,000 rows are exported.

Note: There is no limitation on the number of invoices or file size when exporting legal invoices.

Tip: For the best performance, it is recommended not to export more than 1,000 invoices at a time.

When you export a table with less than 500 rows, the file downloads to your computer immediately. When a table
has more than 500 rows, you receive the exported file zipped in an email.

How do | create a credit memo?

Log in to the CSP and click on the Orders tab on the main menu. Choose the PO you’d like to create a credit for and
select the red coins. You'll create a negative invoice with either a negative quantity or a negative amount. For more
information, see Coupa Supplier Portal.

If you don't have a PO and your customer has given you permission to create invoices without a backing document, click
on the Invoices tab on the main menu. Click on the Create Blank Invoice button above the Invoices table.

If you don't have a PO and your customer has given you permission to create invoices with a backing document, click on
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the Invoices tab on the main menu. Click on the Create Invoice from Contract button above the Invoices table.

For more information, see Create or Edit an Invoice.

Why do | get the "VAT ID format incorrect"” error?
You need to add GB or ABN in front of the VAT number for British or Australian suppliers/invoices. On the main menu,
click on the Admin tab to add a legal entity with the correct VAT ID under Legal Entity Setup.

What do | do if | get the "Please fix the below error" message?

Something is wrong on the customer's end. Ask your customer to check their Coupa instance to see if there is any
custom mandate field which can't be viewed on your side or if the billing account is active. Your customer can open a
ticket with Coupa support if they can't solve the problem.

What types of files can | attach to an invoice?
For invoice image scans, attachments must be of the following types: PNG, GIF, JPG, JPEG, PJPEG, TIFF, or PDF.

One attachment can be up to 100 MB, but for performance reasons, consider limiting the attachment size to 16 MB or
Sso.

How long are legal invoices available for download?

Invoices in the CSP are available for you to download as long as you are connected to the corresponding customer
through the CSP. You can also develop an internal process for downloading and storing these invoices in a separate
electronic archive of your choice.
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Orders

Can | set it so | can only see purchase orders that haven't been invoiced yet?
Currently, you are unable to filter purchase orders based on their invoiced status.

How do | see my customer's purchase orders?
On the main menu, click on the Orders tab. If you are connected to more than one Coupa customer, select their name
from the Select Customer dropdown menu.

You can see their purchase orders only if you have access. Contact your customer and ask them to give you access.

How do | add a carriage to a purchase order?
You need to contact your customer directly for information about adding a carriage line.

How do | change a price on a purchase order?
You cannot change a price on a PO through the CSP. If you need a change order on a PO, talk to your customer about
their policies.

How do | invoice a blanket purchase order?

You can invoice multiple times against a single PO. Just click the gold coin icon for the PO as you normally would, and
enter the amount you'd like to appear on the invoice. The next time you want to invoice against the PO, just do the same
thing.

How many times will Coupa try to resend a purchase order that wasn't able to be sent?
If a PO transmission results in a connection timeout because there was no response from the supplier, Coupa will try to
resend the PO up to four times at five minute intervals.

What is the purpose of a PO acknowledgement by the supplier?
You can let your customers know that you've received the order. Some Coupa customers like their suppliers to use that
field. Ask them if they want you to use it.

How can | view historical (closed) purchase orders in my customer's instance?
Your customer can provide you with information on closed purchase orders.

What is a soft closed PO?
A soft closed PO is a PO that your customer can reopen, for example, if an invoice or credit memo submission is
needed, or if a PO is closed prematurely or by mistake.

You cannot invoice against a soft closed PO. For more information, see View and Manage POs.
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Other

Where can | find information about integrating with Coupa?
For more information, see Suppliers.

How do | update my banking information for direct deposits?
Your banking information is stored in your customer's ERP system (for example, SAP or Oracle) and not stored in
Coupa. Contact your customer directly with the updated information.

Where can | find payment information?
If your customer provided payment information, you can find it on the invoice.

If | use the CSP, who pays me?
Your customer, who uses Coupa, is still responsible for paying you directly. Coupa does not pay suppliers on behalf of
buyers.

What does "pending receipt” mean?
This status shows that the customer is in the process of receiving the goods/services into their system. Once the
customer enters the receipt, the invoice is matched against it.

What do | do if | have a sourcing issue?
See Sourcing Supplier FAQ. If you can't find the solution to your problem, contact sourcing.support@coupa.com.

Is the information in the CSP archived?
No, the information in the CSP is not archived, but you can access it as long as you have a CSP account.
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